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I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.
Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.
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I Trademarks

Microsoft is a registered trademark of Microsoft Corporation.

Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

Microsoft Edge and Excel are either trademarks or registered trademarks of Microsoft Corporation in the
U.S. and/or other countries.

Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad
Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

Adobe, Acrobat, Flash, Photoshop, lllustrator, Adobe RGB and Adobe RGB (1998) are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

Google, Google Home, and Android are trademarks of Google LLC.

App Store is a trademark of Apple Inc., registered in the U.S. and other countries.

Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

AOSS™ js a trademark of BUFFALO INC.

Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other
countries.

The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.

HP-GL and HP-GL/2 are either registered trademarks or trademarks of HP Inc. in the United States
and/or other countries.

Mozilla Firefox is a trademark or registered trademark of Mozilla Foundation in the U.S. and/or other
countries.

Wi-Fi, WPA, WPA2 and WPAZ3 are either registered trademarks or trademarks of Wi-Fi Alliance.

All other company names and products mentioned in this guide may be registered trademarks or
trademarks of their respective companies.

»» Note

The formal name of Windows Vista is Microsoft Windows Vista operating system.
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I Licenses

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.
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"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work

and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or

Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,

the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except

as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;
and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,

or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
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such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

--—-- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
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OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: SciencelLogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, Sciencelogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of SciencelLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 10: Lennart Poettering copyright notice (BSD-like) -----

Copyright 2010 Lennart Poettering

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation files
(the "Software"), to deal in the Software without restriction,

including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:
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The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

---- Part 11: IETF copyright notice (BSD) -----

Copyright (c) 2013 IETF Trust and the persons identified as authors of
the code. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Internet Society, IETF or IETF Trust, nor the
names of specific contributors, may be used to endorse or promote
products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 12: Arista Networks copyright notice (BSD) ----

Copyright (c) 2013, Arista Networks, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Arista Networks, Inc. nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 13: VMware, Inc. copyright notice (BSD) -----

Copyright (c) 2016, VMware, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of VMware, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 14: USC/Information Sciences Institute copyright notice (BSD) -----

Copyright (c) 2017-2018, Information Sciences Institute

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Information Sciences Institue nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it

will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

2006-Jan-27
Copyright 1996-2002, 2006 by
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David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
("as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType
Project (www.freetype.org). All rights reserved.
Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package’, "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
‘FreeType Project’, be they named as alpha, beta or final release.

“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program’ or “executable’.

This program is referred to as “a program using the FreeType engine'.
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: “FreeType Project', "FreeType Engine', "FreeType library',
or "FreeType Distribution’.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
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There are two mailing lists related to FreeType:
o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

---end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties

of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

38



ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License
Copyright (c) 2013-2017
Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE

OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
"AS 1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

39



PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither name of Intel Corporation nor the names of its contributors

may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua
Copyright © 1994-2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated

documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the

rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to

permit persons to whom the Software is furnished to do so, subject to the following conditions:

40



The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH

THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation

the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript
Copyright (c) 2018 ifritdJP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright (c) 2002-2019, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of
BSD license:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2019, Broadcom Corporation. All Rights Reserved.

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.
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THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES

WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The certificate files "Amazon Root CA 1", "Amazon Root CA 2", "Amazon Root CA 4" are licensed under a
Creative Commons Attribution-NoDerivatives 4.0 International License.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.
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* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
AS IS AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1998-2010, Brian Gladman, Worcester, UK. All rights reserved.

The redistribution and use of this software (with or without changes)
is allowed without the payment of fees or royalties provided that:
source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;

binary distributions include the above copyright notice, this list

of conditions and the following disclaimer in their documentation.

This software is provided 'as is' with no explicit or implied warranties
in respect of its operation, including, but not limited to, correctness
and fitness for purpose.

Disclaimer: IMPORTANT: This Apple software is supplied to you, by Apple Inc. ("Apple"), in your
capacity as a current, and in good standing, Licensee in the MFi Licensing Program. Use of this
Apple software is governed by and subject to the terms and conditions of your MFi License,
including, but not limited to, the restrictions specified in the provision entitled "Public

Software", and is further subject to your agreement to the following additional terms, and your
agreement that the use, installation, modification or redistribution of this Apple software
constitutes acceptance of these additional terms. If you do not agree with these additional terms,
please do not use, install, modify or redistribute this Apple software.

Subject to all of these terms and in consideration of your agreement to abide by them, Apple grants
you, for as long as you are a current and in good-standing MFi Licensee, a personal, non-exclusive
license, under Apple's copyrights in this original Apple software (the "Apple Software"), to use,
reproduce, and modify the Apple Software in source form, and to use, reproduce, modify, and
redistribute the Apple Software, with or without modifications, in binary form. While you may not
redistribute the Apple Software in source form, should you redistribute the Apple Software in binary
form, you must retain this notice and the following text and disclaimers in all such redistributions

of the Apple Software. Neither the name, trademarks, service marks, or logos of Apple Inc. may be
used to endorse or promote products derived from the Apple Software without specific prior written
permission from Apple. Except as expressly stated in this notice, no other rights or licenses,
express or implied, are granted by Apple herein, including but not limited to any patent rights that
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may be infringed by your derivative works or by other works in which the Apple Software may be
incorporated.

Unless you explicitly state otherwise, if you provide any ideas, suggestions, recommendations, bug
fixes or enhancements to Apple in connection with this software ("Feedback"), you hereby grant to
Apple a non-exclusive, fully paid-up, perpetual, irrevocable, worldwide license to make, use,
reproduce, incorporate, modify, display, perform, sell, make or have made derivative works of,
distribute (directly or indirectly) and sublicense, such Feedback in connection with Apple products
and services. Providing this Feedback is voluntary, but if you do provide Feedback to Apple, you
acknowledge and agree that Apple may exercise the license granted above without the payment of
royalties or further consideration to Participant.

The Apple Software is provided by Apple on an "AS IS" basis. APPLE MAKES NO WARRANTIES,
EXPRESS OR

IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY

AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE OR ITS USE
AND OPERATION ALONE OR

IN COMBINATION WITH YOUR PRODUCTS.

IN NO EVENT SHALL APPLE BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR

PROFITS; OR BUSINESS INTERRUPTION) ARISING IN ANY WAY OUT OF THE USE,
REPRODUCTION, MODIFICATION

AND/OR DISTRIBUTION OF THE APPLE SOFTWARE, HOWEVER CAUSED AND WHETHER UNDER
THEORY OF CONTRACT, TORT

(INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF APPLE HAS BEEN
ADVISED OF THE

POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2009 Apple Inc. All Rights Reserved.
Copyright (c) 2012-2013 Apple Inc. All rights reserved.
Copyright (C) 2013 Apple Inc. All Rights Reserved.

The following applies only to products supporting PIXUS Cloud Link, PIXMA Cloud Link, or MAXIFY Cloud
Link.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2012 University of Cambridge

All rights reserved.
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PCRE JUST-IN-TIME COMPILATION SUPPORT

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain:  freemail.hu
Copyright(c) 2010-2012 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain: freemail.hu
Copyright(c) 2009-2012 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

Contributed by: Google Inc.
Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE

----------------- Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
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LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This software is based in part on the work of the Independent JPEG Group.

47



I Basic Operations

» Printer Parts
@« Front

Back / Side

Top Cover (Inside)

Operation Panel

Printer Stand

Roll Unit

» Using the Printer

Turning the Printer On and Off

Loading Rolls in the Printer

@ Loading Sheets in the Printer

@« Using the Basket on the Printer Stand
« Storing the Basket on the Printer Stand
@ Using the Roll Unit for Media Take-Up
@ Stopping Printing

@ Pausing Printing
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I Printer Parts

»>

»>

Front

Back / Side

Top Cover (Inside)
Operation Panel
Printer Stand

Roll Unit
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C D =

A: Top Cover
Open this cover to install the print head, load paper, and remove any jammed paper from inside the
printer as needed.

= Top Cover (Inside)

B: Output Guide
Guides printed documents as they are ejected. Open this guide when loading a roll.

C: Roll holder Slot
Slide the Roll Holder into this slot.

D: Roll Holder
= Roll Holder Set

E: Holder Stopper
Secure the roll on the Roll Holder with this part.

F: Release Lever
To release paper retainer, lift the lever.

G: Maintenance Cartridge Cover
Open this cover to replace the maintenance cartridge.

H: Maintenance Cartridge
= Maintenance Cartridge

I: Printer Stand
A stand that holds the printer. Equipped with casters to facilitate moving it.

= Printer Stand

J: USB flash drive port
Insert a USB flash drive to this port.
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K: Touch Screen
Use this screen to operate the printer and check the printer status.

= Operation Panel

L: Ink Tank Cover
Open this cover to replace the ink tank.

= |nk Tank Cover (Inside)

| Roll Holder Set

Load roll paper on the roll holder and then load the holder in the printer. You can use the roll holder with
both 2-inch and 3-inch paper cores. However, if using 3-inch core roll paper, attach the 3-inch paper core
attachment.

= | oading Rolls on the Roll Holder

+ GP-6600S / GP-566S : Roll Holder Set RH2-66

+ GP-4600S / GP-546S : Roll Holder Set RH2-46

* GP-2600S / GP-526S : Roll Holder Set RH2-29
o Roll Holder (for 2- and 3-inch paper cores)

o 3-Inch Paper Core Attachment (x2)

I Maintenance Cartridge

Model number: MC-30

Absorbs ink used for cleaning.

= Replacing the Maintenance Cartridge
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3% Important

* When purchasing, check the Model number.
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I Ink Tank Cover (Inside)

Left Side Right Side

A: Ink Color Label
Load an ink tank that matches the color and name on this label.

B: Ink Lamp
Indicates the state of the ink tank as follows.
* On

The ink tank is installed correctly.

» Off

No ink tank is installed, or the ink level detection function is disabled.

* Flashing

Ink tank is empty.
3> Note

* When there is little ink left, the ink lamp is lit and @ appears on the touch screen.

C: Ink Tank
= |nk Tanks

D: Ink Tank Lock Lever
A lever that locks the ink tank in place and protects it. Lift and lower the lever when replacing an ink
tank. To open it, lift the stopper of the lever until it stops, and then push it down toward the front. To
close it, push it down until it clicks into place.

I Ink Tanks

The printer supports the following ink tanks.

= Replacing Ink Tanks
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- 160 ml (5.4 fl 0z)

32 Important

* When purchasing, check the Model number.

= Checking the Ink Tank Model Number
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I Back / Side

A: Carrying Grips
When carrying the printer, have six people hold it by these handles under both sides.

B: USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

C: Wired LAN Connector
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and
communication is possible between the computer and printer.

D: Power Cord Connector
Connect the power cord to this connector.

E: Roll Unit Power Supply Inlet
Connect the connection cord for the roll unit.

55



I Top Cover (Inside)

A: Top Cover Roller

Prevents paper from rising when ejected.

oo}

: Internal Light
Lights automatically when the top cover is opened or during printing.

C: Cleaning Brush
When cleaning inside the printer under the top cover, use this brush to sweep away paper dust on the
platen.

D: Cutter Blade
= Cutter Blade

E: Paper Alignment Line
Align paper with this line when loading it.

F: Carriage
Moves the print head. It serves a key role in printing.
= Carriage

G: Carriage Shaft
The Carriage slides along this shaft.

H: Platen
The print head moves across the platen to print. Vacuum holes on the platen hold paper in place.

I: Paper Retainer
This retainer holds paper as it is fed.
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I Cutter Blade

Model number: CT-07

A round-bladed cutter for automatic paper cutting.
This cutter blade comes with a part for securing the cutter blade during installation.
= Replacing the Cutter Blade

22 Important

* When purchasing, check the Model number.
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I Carriage

A: Print Head Locking Cover
Secures the print head.

B: Print Head
= Print Head

C: Print Head Lock Lever
Lock print head locking cover.

I Print Head

Model number: PF-10

The print head is equipped with ink nozzles.
= Replacing the Print Head
22 Important

* When purchasing, check the Model nhumber.
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I Operation Panel

F

O ®E 6

A B C D

A: ON button / ON lamp
Turns the printer on and off.

= Turning the Printer On and Off

The ON lamp is lit when the printer is on or in Sleep mode.

B: Load button
Loads the paper when it is set or replaced.

= | oading Rolls in the Printer
= | oading Roll Paper in the Roll Unit
= | oading Sheets in the Printer

C: Feed button
Changes the paper position when the roll paper is loaded.

= Feeding Roll Paper Manually

D: Cut button
Cuts the paper when the roll paper is loaded.

= Cutting Roll Paper

E: Touch Screen
Shows printer menus, as well as the printer status and messages. You can select menu items and
display buttons by gently touching the screen with your fingertip.

= Home Screen Menu Composition

F: Status lamp
* Flashing (white)

During printing, this lamp flashes when the printer is receiving or processing print jobs. Otherwise,
this lamp flashes when the print job is paused or the printer is updating the firmware.
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* Lit (orange)
A warning message is displayed.
* Flashing (orange)
An error message is displayed.
» Off
There are no active print jobs, warnings, or errors.

»» Note

* When the printer is in Sleep mode, to restore the display, press the buttons on the operation panel or
touch the touch screen.

* When Operation panel lock is enabled, touch screen operations are invalid. For details on Operation
panel lock, see Changeable Setting Items Using Remote UI.
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I Printer Stand

The following Stand can be used with the printer.

* GP-2600S / GP-526S : Printer Stand SD-21
The GP-6600S, GP-4600S, GP-566S, and GP-546S models come with the printer stand included.

A: Stand Unit
A stand that holds the printer. Equipped with casters to facilitate moving the printer.

B: Basket
Catches the ejected printed documents.

= Parts of the Basket

C: Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you
move it while the locking casters are locked, the floor may become scratched.

D: Accessory Pocket
Stores the printer's accessories.
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I Parts of the Basket

0

A: Basket Rod (tag side)
Secures the cloth basket to the tips of the basket arm.

B: Basket Arm
Retains the basket rod (tag side).

By changing the length and the angle, you can make the basket suitable for various conditions.

C: Basket Cloth
A cloth tray that catches ejected documents.

D: White Tag
Marks indicating basket attachment orientation.

E: Basket Rewind Button
Press this button when rewinding the basket after it has been wound on the basket rod (tag side).

F: Basket Rod (cord side)
Secures the cloth basket on the rod holder.

G: Rod Holder
Retains the basket rod (cord side).

»>» Note

» For details on using the basket, see "Using the Basket on the Printer Stand" and "Storing the Basket
on the Printer Stand."
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| Roll unit

The roll unit functions as a feed device that can accommodate an additional roll for a total of two rolls on the
printer and as a take-up device that automatically takes up the printed roll paper. Switch between these two
functions depending on the circumstances.

You can use the following roll unit with this printer.

+ GP-6600S / GP-566S : Roll Unit RU-63
+ GP-4600S / GP-546S : Roll Unit RU-43
+ GP-2600S / GP-526S : Roll Unit RU-23

A: Roll Holder Lock Switch
Locks and releases the Roll Holder loaded in the roll unit.

B: Feed Mode Lamp
Lights up when you have selected the feed mode on the roll unit.

C: Auto Take-up Lamp
Lights up when the paper is being taken up.

D: Pause Lamp
Lights up when the paper winding is paused.
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E: Take-up Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the
winding direction is set to inward winding, the unit takes up the paper; when it is set to outward
winding, the unit rewinds the paper.

F: Rewind Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the
winding direction is set to inward winding, the unit rewinds the paper; when it is set to outward
winding, the unit takes up the paper.

G: Auto Take-up/Pause Button
Pauses and resumes the taking up of paper.

H: Inward/Outward Winding Changeover Switch
Changes the winding direction when the paper is wound (inward winding and outward winding).

I: Take-up Mode Lamp
Lights up when you have selected the take-up mode on the roll unit.

J: Roll Holder Slot
Slide the Roll Holder into these guide grooves.

K: 3-Inch Paper Core Attachment
Attaches to the Roll Holder when you are using a roll paper with a 3-inch paper core.

L: Feed Flap Switch
Change the feed flap position depending on the roll unit mode.

M: Roll Holder
Load the roll on this holder.

N: Holder Stopper
This part secures the roll paper on the Roll Holder.
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I Using the Printer

>

>

Turning the Printer On and Off
Loading Rolls in the Printer

Loading Sheets in the Printer

Using the Basket on the Printer Stand
Storing the Basket on the Printer Stand
Using the Roll Unit for Media Take-Up
Stopping Printing

Pausing Printing
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I Turning the Printer On and Off

I Turning the printer on

1. Press ON button to turn on printer.

The ON button lights up and the printer will now start up.

The Canon logo appears on the touch screen, and then "Starting the system...Please wait
momentarily" appears.

@ @ & &

When startup is finished, the printer enters standby mode.
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Ready to print

GY PEK ©O MEK
(@71 50.0m Plain Paper
50.0m Plain Paper

A Maintenance

2 Job management

The printer will not enter standby mode in the following situations. Take action as necessary.

* The top cover is open

Close the top cover.

* The ink tank cover is open

Close the ink tank cover.

* The print head is not installed

= Replacing the Print Head

¢ The ink tank is not installed

= Replacing Ink Tanks

e If "Error" is shown on the touch screen

Check the message on the touch screen and take action as necessary.

* The ON button and Status lamp do not light up, and nothing appears on the touch screen

Check the connection at the plug and electrical outlet.

I Turning the printer off
3% Important

* Never disconnect the printer's power supply or unplug it during a print job. This may damage the
printer.

1. Make sure no print jobs are in progress.

While the Status lamp is flashing, the printer is running. The color of the lamp indicates the following
states.
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©E & &

If the Status lamp is flashing orange, check the message on the touch screen and take action as

necessary.

If the Status lamp is flashing white, the printer is printing, receiving data, etc. Turn off the power after
the Status lamp turns off.

2. Hold down the ON button for more than a second.

@ E B ®

"Turning off... Please wait momentarily" appears on the touch screen, and the printer turns off.
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I Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

When selecting Enable in Roll paper auto feed, the roll paper is fed automatically by simply loading it.

32 Important

+ Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be
advanced correctly when you turn the printer on.

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Top Cover

« If Paper retention settings is set to Release, the roll paper is not fed automatically.

* For details on the paper that can feed roll paper automatically, see "Paper Information List."

»>» Note

» When using the roll unit, you can also load roll paper on the roll unit separately from the printer that is
described here.

= | oading Roll Paper in the Roll Unit

* When roll paper cannot be fed automatically, see "Roll Paper Is not Switched Automatically."

1. Select the paper setting display area on Home screen.

Ready to print

There is no paper.
There is no paper.

There is no paper,

|4 Maintenance

2. Select the Roll paper 1 area.
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Paper information

@ [ @n There is no paper. | Stop

There is no paper.

There is no paper. hd

Buy paper

3. Select Load paper.
2> Note

« If any paper has been advanced that will not be used, a message is shown requesting you to
remove it. After following the instructions on the screen to remove the paper, go to the next step.

4. Open top cover and lift output guide.

5. Hold flanges (A) so that holder stopper is on left, align roll holder shaft with roll holder slot
left and right guide grooves (B), and load.
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A Caution

* Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

» Do not release the flanges until the holder is loaded in the roll holder slot.

» Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

3% Important

« If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,
remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

» Load the roll paper so that it is not loaded in the opposite direction.

Make sure there is no slack in the roll paper, and then load it.

* Depending on the surrounding environment, the leading edge of roll paper is stuck because of
static electricity or humidity so that the roll paper may not be able to be fed correctly. In this case,
set Roll paper auto feed to Disable, and then feed the roll paper.

« If the roll paper is decentered, it may not be able to be fed correctly. In this case, set Roll paper
auto feed to Disable, and then feed the roll paper.
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* When Roll paper auto feed is Enable and if you attach the roll holder without the roll paper
loaded on the roll holder, Preparing to feed the paper... appears on the operation panel. In this
case, press the Stop button on the operation panel to cancel feeding.

»» Note

* For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll
Holder."

* When selecting Enable in Roll paper auto feed.

Go to step 6.

* When selecting Disable in Roll paper auto feed.

Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly beneath
it, and feed roll paper until you hear a sound.

22 Important
« If the roll paper has become unwound, remove the slack before loading the roll paper.

* When feeding the leading edge of the roll paper, make sure the entire width of the roll paper
is separating and feeding from the roll. If the roll paper is fed with some of the roll paper still
stuck to the roll, the roll paper will be damaged.

* Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may
affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to
protect the printing surface.
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« If the paper is wrinkled or warped, straighten it out before loading it.

* Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

E

» Depending on the paper, the roll paper may be scratched when being fed and not feed well.
In this case, you must feed the paper manually after setting Paper retention settings to
Release on the touch screen. Lift the release lever, advance the roll paper until its leading
edge appears on platen, lower the release lever, and then proceed to the next step. However,
if Paper retention settings is set to Release, automatic switching of the upper and lower
rolls is not possible.

3. Lower output guide.

* When selecting Enable in Roll paper auto feed.

The roll paper is fed.

* When selecting Disable in Roll paper auto feed.

Select Start feeding, and then the roll paper is fed.
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5. After paper feeding has started, do the following operations based on the Manage
remaining roll amount setting and the barcode printed on the roll paper

= Keeping Track of the Amount of Roll Paper Left

* When selecting Disable or Auto estimate in Manage remaining roll amount.

o When selecting Manual or Auto with confirmation in Media type selection method.
A menu for selecting the media type appears on the touch screen. Operate the touch screen
and select the media type to be used.

> When selecting Auto detect in Media type selection method.
You'll see candidate for the media type you've estimated to the touch screen. After 5 seconds,
the paper type of the first item is selected. If you choose a different candidate, you can use the
touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.
A menu for selecting the media type appears on the touch screen. After 5 seconds, the media
type will be selected with the fixed media kind.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.
The type and amount of paper left is automatically detected based on the barcode printed on the

roll. There is no need to specify the type and length of the paper.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

> When selecting Manual in Media type selection method.
A menu for selection of the media type and length is shown on the touch screen.Operate the
touch screen, select the media type to be used, and enter its length.

o When selecting Auto with confirmation in Media type selection method.
A menu for selecting the estimated media type candidates and the paper length. Interact with
the touch screen, select the media type you want to use, and enter the length.

> When selecting Auto detect in Media type selection method.

A menu for selecting the estimated media type candidates and the paper length.After 5
seconds, the paper type of the first item is selected. If you choose a different candidate, you
can use the touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.

A menu for selecting the media type and the paper length appears on the touch screen. After 5
seconds, the media type will be selected with the fixed paper kind.

2% Important
« |If the leading edge of the roll paper is folded or dirty, cut the leading edge of the roll paper.

= Cutting Roll Paper

74



»» Note

* If you have selected Auto with confirmation or Auto detect in the Media type selection
method and you are using the barcode to manage the remaining roll paper, the barcode is read
first. If it fails to read the barcode, it will detect the media type from the estimated result and
display the candidate.

 For details on media types that you can select, see "Paper Information List."
» The width of the roll paper is automatically detected by the printer when the paper is loaded.

When using roll paper with a user-defined size width, the detected width length and the set width
length must exactly match, so even if the correct roll paper is loaded, detection may fail.

In this case, you can improve it by setting the roll paper width you want to use in Add priority roll
paper width.

= Add priority roll paper width
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I Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

22 Important

» Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.
* Load the paper straight. Loading paper askew will cause an error.

=» 1317

+ If you are not using the stand, make sure there is no object under the printer. If there is any object
under the printer, it may cause damage of the paper or jamming.

»>» Note

» Before loading cut sheets, check whether or not the inside of the top cover or the output guide is soiled.
If these areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Top Cover

» Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Select the paper setting display area on Home screen.

Ready to print

GY PEKE O MEX

(21— 50.0m Plain Paper

50.0m Plain Paper

ETEERS

2 Job management

> Note

« If a print job has been received in advance, follow the instructions on the screen and select Load
paper.

2. Select the Manual area.

76



Paper information

@ OF Plain Paper
50.0m A1 Roll
OF Plain Paper
20.0m  567.8mm

- " [ There is no paper. j

Buy paper

3. Select Load paper.

4. Open top cover and lift release lever.

2% Important
* Do not touch Linear Scale (A), carriage shaft (B), or Ink Tube Stabilizer (C). Touching these parts

may damage them.
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5. Insert the cut paper in portrait orientation, with the print side up, between the platen (D) and
the paper retainer (E).

When the cut paper is inserted, it is automatically adsorbed onto platen surface.

6. Align the paper with the paper alignment line (F) on the right side.
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7. Align the back edge of the inserted paper with the front edge of the back paper alignment
line (G).

G

Y

32 Important

» Load the sheet so that it is parallel to the right paper alignment line (F). Loading paper askew will
cause an error.

» Warped paper may rub against the print head. Straighten paper if it is warped before loading.
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»» Note

* You can also align the cut sheet based on its near edge. In this case, load the cut sheet aligning
its near edge with marks (H) on the platen and the right edge with the right-side paper alignment
line (F).

* You can adjust the vacuum strength holding the paper against the platen when the release lever
is up. If it is difficult to load the paper, tap Suction on the touch screen and adjust the vacuum
strength. You can adjust the vacuum strength to 5 levels.

However, even if you increase the suction, it may not be sufficient to hold some types of paper
against the platen well. In this case, use your hand to load the paper.

» Sheets are held in place by suction through holes on the platen. Although the suction may
produce a noise when paper is loaded in some positions, it does not indicate a problem. If the
noise is distracting, try moving the paper over slightly to the left or right (up to 0.04 inch (1 mm))
while keeping it parallel to the paper alignment line.

» The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet
during this time, pull the sheet away and reinsert it to start the suction again.

8. Lower release lever and close top cover.
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»» Note

« If a print job has been received in advance, follow the touch screen to start printing after loading
the paper.

9. Select the type of loaded paper and select OK.
Paper feeding will start.

> Note

 For details on media types that you can select, see "Paper Information List."
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I Using the Basket on the Printer Stand

By changing the following four items for the basket, you can use the basket in various ways to suit your
application.

Length of basket arm
Tilt of basket arm
Attachment position of basket

Length of basket

This section describes how to change the basket.

For specific examples of basket use, see "Example Basket Configurations."

3% Important

When changing the position of the basket, first return the basket to a unwound state while pressing the
basket rewind button on the right end of the basket rod (tag side), and then make the change.

If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

When moving the printer, remove the basket.
Do not apply excessive force to the basket. Doing so may damage the basket.

If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.

I Changing Length of basket arm

You can change the length of the basket arm in two steps.

To lengthen, expand the left/right basket arm in the direction of the arrow.

To shorten, contract the left/right basket arm in the opposite direction of the arrow.
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32 Important

* When lengthening the basket arm, first return the basket to an unwound state while pressing the
basket rewind button on the right edge of the basket rod (tag side), and then make the change.

| changing Tilt of basket arm

You can change the tilt of the basket arm in three steps.

D

When securing the basket arm, attach the basket locking support to the basket arms (A) on both sides.

&3



\,

32 Important

« If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled
out as far as possible.

* When changing the angle of the basket arm, hold the thick part of the left/right basket arm, and adjust
them.

» While using the basket locking support, do not apply excessive force to the orientation in which you
lower the basket arm. Doing so may damage the basket.

» While using the basket locking support, you cannot use "Printing on Large-Format or Easily Damaged
Paper (Position 3)." When using this position, detach the basket locking support.

» While using the basket locking support, you cannot store the basket. When you store the basket,
detach the basket locking support.

= Storing the Basket on the Printer Stand

I Changing Attachment Position of basket

You can attach the basket rod (cord side) to the stand's rod holder or the front of the printer.

To attach, hang both sides of the basket rod (cord side) on the paired attachment locations shown in the
illustration.
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22 Important

» When attaching the basket rod (cord side) to the front of the printer, make sure both ends of the rod
(A) are securely hooked onto the attachment parts.

I Changing Length of basket

You can adjust the basket length by rotating the basket rod (tag side).

To shorten, rotate the basket rod (tag side) in the direction of the arrow to wind the basket.
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To lengthen, rotate the basket rod (tag side) in the opposite direction of the arrow while pressing the

basket rewind button (A) on the right end of the basket rod (tag side). You can return the wound basket to
its original position.
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I Example Basket Configurations

Various positions are possible for the basket that collects the printed materials.

In this section, we present the following five positions as examples of using the basket. Switch the position
of the basket to suit to the media type and the print job.

= Using Without roll unit (Position 1)

= Using With roll unit (Position 2)

= Printing on Large-Format or Easily Damaged Paper (Position 3)

= Stacking Printed Materials (Position 4)

= Moving Printed Materials to Next Work Area Immediately (Position 5)

For instructions on switching the basket position, see "Using the Basket on the Printer Stand."

22 Important

* If replacing the roll paper or using the roll unit as a take-up device, you must store the basket.

= Storing the Basket on the Printer Stand

« If the printed materials collected are damaged or folded, select Eject cut in Cutting mode or use the
basket in a different position.

= Specifying the Cutting Method for Rolls

I Using Without roll unit (Position 1)

You can use the basket in the following positions when not using the roll unit.

22 Important

» The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

+ If using the roll unit as a feed device, we recommend using it as described in "Using With roll unit
(Position 2)".

+ If using the roll unit and using the Position 1 basket, the printed materials may come in contact with
the roll unit depending on the paper, resulting in damage.
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« If using the roll unit as a feed device and using the Position 1 basket, the ejected roll paper's cut
end enters the roll unit and may cause a paper jam or affect the print quality when set to Borderless
Printing or Trim edge first when loading the paper.

* Roll paper up to 62.0 inches (1,575 mm) in length can be collected in the basket. If printing on longer
roll paper, use as described in "Printing on Large-Format or Easily Damaged Paper (Position 3)" or
use with the roll unit as the take-up device.

I Using With roll unit (Position 2)

You can use the basket in the following positions when using the roll unit as a feed device.
This position is useful also when rewinding printed roll paper by hand.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, and extend the basket arm as far as possible at the angle shown to achieve this position.

You can adjust the basket length so that it is easy to use.

32 Important

* You can place up to approximately 4.41 Ibs (2 kg) of printed materials in the basket. If the weight of
the printed materials is greater than that, the basket may fall over.

I Printing on Large-Format or Easily Damaged Paper (Position 3)

If printing on large-format or easily damaged paper, you can use the basket in the following position.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible, and lower it to the angle shown. Next, adjust the length
so that the basket is pulled into this position.
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3% Important

» Always select Eject cut in Cutting mode when used in this position. If you select Automatic cut, the
printed materials may be damaged.

= Specifying the Cutting Method for Rolls

» Be extra careful when using paper that tends to curl or is damaged easily in this position.

» With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

» Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.

I Stacking Printed Materials (Position 4)

You can use the basket in following positions when you want to stack printed materials.

Move the basket rod (cord side) to the lower of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the
basket is pulled into this position.

2% Important

* In the following cases, use as described in "Using Without roll unit (Position 1)" or "Using With roll
unit (Position 2)". If printing multiple pages in these positions, print after removing each sheet.

— Printed materials other than A2 portrait
— Paper curls an extreme amount due to paper characteristics and printing environment

— If there is not much paper remaining on the roll, and the paper curls an extreme amount

I Moving Printed Materials to Next Work Area Immediately (Position 5)

You can use the basket in the following position when moving the printed materials to the next work area
immediately.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the
basket is pulled into this position.
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3% Important

» Be extra careful when using paper that tends to curl or is damaged easily in this position.

» With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

» Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.
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I Storing the Basket on the Printer Stand

Store the basket in the following two positions when not in use. Select the position to suit the circumstances.

= |f Changing Roll Paper or Using roll unit as Take-up Device

= Using Without basket (Only When roll unit Is Not Used)

I If Changing Roll Paper or Using roll unit as Take-up Device

If replacing the roll paper or using the roll unit as a take-up device, store the basket.

You can store the basket, by attaching the basket rod (cord side) to the rod holder, lowering the basket
arm until level, and then pushing as far back as possible.

3% Important

« If changing the basket position, first release and rewind the basket. If it is not released and rewound,
the change may not be performed smoothly, or the basket may be damaged.

« If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled
out as far as possible.

« If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

» Do not apply excessive force to the basket. Doing so may damage the basket.

I Using Without basket (Only When roll unit Is Not Used)

If you are not using the roll unit, you can easily store the basket by holding the thick parts of the left/right
basket arm in "Using Without roll unit (Position 1)", and moving them in the direction of the arrow.
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| Using the Roll Unit for Media Take-Up

» Switching Roll Unit Modes
» Using the Roll Unit In Take-Up Mode

» Removing Printed Paper from the Roll Unit

93



| switching Roll Unit Modes

Before using the roll unit, follow these steps to select the mode you want to use.

22 Important

« After switching the roll unit function, you must use a separate computer to apply the roll unit settings to

the printer driver.
= Reflect Roll Unit Settings in the Printer Driver (Windows)

= Reflect Roll Unit Settings in the Printer Driver (macOS)
+ If you change the roll unit from a take-up device to a feed device, first cut the paper that has been taken

up.

I Using as take-up device

1. Select the paper setting display area on Home screen.

Ready to print

GY PEEX D MBE Y M

©1-50.0m Plain Paper
There is no paper,

I }  Maintenance

= Job management

2. Select the Roll paper 2 area.

Paper information

@ @n Plain Paper
50.0m A1 Roll

l OH There is no paper.

- F There is no paper. N

Buy paper

3. Select Roll unit use settings.
4. Check the contents of the message and select ON.

5. Select paper cutting settings when using take-up mode.
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»» Note

* If you selected Do not cut, the roll paper will not be cut after printing regardless of the
Cutting mode setting on the printer. Select this option when you want to print multiple pages
consecutively without cutting.

« If you selected Use the cutting mode setting, cutting for each page will be performed
according to the Cutting mode setting on the printer.

= Specifying the Cutting Method for Rolls

* If you select Use the cutting mode setting, and Automatic cut is set in the Cutting mode
settings on the printer, we recommend setting Wind up after cutting to Enable. When set to
Disable, a printed document that has been taken up is cut automatically without being pressed,
resulting in fraying.

« If roll paper is loaded from the roll unit to the printer, a screen confirming whether or not to
remove the roll paper appears. If you select Yes, the roll paper is positioned so that it can be
removed and the roll unit changes to a take-up device.

6. Check the contents of the message and select Yes or No.

If you select Yes, the steps for loading the paper on the roll unit appear on the touch
screen.

If you select No, the operation ends here. Load the paper on the roll unit when
printing. However, in this case, you must load the paper while printing is progressing,
so instructions will not appear on the touch screen.

For details on loading paper on the roll unit set as a take-up device, see "Using the Roll
Unit In Take-Up Mode."

»» Note

* If you select Yes, a margin of approximately 23.7 inches (600 mm) is generated at the leading
edge because the roll paper advances to the roll unit before printing.

I Using as feed device

1. Select the paper setting display area on Home screen.

Ready to print

©71-—50.0m Plain Paper

1, Take-up mode

I ! Maintenance

= Job management
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2. Select the Take-up mode area.

Paper information

@ OF Plain Paper
50.0m A1 Roll

&, Take-up mode

- - There is no paper.
Buy paper

3. Select Roll unit use settings.

4. Check the contents of the message and select ON.

»» Note

* If you change the mode without cutting the roll paper with the printer's cutter, a screen
confirming whether or not the paper taken up has been cut appears after you select ON. If
the paper has not been cut, select No and cut the paper that has been taken up first.
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| Using the Roll Unit In Take-Up Mode

22 Important
* For details on the roll paper compatible with winding, see "Paper Information List.".

+ Before loading the roll paper to be taken up on the roll unit, set the roll unit mode to take-up device on
the printer touch screen.

= Switching Roll Unit Modes

« If the roll holder is installed on the roll unit, first remove the roll holder from the roll unit, and then
remove the roll paper loaded on the roll holder.

= Removing Roll Paper from the Roll Unit

» Paper winding is possible until the outer diameter of the wound paper is the same as the outer diameter
of the holder stopper.

1. Store basket.

= Storing the Basket on the Printer Stand

2. Rotate the holder stopper lever (A) towards IP to release the lock, and while holding the
end plate (B), remove the holder stopper from the roll holder.

3. If taking up roll paper whose paper core has an inner diameter of 3 inches (76.2 mm), insert
3-Inch Paper Core Attachment in roll holder and holder stopper.

Align the 3-Inch Paper Core Attachment tabs (A) with the holes on the roll holder or holder stopper (B)
and insert firmly.

« roll holder Side

97



2% Important

+ We recommend using a paper core that is wider than the paper to be wound when winding paper.
If you use a narrower paper core, use with a gap between the holder stopper and the paper.

« Always use a paper core for winding that is the same thickness or is thicker than the roll paper's
paper core. If you use a paper core that is thinner, it may affect take up.

5. Insert holder stopper from left into roll holder, and then while holding the end plate (B), push
firmly until holder stopper flange (A) touches paper core. Lock the holder stopper lever (C)

by rotating it towards ﬁ
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7. Hold flanges (A) so that holder stopper is on left, align roll holder shaft with roll holder slot
left and right guide grooves (B), and load.
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9. Change the feed flap switch on top of the roll unit so that the switch indicator (A) is aligned
with e (B) position on the take-up icon.
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10. Change Inward/Outward Winding Changeover switch on roll unit to desired winding
direction.

> Note

 For the winding direction of the roll paper, you can select either outward winding to make the
printed surface on the outside of the roll or inward winding to make the printed surface on the
inside of the roll.

11. Follow these steps to secure the leading edge of the roll paper to the paper core with tape.
* If message appears on touch screen to confirm whether or not to advance paper
automatically so it can be secured with tape
1. Select Yes.
The leading edge of the roll paper advances until it is close to the roll unit.

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

o Outward Winding
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3% Important

« If winding with inward winding, you must pass the leading edge of the roll paper to the
back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass
the roll paper to the back of the paper core.

3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.

o Outward Winding

o Inward Winding
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22 Important

» Secure the left and right edges of the roll paper with tape within 2.0 inches (50 mm) of the
edges so that neither end of the roll paper lift up.

* When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

* If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward, check that roll holder is not lifting up, and select OK.

o Outward Winding
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3% Important

« If the roll holder lifts up, it may cause an error.

7. To stabilize operations when starting taking up, advance roll paper with operation panel and

wind roll paper approximately one revolution.

= Feeding Roll Paper Manually

8. Push roll holder downward again, and check that roll holder is not lifting up.
The winding preparation is complete. When printing to the roll starts, the roll paper can be

automatically wound.

* If Ready to print appears on touch screen
1. Manually advance roll paper or start printing, and wait for leading edge of roll paper to reach

roll unit.

= Feeding Roll Paper Manually

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

o Qutward Winding

22 Important

* If winding with inward winding, you must pass the leading edge of the roll paper to the
back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass

the roll paper to the back of the paper core.
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3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.

o QOutward Winding

32 Important

» Secure the left and right edges of the roll paper with tape within 2.0 inches (50 mm) of the
edges so that neither end of the roll paper lift up.

* When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

« If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward and check that roll holder is not lifting up.

o Outward Winding
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3% Important

« |f the roll holder lifts up, it may cause an error.

7. Make sure Inward/Outward Winding Changeover switch on roll unit is in desired direction
and press Auto Take-up/Pause button.

The Pause lamp, which has been lighted up to this point, turns off, and the Auto Take-up
lamp lights up instead.

The winding preparation is complete. During printing, the winding starts. Before printing, the
winding starts at the same time as the printing.

3% Important

* When winding inwardly, loosening of the wound paper can be prevented by pressing the
roll paper with the arm. However, doing so may produce pressure traces on the paper.
In this case, tap the roll unit area of the media information display area and set Paper
retention settings to Release.
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I Removing Printed Paper from the Roll Unit

»» Note

* By selecting the paper settings display area and then Take-up mode area when setting Take-up mode
and setting Wind up after cutting to Enable in advance, you can omit steps 6 and 7 below, because
when the paper is cut after printing, the next paper will be automatically taken up after that. However,
be careful when using easily damaged roll paper because the roll paper touches the roller when paper
is cut.

1. Select the paper setting display area on Home screen.

Ready to print

©1- 50.0m Plain Paper

&, Take-up mode

| ! Maintenance

&= Job management

2. Select the Roll paper 1 area.

Paper information

OF Plain Paper
50.0m A1 Roll

@, Take-up mode

[ There is no paper.

Buy paper

3. Select Feed/cut.

4. Tap or touch Advance and Rewind to move roll paper forward or back.

With the winding direction set to outward winding, advance the length of one circumference of the roll or
more to protect the print side.

5. Select Cut paper.

6. Hold printed paper between output guide and roll unit, then select Yes.

The roll is now cut.
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2% Important

* When cutting the roll paper, always hold the printed paper. If cut without holding the printed paper,
the paper may fall to the floor and become soiled.

7. While holding trailing edge of printed paper, press Take-up or Rewind button to wind
printed paper.

Apply adhesive tape to the rewound paper to hold it in place, if necessary.

2» Important

» Be careful not to scratch the printed surface.

8. Change Roll Holder Lock switch on roll unit to release position.

9. Hold roll holder by its flanges (A), and remove from roll unit.
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10. Rotate the holder stopper lever (A) towards :P to release the lock, and while holding the
end plate (B), remove holder stopper from the roll holder.
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I Stopping Printing

To cancel printing or reception of print jobs, tap Stop on the touch screen.

Printing...

i Maintenance

&= Job management

When you tap Stop during printing, the behavior of the printer varies depending on the current status.

* You tap Stop before printing starts

A confirmation message is displayed. To cancel the print job, select Yes.

* You tap Stop during printing

A confirmation message is displayed. To cancel the print job immediately, select Yes.

110



I Pausing Printing

During printing, if you set Pause printing to Enable, the printer enters a state in which printing is paused,
after the completion of the printing process when this setting was made.

In this state, all printing is not executed.

To restore normal operation after pausing printing, set Pause printing to Disable.

»>» Note

* In the following cases, the status is cleared even if you do not set Pause printing to Disable.

— When paper is advanced

— If you changed the media type from the paper settings display area

1. Select . Job management on Home screen during printing.

Printing...

| ! Maintenance

| = Job management

=@ Print from USB flash drive

2. Select Pause printing.

3. Select Enable.
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I Printing

» Printing from Your Computer (Windows)

Printing with Easy Setup #Basics
& Printing Photos and Business Documents
Printing By Setting Print Purpose
Edit in PosterArtist and Print
@ Printing CAD Drawings
Printing By Setting Print Purpose
a Scaled Printing
@ Printing to Oversized Paper Sizes
a Setting Paper Dimensions (Custom Size)
& Printing Hanging and Horizontal Banners (Large-Format Printing)
& See more...
» Printing from Computer (macOS)

& Printing with Easy Setup #Basics

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners (Large-Format Printing)
& See more...
» Printing from Printer
& Printing Data Saved on USB Flash Drive
» Printing from Smartphone/Tablet
& Print Easily from a Smartphone or Tablet with Canon PRINT
a Printing from iOS Device (AirPrint)
» Enlarging Copy with imageRUNNER ADVANCE

» Using PIXMA/MAXIFY Cloud Link
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» Managing Print Jobs
a Handling Print Jobs

a Using the Printer Hard Disk to Handle Print Jobs
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I Printing from Your Computer (Windows)

» Printing with Easy Setup 7Basic

» Setting the Number of Copies and Printing Order

» Using Roll Unit to Use 2-Level Rolls

» Printing Photos and Business Documents

» Printing CAD Drawings

» Changing the Print Quality and Correcting Image Data
» Scaled Printing

» Printing to Oversized Paper Sizes

» Setting Paper Dimensions (Custom Size)

» Set a Custom Size Roll Width

» Printing without Edges Based on the Scenarios

» Printing Hanging and Horizontal Banners (Large-Format Printing)
» Printing by Dividing/Joining Documents

» Printing Document in Center of Paper

» Printing by Saving Roll Paper

» Switching the Paper Source to Match the Purpose

» Displaying the Print Results before Printing

» Other Convenient Settings
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I Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

I Printing with Easy Setup

1. Check that printer is turned on

2. Load paper on the printer

Set roll paper or cut sheet to a printer.

3. Open the printer driver setup window

4. Select the media type

The type of paper set in the printer is displayed.

= Canon Frinting Freferences o
Man  Page Setup Lyl Fawoctes  Lbity

[eca Tiee: EEET—— | |

B 5 Gl I et Spordy
: . Easy Sefings w
Perd Target
E Phaoto (Colar)
———— L Pagter
Letier (B5 w107
EShmeiidhn
Letier (B5R107)
ESDm= 1100 m
P Chuslty Standard -

Buttabde for prirting nomral doouments that contan a midure of
ten, phatiogrephs and graphecs

22 Important

« See "Paper Information List" for Canon authentic paper or Canon output check paper.

»» Note

» To prevent the printer from automatically applying the media type set on the printer, change the
settings in Custom Settings... in the Utility tab.

» Click Get Information... to display the Paper Information on Printer dialog box. The Paper
Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

If Roll Paper (Auto) is selected for the paper source, it will remain as Roll Paper (Auto) even if
you get the paper information from the printer.
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 For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."

5. Select print target

From the pull-down menu, select Easy Settings, and then select the setting that matches your

purpose from the Print Target list.

= Cance Frimting Freferences o
Man  Page Setup Leyout  Favoctes | Lbity
Meda Typs: :P'ImPap:r "’:
lt-_ Gel nfomation. Specily...
— Prirt, Targeet:
Letier (25107
EShmei100n

& tuetual Sive
Letier (B5X107
EShm=iidin
Pt Coanlty Standard &
Sultabde for printing nommal doouments that contan a midure of
e, phtiographs and graphics.

6. Select the print quality

For Print Quality, select High, Standard or Fast according to your purpose.

= Cance Frimting Freferences o
Man  Page Setup Leyout  Favoctes | Lbity
Meda Type: | Plan Paper =)
[ = Get Infomation... Speedy
— Easy Setiings -
[ Prrk Tawges:
H Photo [Colar)
Letter (557117 Poser
EShmei100n
& Asiual Dize
Letier (B5X107
ESbimxiidhn
- [Pt oty Ttanden -

Sultabde for printing nommal doouments that contan a midure of
e, phtiographs and graphics.

3% Important

» The print quality settings that can be selected may differ depending on a printing profile.
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7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

= Canoe Frinting Freferences o

Men  PageSehg  Lewt Favostes  Lhity

IE,J. Page Size Letter @511 -
[ Bordaress Prarting Bordedess Seting

[[] Eniarged Sedueed Prrtng
Fit Paper Size
Fit Rl Paper Wickh
Saing Pubs | 5

Letier (B 5N1E7) i
E S0 108 n &2 F Sama g Page Sz

&+ Actual Jize

Leter (B 5x187) Ot gtor
ESOmxi10m

ﬂ [ Rotate Fage %0 degrees

A @ronn A O Lareage

Faper Source: ol Paper LRsie] ke
Foll Paper Wilth 24 in Pl {509 6} bt
Foll Papesr Optiore_

Dutpns Mathed Bun Optiors.

0K Canzal Aoy Hetp

8. Select the paper source

For Paper Source, select the setting that matches your purpose.

= Cancm Frinting Freferences i

Man | Pape S0 Lewt | Favoctes  Lbity

B poge size Letter 57117 -
[ Bordaress Prarting Bordedess Sating
[[] Eriarged Sedursd Prring
Fit Paper Size

78 Foll Faper Widh

Saing L T

Letier (85187 -
EShinx i100@ ) ; G 29 P Size
& Actual Jize

Letier (B R187) Crenlgan
ESOmxiiddn

ﬂ ] Rotate Fage 90 dagress

A @roan N [ [rewen

IPMSU..IH Foll P (Autin] £ I
Flodl Papesr Wit 24 in Floll JE09 Gl e
Foll Pagesr Optiore._.
Outpt Mathod S Optons. Def ity

22 Important
» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

9. Select roll paper width
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If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper

loaded in the printer.

B ClRoste Page 0 dsgrees

= Cance Frinting Frederences w
Man | PageSehn Lmwat Favotes  Lbity
—— B page ize Letter @511 -
!I— [ClBordedess Printng Eorderess Setng
= (] Entarged Broduend Prning
—— Fit Paper Sice
———— % Rl Paper VWickh
i e
Letier (E5®1E7) i
ESOnxi100n £ F Sama as Page Sz
& fueual Sive
oo
EShm=iidhnm
A @ A) O Lnsesa

Faper Source: Rl P Lhss) -
s 24 in P S0 i) ~|
Foll Papesr Optiors
Dutput Mt S Opters
oK Cancel Fecy Help

10. Complete the setup
Click OK.
When you print, the document is printed with settings that match your purpose.
= Canom Frinting Freferences o
Man | PageSep Lot Favoctes Lbity

B page size Letter (157117 ~

[ = [ Bordefiess Prrting Bordetess Setng

= [[] Eriarged Bedued Prring

— Fit Paper Sice

— i Rl Paper VWickh

Lehef[!-i‘ﬂlélsuﬂgnmﬂ :5:'\. Same a1 Page Size
Astusl Sive
Ltier (B5R107) Crartptar
ESDmx 100 m _A-J@ij _'ﬁjl:l
B OlRctae Page 90 degrees
Paper Source [Flall Pragzetr {Atis] w
Bl Paper Wik 28 in Floll (509 ) w
Foll Paper Optors
Dutput Mt S Opters
ot | |
23> Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.
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I Checking Printer Settings and Applying Settings to Printer Driver
1. Open printer driver setup window

2. Click Get Information... on Main tab

The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Paper Width.

4. Apply settings
To apply the printer settings to the printer driver, click OK.

»» Note

« If the media type and the output paper size are not set on the printer, OK will be grayed out and
cannot be clicked.

« If communication with the printer is disabled, printer media information from the printer cannot
be obtained.
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I Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.

= Canom Printing Freferences x

Man  Page Setp Land  Favodtes  Lbity

Y [ Pasge Lot 1'!.7] Pealer (1% 7
[ seame CONFIDENTIAL
Letier (BL5™117)
EShnziidhn _.I' [ Fre Corternd
LY
Letier (B.57%117) .
BEhinx 100 Gl [JRstae 180 degrees

-
-rl ] Ma Spaces o Top o Bamare

Copies [ oo
7] Pk freams Lati Praps

Paxgn Cptions. TSora Serg Cefmits

ok 0 coes | [ oo te

3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and

uncheck the check box when you want to print from the first page.

4. Complete the setup
Click OK.

When you execute print, the specified number of copies will be printed with the specified printing order.

22 Important

» When the application software that you used to create the document has the same function, specify
the settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of

the two settings or the specified printing order may not be enabled.
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I Using Roll Unit to Use 2-Level Rolls

» About 2-Level Roll Switching

» Setting the Paper Rolls in the Printer According to the Intended Use

» Printing by Automatically Switching Upper-level and Lower-level Roll Papers
» How to Switch Paper Rolls

» Reflect Roll Unit Settings in the Printer Driver
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I About 2-Level Roll Switching

This printer allows you to load roll paper in two levels. The upper level (Roll 1) and the lower level (Roll 2)
can be automatically switched depending on the print job.

Printing by automatically switching Roll 1 and Roll 2 in this way is called "2-level roll switching."

» For instructions on setting the paper, see "Setting the Paper Rolls in the Printer According to the
Intended Use."

» For the 2-level roll switching procedure, see "Printing by Automatically Switching Upper-level and Lower-
level Roll Papers."

» Guidelines on how to switch Roll 1 and Roll 2 for certain cases are summarized in "How to Switch Paper
Rolls."

Refer to this section if a document cannot be printed as intended or as necessary.
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Setting the Paper Rolls in the Printer According to the Intended
Use

If you want to switch the 2-level rolls, set the paper rolls on the upper and lower level of the printer in one of
the ways described below depending on the intended use.

* When automatically switching from paper roll 1 to paper roll 2 to match the paper size specified for the
print job

Set two paper rolls of the same type of paper but of different width on the upper and on the lower trays.
Example of how to set the paper

Paper-feeding tray Roll Width Media Type
Upper-level 24 in Roll (609.6mm) | Plain Paper
Lower-level A1/A2 Roll (594.0mm) | Plain Paper

* When automatically switching from paper roll 1 to paper roll 2 role to match the paper type specified for
the print job

Set two paper rolls of the same width but of different types of paper on the upper and on the lower trays.
Alternatively, set two paper rolls of different width and different types of paper on the upper and on the
lower trays.

Setting the paper (Example 1)

Paper-feeding tray Roll Width Media Type
Upper-level A1/A2 Roll (594.0mm) | Plain Paper
Lower-level A1/A2 Roll (594.0mm) [ Canon Coated Paper

Setting the paper (Example 2)

Paper-feeding tray Roll Width Media Type

Upper-level 36 in Roll (914.4mm) | Plain Paper

Lower-level A1/A2 Roll (594.0mm) [ Canon Coated Paper
22 Important

+ 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible with
automatic cut-off. For checking which types of paper are compatible with automatic cut-off, look up the
paper you want to use on the "Paper Information List."

+ If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, you cannot switch
between upper and lower rolls corresponding to the media type specified by the print job. If different
types of roll paper are set for the upper and lower rolls, specify the media type, such as plain paper or
enameled paper, in Media Type.

»» Note

» For information on how to set the paper rolls in the printer, see "Handling rolls."

* When rolls of different types of paper and of different width are set in the upper and lower trays, the
paper roll matching the type of paper specified for the print job will be used.
Depending on the settings, an error may occur causing the wrong paper roll to be used; in such cases,
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it is recommended that, instead of using 2-level roll switching, you specify which one is best between
paper roll 1 and paper roll 2 and print.

A3
DA
o (B
) T
. o _,zl . 9
Document Roll 1: Roll 2:
Size: A3 1ISO A1/A2 ISO A3/A4
Media Type: Plain Paper Plain Paper Glossy Paper

» To learn how to switch paper- feeding trays, see "How to switch paper rolls."
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Printing by Automatically Switching Upper-level and Lower-
level Roll Papers

You can print by automatically switching Roll 1 and Roll 2 depending on the media type or your purpose.

The procedure for printing by switching the roll papers is as follows:

1. Load roll papers in upper and lower levels of printer

2. Open the printer driver setup window

3. Select the media type

The type of paper set in the printer is displayed.

= Canon Printing Preferences x
Mant  Page Setup Lyt Favectes  Lbity
I-‘-'!ed-u Tiee: A I

I*:_: (el Infovematan Specdy
I 3 Easy Settings w
E = Pord Targes
H Fhaoto [Color
p——— - Foster
Letier (B.5%117)
EShinxi10hn
4+ dstusl Sive
ESOmxi100m
Perd Chusliy Siandard -

Sustable for printing nomal documents that contain a miduee of
teoed, phtographs and graphics.

»» Note

« If Automatically switch paper sources (paper size priority) is grayed out, refer to "Reflect Roll
Unit Settings in the Printer Driver" and set Roll Unit in the Device Information dialog box to Yes.

4. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

5. For Paper Source, select Roll Paper (Auto)
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

7. Selecting the printing method for the roll paper

When performing enlarged/reduced printing in accordance with the roll width, place a checkmark next to
Enlarged/Reduced Printing and select the Fit Roll Paper Width.

8. Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

> Note

« If you rotate a portrait document 90 degrees and print it at that horizontally, you may be able to
save paper depending on the paper size.

2» Important

* When you select the Rotate Page 90 degrees check box and print the document, the document
will be rotated 90 degrees only if the vertical length of the document fits in the width set in Roll
Paper Width.

Therefore to use this function, correctly set Roll Paper Width to the width of one of the roll papers
loaded in the printer.

Roll Width:

D t
ocumen ISO A1/A2 Roll (594.0 mm)
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« If the roll papers loaded in the upper and lower levels are different media types, the document is
printed on the roll paper that matches the media type specified in the print job.
If the document is being rotated 90 degrees for printing and the roll papers loaded in the upper
and lower levels have different widths and different media types, set the correct combination of
width and media type so that they match one of the roll papers loaded in the printer.

9. Complete the setup

Click OK.
When you print, the paper source is switched automatically to roll paper.

22 Important

» On the operation panel, if Printer settings -> Paper-related settings -> Roll paper auto switching
is set to Do not identify size, the document may be printed on the unintended roll paper. Canon
recommends that you set this setting to Identify size before you print.

+ 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible with
automatic cut-off. For checking which types of paper are compatible with automatic cut-off, look up the
paper you want to use on the "Paper Information List."

+ If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, you cannot switch
between upper and lower rolls corresponding to the media type specified by the print job. If different
types of roll paper are set for the upper and lower rolls, specify the media type, such as plain paper or
enameled paper, in Media Type.

»» Note

+ For details about how to switch the source levels depending on the print job, see "How to Switch Paper

Rolls."

I Printing by Saving Paper

Depending on the paper size that was specified in the print job, the printer automatically identifies the roll
paper that will produce the smaller margins.

Whether or not the page is rotated 90 degrees, the printer prints using conditions that produce the
smallest paper margins from among the Roll1 and Roll2 combinations.

Document

127



Al
O E [ [aza
O A |
BESE || VA oD | A4
v c':‘;ﬁ;.’-:': @I
Al e
o o A
(]
%) UEE
TS 0)
d:]l:} L
I
L Ty

Roll 1: ISO A1/A2 Roll 2: ISO A3/A4

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Set automatic paper source switching

On the Device Settings tab, select the Automatically switch paper sources (paper size priority)
check box.
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Gt Infomation....

. Click Get Information...

When the confirmation message appears, click Yes.
Your computer gets the paper size information from the printer and displays the width of the roll paper
that is actually loaded in the printer.

32 Important

* When you replace the roll paper loaded in the printer, always click Get Information... to obtain
the roll paper width information. If the roll paper width is not set correctly, you may not be able
to print the document as intended.

. Open the printer driver setup window

. Select the media type

The type of paper set in the printer is displayed.

. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

For Paper Source, select Roll Paper (Auto)

. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.

Complete the setup
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Click OK.
When you print, the paper source is switched automatically to roll paper.

32 Important

» This method switches the upper and lower levels depending on the paper size specified in the print
job. Always load the same media type for the roll papers in the upper and lower levels of the printer.
If different types of paper are loaded, an error could occur and you may not be able to print the
document as intended.

* If roll papers of the same width and type are loaded in the upper and lower levels and you want
to automatically switch the roll papers, clear the Automatically switch paper sources (paper size
priority) check box.

> Note

« If Roll 1 and Roll 2 produce the same margins, Roll 1 is used for printing.
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I How to Switch Paper Rolls

Here we will explain how, in certain situations, paper roll 1 and paper roll 2 are switched. Refer to this
information when necessary, for example, when documents will not print as expected, etc.

If you select Roll Paper (Auto) under Paper Source in the Page Setup tab, of the two paper rolls loaded in
the lower and upper trays of the printer, the one best suited for the print job will be automatically selected.

Whether paper roll 1 or paper roll 2 will be used, is determined through a sequence of judgment based on
the 7 conditions in the table below.

At such times, the Printer settings -> Paper-related settings -> Detect paper setting mismatch in the
Printer unit's Operation panel will switch to the result of the judgment based on the process described below.

« If the Detect paper setting mismatch setting is set on Pause or Hold job
« If the Detect paper setting mismatch setting is Display warning or Do not detect

22 Important

« If the lower roll unit is not loaded or if the roll unit that was set as the take-up unit is loaded, the roll
paper cannot be switched automatically.

»>» Note

« If Error or On hold are displayed, replace the paper to match the requirements of the print job.
* In order to minimize paper waste, it is recommended that you configure the operation panel on the
Printer unit as indicated below.
— In Printer settings -> Paper-related settings, set Roll paper auto switching to Identify size
— In Paper settings display area -> (Each paper type) -> Paper settings -> Advanced, set
Detect paper width to Enable

« If, on the Device Settings tab, a checkmark appears next to Automatically switch paper sources
(paper size priority), do not follow the table below.

If the Detect paper setting mismatch setting is set on Pause or Hold job

Condition Situation Judgment result
) Select the paper
Only one of either paper roll 1 or o
aper roll 2 is long enough roll of sufficient
i u
pap g g length
Neither paper roll 1 nor paper roll
2 are long enough Error
Whether the paper roll loaded on the printer is a 9 9
Condi- . . o
tion 1 long enough to print the paper size specified Both paper roll 1 and paper roll 2
for the print job.
are long enough
On the Printer's menu, Manage | To Condition 2
remaining roll amount is set on
Disable (length of the paper roll
cannot be determined)
| Whether the paper roll loaded on the printer | Only one of either paper roll 1 or | Select the paper
C_°nd" matches the paper type specified for the print | Paper roll 2 matches the paper | roll matching the
tion2 iop *1 type paper type

131



Neither roll 1 nor roll 2 match the
paper type

Error / On hold

Both paper roll 1 and paper roll 2
match the paper type

To Condition 3

It has changed to Do not identi-

Select the paper
roll currently be-

Condi- [!n the Printer menu, how has the Roll paper | fy size ing fed into the
tion 3 |auto switching setting changed? platen *2
It has changed to Identify size | To Condition 4
Select the paper
Only one of either paper roll 1 p P
or paper roll 2 is compatible with roll compatible
i ible wi
pap . P with borderless
borderless printing o
printing
Condi- |If borderless printing has been indicated for Neither paper roll 1 nor paper roll
tion 4 |the printjob (if it has not, on to condition 5) 2 are compatible with borderless | Error
printing
Both paper roll 1 and paper roll
2 are compatible with borderless | To Condition 5
printing
Only one of either paper roll 1 or | Select the paper
paper roll 2 has the width speci- | roll of the match-
fied for the print job ing width
Neither paper roll 1 nor paper roll
Whether the width of the paper roll loaded on | 2 have a width matching the one | Error / On hold
Condi- [the printer matches the paper width specified | specified for the print job
tion 5 |for the print job (only when printing borderless
or enlarging/reducing) Both paper roll 1 and paper roll
2 have a width matching the one
specified for the print job To Condition 6
Paper roll width has not been
specified for the print job
. . Select the paper
The width of the paper size . .
o . | roll in which the
specified for the print job only fits |
o i width of the paper
within the width of paperroll 1 or | . )
size fits comforta-
paper roll 2 bly
| Whether the width of the paper size specified
Condi- ¢, the print job fits within the width of the pa- | The width of the paper size
tion 6

per roll loaded on the printer.
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specified for the print job does
not fit within the width of either
paper roll 1 or paper roll 2

Error

The width of the paper size
specified for the print job fits

To Condition 7




within the width of both paper roll
1 and paper roll 2

Condi-
tion7

Is the width of paper roll 1 different from the
width of paper roll 2?

Roll width is different

Select the paper
roll whose width
is closer to the
width specified for
the print job

Roll width is the same

Select the paper
roll currently be-
ing fed into the
platen *2

*1 If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, the media type set in
the printer is recognized as being consistent with the media type specified in the print job.

*2 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll
1 is selected.

* When the printer has switched to sleep mode and has returned to the initial position
* When the printer has been turned on
* When cut sheet has been fed into the printer and has exited it

If the Detect paper setting mismatch setting is set on Display warning or Do not detect
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Condition Situation Judgment result
Select the paper
Only one of either paper roll 1 or . p P
aper roll 2 is long enough roll of sufficient
pap 9 g length
Neither paper roll 1 nor paper roll
2 long enough Error
Whether the paper roll loaded on the printer is are long 9
Condi- . . .
tion 1 long enough to print the paper size specified Both paper roll 1 and paper roll 2
for the print job.
are long enough
On the Printer's menu, Manage | To Condition 2
remaining roll amount is set on
Disable (length of the paper roll
cannot be determined)
Only one of either paper roll 1 or | Select the paper
paper roll 2 matches the paper roll matching the
type paper type
| Whether the paper roll loaded on the printer
C-ondl- matches the paper type specified for the print | Neither roll 1 nor roll 2 match the
tion 2 job. paper type
To Condition 3
Both paper roll 1 and paper roll 2
match the paper type
Select the paper
Condi- |In the Printer menu, how has the Roll paper | It has changed to Do not identi- | roll currently being
tion 3 |auto switching setting changed? fy size fed into the platen
*1




It has changed to Identify size

To Condition 4

Only one of either paper roll 1
or paper roll 2 is compatible with
borderless printing

Select the paper
roll compatible
with borderless
printing

Condi- |If borderless printing has been indicated for Neither paper roll 1 nor paper roll
tion 4 |the printjob (if it has not, on to condition 5) 2 are compatible with borderless | Error
printing
Both paper roll 1 and paper roll
2 are compatible with borderless | To Condition 5
printing
Only one of either paper roll 1 or | Select the paper
paper roll 2 has the width speci- | roll of the match-
fied for the print job ing width
Neither paper roll 1 nor paper roll
Whether the width of the paper roll loaded on | 2 have a width matching the one
Condi- |the printer matches the paper width specified | specified for the print job
tion 5 |for the print job (only when printing borderless
or enlarging/reducing) Both paper. roll 1 and .paper roll To Condition 6
2 have a width matching the one
specified for the print job
Paper roll width has not been
specified for the print job
The width of the paper size SeI(.act th.e paper
o L .| roll in which the
specified for the print job only fits |
within the width of paper roll 1 or v‘{ldth,Of the paper
size fits comforta-
paper roll 2
bly
| Whether the width of the paper size specified | The width of the paper size
C-ondl- for the print job fits within the width of the pa- [ specified for the print job does
tion 6 per roll loaded on the printer. not fit within the width of either
paper roll 1 or paper roll 2
To Condition 7
The width of the paper size
specified for the print job fits
within the width of both paper roll
1 and paper roll 2
Select the paper
roll whose width is
Roll width is different closer to the width
Condi- |Is the width of paper roll 1 different from the specified for the
tion 7 | width of paper roll 2?7 print job
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Roll width is the same

Select the paper
roll currently being




fed into the platen
*1

*1 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll
1 is selected.

* When the printer has switched to sleep mode and has returned to the initial position
* When the printer has been turned on

* When cut sheet has been fed into the printer and has exited it
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I Reflect Roll Unit Settings in the Printer Driver

Reflect printer unit's Roll Unit settings in the printer driver.
If the printer unit settings are reflected in the printer driver, the paper that can be set in the printer driver

settings will change to a status suitable to the printer unit status.

The following explains the procedure to reflect Roll Unit settings in the printer driver.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Click the Device Settings tab's Device Information

Click Acquire Status in the displayed Device Information dialog box, and then click Yes.
Printer unit settings will be reflected in the printer driver.

32 Important

+ In the event the lower roll unit is not set or the roll unit is being used as a wrapping device, the value
of Roll Unit will be set to No. In this case, Automatically switch paper sources (paper size priority)
will be grayed out and cannot be selected. Also, the Paper Source items that can be selected in the
Page Setup tab will change.
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I Printing Photos and Business Documents

» Printing By Setting Print Purpose

» Edit in PosterArtist and Print
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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. Select print purpose
For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

2 Important
» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterAtrtist.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist and printing in a poster layout.

1. Open the printer driver setup window

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.
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»» Note

» Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist

Click OK.
When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist

5. Edit page in PosterArtist

Image editing and sorting is implemented in PosterArtist.

By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple
application software can be arranged on one page.

After editing is complete, please print from PosterArtist menu.
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»» Note

» For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
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I Printing CAD Drawings

» Printing By Setting Print Purpose
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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. Select print purpose
For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

2 Important
» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Changing the Print Quality and Correcting Image Data

» Adjusting Color Balance

» Setting the Print Quality Level (Custom)

» Printing a Color Document in Monochrome
» Specifying Color Correction

» Adjusting Brightness

» Adjusting Contrast

¥

Printing Using Detailed Setting Mode
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I Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the advanced settings

Select Advanced Settings from the pull-down menu on the Main tab.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red
becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select the print quality

For Print Quality, select Custom.
The Custom dialog box opens.
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3% Important

« If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.

4. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.
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2% Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

I Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Monochrome.

»» Note

» The selectable Color Mode depends on the media type selected for Media Type on the Main tab.

4. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

152



3% Important

* When Monochrome is selected, the printer driver processes image data as sRGB data. In this case,
actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to SRGB data
using an application software.

»» Note

* When Monochrome is selected, inks other than black ink may also be used.
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I Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select Off.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the printer driver's original color profile. Normally, you should
choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

32 Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

« If Auto (Use Printer Settings) is selected for Media Type, the Matching sheet is not displayed, and
color correction occurs according to printer settings.
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I Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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I Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

I Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

»>» Note

* Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a
format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

I Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver

This section describes the procedure for printing data by using the color correction function of the
printer driver.

Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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I Adjusting Colors with the Printer Driver

To use printer driver matching when printing, turn on the printer driver's color correction function. Printer
driver matching accurately applies the characteristics of data displayed on the monitor and allows you to
obtain print results of impressions that are close to those displayed on the monitor.

22 Important

» When printing using printer driver matching, Canon recommends that you set the monitor and the
environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

»>» Note

* When printing from an application software that can identify ICC profiles and allows you to specify them,
use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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5. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster)
Reproduces vivid colors on data such as a poster.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you print, the colors get adjusted by the printer driver when printing the data.

I Related Topics

= Setting the Print Quality Level (Custom)
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= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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| Printing with IcC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

I Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself, be sure to select color management
items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Off for Color Correction.
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.
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5. Select input profile

Select the Input Profile you want to use.
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32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

6. Select the printer profile
Select Printer Profile as follows:

» To set the printer profile automatically:
Select Auto Settings.

» To set the printer profile manually:
Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Saturation
Reproduces vivid colors on data such as a poster.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

32 Important

* When you select Perceptual to print images, Canon recommends that you set the monitor
and the environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix + 125 Ix

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

32 Important
» Depending on the media type, you may obtain the same print results even when you change

the Rendering Intent setting.

8. Set the other items
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If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

= Canon Printing Preferences X

Man  Page Setp Lot Favodtes  Lbity

Madia Typa :P'I.mPaptr |
Get Informsterm Specdy
Iwm W I
Prirt Chusity Sandard ot
Plessodutaon: 30
Litier (B5 %117 Cabar Mo Color e
EShinxiidhin
4+ Aetusl Size Codor Seftings_

Letier (B5x117)
EShinx 100 n

[ Thaien e Lrsss

] Prevvrw before prrting

Sty Mordor, Aooounding,, Defmis

| Ok || Canes Fogly Hep

3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Contrast
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I Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase

the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

él Canoa Printing Preferences X

Man  Page Setp Leypsd | Favodes  Lbity

Meda Type: | Plan Paper vl
Gl Informsen [ Specdy
Imud!‘-mhpl. W I
Peiri Gty Sandard o
Pessod e 300dpi
Latier BEHIT7 Coker Masch Coler v
ESH w1008 i .
4+ Aetusl Size Conlar Seftings

Letier (E5®117)
EShinx 100 n

[) Thishen Fine Lises

3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
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| Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window
2. Select the media type
The type of paper set in the printer is displayed.
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3. Select advanced settings
From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions

Set the following items as necessary.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source
For Paper Source, select the setting that matches your purpose.

2% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with the print conditions you set.
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I Related Topics

= Adjusting Color Balance

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source
For Paper Source, select the setting that matches your purpose.

3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.
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6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding

check box.
The current settings are displayed in the settings preview on the left side of the window.
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* Fit Paper Size

Scales the document to match the paper size.
* Fit Roll Paper Width

|
| .
Scales the document to match the roll paper width.
* Scaling
B0%

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.

The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

22 Important

» When the application software which you used to create the original has the scaled printing function,
configure the settings on your application software. You do not need to configure the same setting in
the printer driver.

+ If you are performing enlarged/reduced printing when Automatically switch paper sources (paper
size priority) in the Device Settings tab is enabled, Fit Roll Paper Width is selected for Enlarged/
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Reduced Printing on the Page Setup tab, and Roll Paper (Auto) is selected for Paper Source, Roll 1
(upper level roll paper) is always used for printing.

»>» Note

 Selecting Enlarged/Reduced Printing changes the printable area of the document.
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I Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...
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The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

2% Important

» When printing to oversized paper sizes, use paper that has the following necessary margins added to
the document size.
— Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
— Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

»>» Note

* An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.
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» To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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I Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

I Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab
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The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify a size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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»» Note

+ By selecting the Borderless Printing Size check box for Paper Size, you can select a size
from the paper sizes that support Borderless Printing. By selecting the Fix the Ratio of the
Width to Height check box, you can change the size while keeping the Width and Height ratio.

4. Set user-defined paper

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

I Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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3. Set the custom paper size

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

22 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Paper Sizes."

* Any paper size that was set by using Custom Size can no longer be used after the application software

is closed.
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3> Note
« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can still print but you may not be able

to obtain correct print results.
» The maximum configurable size with Custom Size is 3.2m.
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I Set a Custom Size Roll Width

By specifying the roll paper width with a value, you can use roll paper with a width that cannot be selected in
Roll Paper Width.

The procedure for setting custom size roll width is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes between
Roll Paper (Auto), Roll 1 and Roll 2.
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3. Select paper roll width
In Roll Paper Width, select User-defined1 (XXXX) / User-defined2 (XXXX).
The Custom Size Settings dialog box opens.

4. Set paper roll width

Specify Units, enter the roll width you want to use, and then click OK.
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»» Note

« If the value you entered is the same as the other roll widths, a message will be displayed, and the
other roll paper sizes will be set.

5. Complete the setup

Click OK on the Page Setup tab.
If you perform the print, the roll paper with the specified width will be used for printing with each setting

applied.
3> Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

+ If you select a paper feed method for the custom size roll paper in Get Information... in the Main tab,
Roll Paper Width is set to Custom Size (XXXX).

However, if the same custom size is already set in User-defined1 (XXXX) or User-defined2 (XXXX),
it will not be set to Custom Size (XXXX), and User-defined1 (XXXX) or User-defined2 (XXXX) will be
selected instead.
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I Printing without Edges Based on the Scenarios

» Printing without Margins to Match Paper Size
» Printing without Margins to Match Roll Paper Width
» Printing Full-Size without Margins

» Three-sided Borderless Printing on Roll Paper
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I Printing without Margins to Match Paper Size
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The procedure for borderless printing by enlarging or reducing documents to match paper size is described
below.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes between
Roll Paper (Auto), Roll 1 and Roll 2.

3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

. Select a method for printing borderless

Select Fit Paper Size in Borderless Printing Method.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

. Complete the setting process

Click OK.
If you print now, the document will be printed without margins to fit the paper size.

32 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you print borderless while Automatically switch paper sources (paper size priority) in the Device
Settings tab is on, in the Page Setup tab, under Borderless Printing Method, you will only be able

187



to select Scale to fit Roll Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray)
will be normally used for printing. If the size, or the type, of the paper set in roll 1 is not compatible with
borderless printing, you will not be able to print borderless.

» The following roll paper supports borderless printing.

= Paper Sizes
+ If margins are formed on the left and right of the document, adjust the amount extending off paper

during borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Printing without Margins to Match Roll Paper Width

I ':|

Procedure for printing borderless by enlarging/reducing documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes between
Roll Paper (Auto), Roll 1 and Roll 2.

3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

. Select a method for printing borderless

Select Scale to fit Roll Paper Width in Borderless Printing Method.

. Complete the setting process

Click OK.
Job will print to the entire roll width without a white border.

22 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you print borderless while Automatically switch paper sources (paper size priority) in the Device
Settings tab is on, in the Page Setup tab, under Borderless Printing Method, you will only be able
to select Scale to fit Roll Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray)
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will be normally used for printing. If the size, or the type, of the paper set in roll 1 is not compatible with
borderless printing, you will not be able to print borderless.

» The following roll paper supports borderless printing.
= Paper Sizes

« If margins are formed on the left and right of the document, adjust the amount extending off paper
during borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Printing Full-Size without Margins

—

Procedure for printing borderless images in the same size as the original document without enlarging/
reducing them.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes between
Roll Paper (Auto), Roll 1 and Roll 2.

2% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

5. Select a method for printing borderless
Select Print Image with Actual Size in Borderless Printing Method.
6. Complete the setting process
Click OK.
If you print, the document is printed in the original size without white borders.
2» Important
+ If Amount of Extension is set to the second from the right, create the source document with a
size 2mm larger on each of the top, bottom, left and right sides than the size of the paper you wish
to print.
22 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you print borderless while Automatically switch paper sources (paper size priority) in the Device
Settings tab is on, in the Page Setup tab, under Borderless Printing Method, you will only be able
to select Scale to fit Roll Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray)
will be normally used for printing. If the size, or the type, of the paper set in roll 1 is not compatible with
borderless printing, you will not be able to print borderless.

The following roll paper supports borderless printing.

= Paper Sizes
If margins are formed on the left and right of the document, adjust the amount extending off paper

during borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Three-sided Borderless Printing on Roll Paper

g
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In normal borderless printing, paper sizes that match the width of the roll paper are combined to print without
borders on all four sides.

If you use the three-sided borderless printing feature, you can combine paper sizes that don't match the

roll paper width, and print with no borders on three sides. However, if you perform three-sided borderless
printing, you need to cut the right side of the paper after printing.

I Three-sided Borderless Printing to Match Paper Size

The procedure for three-sided borderless printing by enlarging or reducing documents to match paper size
is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes
between Roll Paper (Auto), Roll 1 and Roll 2.

32 Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.

. Click Borderless Setting

When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided
Borderless, and then click OK.
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. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Fit Paper Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

. Complete the setting process

Click OK.
If you print now, the document will be printed without margins on three sides to fit the paper size.

. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing. Cut slightly to the inside of the
margin as the document is enlarged to extend slightly beyond the specified size.

To get the document to standard size, it is recommended to take measurements and cut in the correct
positions.
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I Printing Full-Size without Margins on Three Sides

The procedure for three-sided borderless printing in the same size as the original document without
enlarging or reducing the size is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes
between Roll Paper (Auto), Roll 1 and Roll 2.

3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.
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5. Click Borderless Setting

When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided
Borderless, and then click OK.

Borderless Setting *

Amonrd of Extension _ﬁ_ . -EJ

6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Print Image with Actual Size
option.

7. Complete the setting process

Click OK.
If you print now, the document will be printed without margins on three sides while retaining the same
document size.

8. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing.
To get the document to standard size, it is recommended to take measurements and cut in the correct

positions.
S ) ' | L
2 &
32 Important

« If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.

» Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

* When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left margin. After the printed material has exited the printer and has been cut, cut the
upper, lower, and right edges with a pair of scissors.

* When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.
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You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

» The following roll paper supports borderless printing.
= Paper Sizes

+ If margins are formed on the left of the document, adjust the amount extending off paper during
borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Hanging and Horizontal Banners (Large-Format
Printing)

A drapery or banner can be made by enlarging or reducing original documents made on application
software.

The procedure for printing hanging and horizontal banners is as follows:

| Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Size on the Page Setup
tab.

In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Paper Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

I Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

»» Note

» Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.

For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.

(when setting length to 1/6 the user-defined paper)

— User-defined paper 1: Width 600mm, Height 3,000mm

— User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software

Use the registered user-defined paper 2 size to create original document using an application.
3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in the Page Size on the Page Setup
tab.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

»>» Note

» Maximum printable length is 18.0 m. In the event the enlarged length exceeds 18.0 m, the part of the
image exceeding the length will not be printed.

« If printing cannot be performed correctly, you may be able to improve printing by using the Special
Settings dialog box on the Layout tab to change FineZoom Settings to Yes.
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I Printing by Dividing/Joining Documents

» Inputting Documents Created Using Multiple Applications into Free Layout plus
» Printing by Connecting Multiple Pages
» Printing Multiple Pages All on One Page

» Dividing and Printing Posters
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I Printing by Connecting Multiple Pages

Print documents with several pages as one continuous document. When you do this, the spaces between
the pages will be removed.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.
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3% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Set roll paper options

Click Roll Paper Options... to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

Roll Paper Optaons .
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4. Complete the setup
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Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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I Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size
From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.

Page Layout Prinking X

Corcs | [ Detmts e

Page Order
To change the page arrangement order, select a placement method from the list.
Page Border

To print a page border around each document page, select something other than None from the list.

5. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

2» Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the
Page Setup tab, Page Layout is grayed out and cannot be set.

« If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW Spooling),
Page Layout is grayed out and cannot be set.
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| Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

I Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of divisions

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

3% Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on
the Page Setup tab, Page Layout is grayed out and cannot be set.

+ If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW
Spooling), Page Layout is grayed out and cannot be set.

I Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range

Clear the check boxes of the pages you do not want to print.

In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.

Check the pages to be printed, and then click OK.
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3> Note
* In the setting view on the left side of the Pages to Print dialog box, you can also clear the
display by clicking the pages you do not want to print.

To redisplay a cleared page, click that page again.
» To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

22 Important
« If you partition and print as a poster, the source document will be printed in enlarged form, so the print

results may become rough.
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I Printing Document in Center of Paper

When you want to position the source document in the middle of the cut sheet and print, or print with even
margins on the right and left in relation to the width of the roll paper, use the Print Centered function.

The print results when setting with Print Centered are as follows. Normally, if Print Centered is set when
printed as in (A), it will be printed as in (B) for cut sheet and (C) for roll paper.
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»>» Note

* When setting the magnification using Scaling from Enlarged/Reduced Printing on the Page Setup
tab and printing, the start point for enlarge/reduce will always be fixed based on the top left corner of
that page. For that reason, for reduced printing, the bottom and right margins of the paper will increase.
At this time, if you place a checkmark next to Print Centered on the Layout tab, the top, bottom, left
and right margins can all be printed evenly.

The procedure for printing in the center of the paper is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select the paper size

Select the size of the paper you want to print from Page Size on the Page Setup tab.
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4. Set magnification as necessary

Where necessary, attach a checkmark next to Enlarged/Reduced Printing, and set according to the

objective.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.
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2% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

7. Print document in the center of paper

Select the Print Centered check box on the Layout tab.
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8. Complete the setup

Click OK.
When you print, the document is printed in the center of the paper.
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I Printing by Saving Roll Paper

» Saving Roll Paper by Rotating Document 90 Degrees

» Saving Roll Paper by Eliminating Upper and Lower Margins on Document
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I Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

4. Select the paper source

From the Paper Source list on the Page Setup tab, choose the best option for your purposes between
Roll Paper (Auto), Roll 1 and Roll 2.

2» Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width
For Roll Paper Width, select the width of the roll paper loaded in the printer.
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7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

22 Important
* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the Page

Setup tab, Rotate Page 90 degrees is grayed out and cannot be set.
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* When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in the
vertical direction is longer than the width selected in Roll Paper Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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Saving Roll Paper by Eliminating Upper and Lower Margins on
Document

When printing on roll paper, you can save paper by reducing the upper and lower margins when printing.

The procedure for saving paper by reducing the upper and lower margins is as follows:

1. Open the printer driver setup window

2. Select the media type
The type of paper set in the printer is displayed.
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3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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4. Select the paper source
For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.
3% Important
* The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

5. Select roll paper width
For Roll Paper Width, select the width of the roll paper loaded in the printer.

6. Selecting Paper Saving

On the Layout tab, select the No Spaces at Top or Bottom check box.
The current settings are displayed in the settings preview on the left side of the window.
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. Complete the setup

Click OK.
When you print, the upper and lower margins are reduced so that you can save paper.

218



I Switching the Paper Source to Match the Purpose

This printer has three paper sources: Roll 1, Roll 2, and Cut Sheet.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.

3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.
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Roll Paper (Auto)
Feeds paper by automatically switching between Roll 1 and Roll 2 according to the print job.

Roll 1
Feeds paper from Roll 1.

Roll 2
Feeds paper from Roll 2.

Cut Sheet
Feeds paper using the cut sheet.

32 Important
» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit

option settings.

4. Complete the setup
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Click OK.
When you execute print, the printer uses the specified paper source to print the data.

»» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer,
an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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I Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

I Related Topic

= Canon imagePROGRAF Preview

221



I Other Convenient Settings

» Stamp Printing
» Setting a Page Size and Orientation
» Registering a Frequently Used Printing Profile

» Cutting Roll Paper after Printing
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I Stamp Printing

The Stamp function allows you to print a stamp text over or behind document data.
"DRAFT," "CONFIDENTIAL," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.
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3. Complete the setup
Click OK.

When you execute print, the data is printed with the specified stamp.

22 Important

» Depending on your usage environment, you may not be able to use the Stamp function. In this case,
set Spooling at Printer Driver in the Special Settings dialog box to Yes.
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I Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

I Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
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The Define Stamp dialog box opens.
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3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.

In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.

Change the Font, Style, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.

Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

I Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Stamps, select the title of the stamp you want to change the settings for.
3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

»» Note

» The stamp registered as the default setting cannot be changed.

I Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Stamps and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup
Click OK to return to the Layout tab.
3> Note

» The stamp registered as the default setting cannot be deleted.
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I Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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I Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:
I Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....
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4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.

The name and the icon appear in the Favorites list.

To check the settings of the registered favorite, click Settings Details.

»» Note

» To save the settings of the favorite to a file, click Export... on the Favorites tab.

I Printing Using Favorite Settings
1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

I Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.

» The settings of the favorite being applied to the current print settings cannot be deleted. To delete
that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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I Cutting Roll Paper after Printing

The procedure for cutting roll paper automatically and printing cut guidelines is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.
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2% Important

» The paper feed method will differ depending on the lower level (roll paper 2) settings or roll unit
option settings.

3. Display Roll Paper Options dialog box
Click Roll Paper Options to display the Roll Paper Options dialog box.

Rell Paper Optaons -

Jud e Cuting Ted w

Cancel Delmds Help

4. Set auto cut

From Automatic Cutting, select the item that matches your purpose.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

* Yes

The roll paper is cut automatically after printing.
* No
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The roll paper is not cut after printing.
* Print Cut Guideline

Cut guidelines are printed for cutting the roll paper manually after printing.

»» Note

» The default setting for automatic cutting is Yes.
After completing the setting, click OK to return to the Page Setup tab.

5. Complete the setup

Click OK on the Page Setup tab.
When you print, the status after printing is set to whatever was set in Automatic Cutting.
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I Printing from Printer

» Printing Data Saved on USB Flash Drive
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I Printing Data Saved on USB Flash Drive

You can print photo data (JPEG file) or document data (PDF file) saved on the USB flash drive easily.
¥>» Note
* Restrictions on printable PDF/JPEG files
— PDF file:
Files which conforms to V 1.7
-Does not support overprint or some of transparent processing.

-Font embedding is recommended. If a font is not embedded, it is replaced with one of the built-in
fonts below.

Times-Roman, Helvetica, Courier, Symbol, Times-Bold, Helvetica-Bold, Courier-Bold,
ZapfDingbats, Times-lItalic, Helvetica-Oblique, Courier-Oblique, Times-Boldltalic, Helvetica-
BoldOblique, Courier-BoldOblique

— JPEG file:
Files which conforms to JFIF 1.02
Supports the files with the following conditions.
-Processing method: Basic DCT
-Color mode: RGB/GrayScale
-Number of colors: 24bit/8bit
-Number of pixels: 38400 or less vertically and horizontally

Does not support some samplings

1. Load paper.

= Loading Rolls in the Printer
= [ oading Roll Paper in the Roll Unit
= | oading Sheets in the Printer

2. Insert USB flash drive into the USB flash drive connector.

3. Select E Print from USB flash drive on HOME screen.
> Note

* When the message informing you that the operation restriction is enabled, ask the administrator of
the printer you are using.

+ If no printable data is saved on the USB flash drive, There are no files that can be printed. is
displayed on the touch screen.

4. Select folder or data to print.

The print standby screen is displayed.
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N

1)

sample.pdf
B
Preview | Print settings ||

A. Number of copies

Select to change the number of copies.

A

sample.p

B. Preview
Select to preview an image of the printout on the preview screen.

Specify the pages to preview and print only specific pages.

C. Print settings

Select to check or change settings on the Print settings screen.
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Print settings

@ Color Color (perceptual) Stop

Print glty 3

Paper src Auto select

]

Apply

5. Select Start.
The printer starts printing.
2> Note

» On the displayed screen, select Yes to return to step 4, or select No to return to the HOME screen.
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I Printing from Smartphone/Tablet

For more on printing from a device, refer to the device's or application's instruction manual.

» Print Easily from a Smartphone or Tablet with Canon PRINT

» Printing from iOS Device (AirPrint)
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I Enlarging Copy with imageRUNNER ADVANCE

Copy scanned with imageRUNNER ADVANCE can be sent to the printer via FTP.

I Enable FTP from Remote Ul.

1. Start up Remote UI.

= Start up Remote Ul

2. Select System info and LAN settings.
3. Select LAN settings.

4. Select Advanced setup.

5. Confirm the message and select Yes.
6. Select FTP settings.

7. Select Enable.

8. Select Use authentication check box and Set/change password check box, and then
enter a user name and password.

The user name and password you enter in this step are used for FTP authentication. Enter the same
value for FTP settings of imageRUNNER ADVANCE.

9. Select OK.

Please wait momentarily appears and returns to the startup screen.

10. Close web browser.
I Perform enlarge settings on the operation panel.
El
1. Select Printer settings on HOME screen.
2. Select Print settings.

3. Select Direct print settings from FTP.

4. Select the number to set.
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Direct print settings from FTP

Print settings 1

Print settings 2
Print settings 3

Print settings 4

See the following two types of enlargement setting methods.

= Fitting to Paper Width
= Specifying Magnification Level

I Scan and enlarge copy
1. Place the copy on the platen glass or feeder of imageRUNNER ADVANCE.

2. Select Scan and Send.

4. Select File.
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5. Select FTP from the Protocol drop-down list.

frdsgars 4

his
Loty P 1 et B v

6. Enter setting items.

uhimy Srdsaies §
Soectly ot T it i v

Enter the printer's IP address as the Host Name.

»» Note

» We recommend that you set a fixed IP address for your printer.
Enter "./folderN" in Folder Path. ("N" represents the print setting number specified in the Direct print

settings from FTP screen on the printer.) For example, to enter the pathname for Print settings 1,
enter "./folder1". For Print settings 2, enter "./folder2".

Use the same User Name and Password that you set for FTP authentication in the Remote UI.
7. Select OK.

8. Select the setting button for file format.
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9. Select File Format.

Select PDF or JPEG.
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»» Note

« If you select PDF, remove the check from the Compact and Encrypt check boxes.

10. Specify the settings as necessary.
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32 Important
» Select 300x300 dpi or 600x600 dpi as the resolution.

11. Press (Start).

If you are placing your originals on the platen glass, press (Start) to scan each original.

12. When scanning is complete, select Start Sending.
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Scanned originals are sent to the printer and printing starts.

23> Note

* It is recommended to register the setting contents in Favorite Settings.
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| Fitting to Paper width

1. Select Paper settings.

Print settings 1

A

Print quality settings

” Paper settings

Line & pen manager

=o)

Processing options

2. Select Enlarge/Reduce.

Paper settings
Save paper
Rotate
Auto rotation

“
” Enlarge/Reduce

3. Select Fit paper size.

Fit paper size ﬂ S
op

Same size

Scaling

»» Note

» Change the image quality in Print quality settings if necessary.
* You can specify the orientation of the image from Rotate.
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I Specifying Magnification Level

I Setting Input resolution
1. Select Print quality settings.

Print settings 1

@ “ Print quality settings H Stop

Paper settings
Line & pen manager

Processing options

2. Select Input resolution.

Print quality settings
@ Color mode

Print quality

Input resolution |

ho

Select the input resolution that matches your output requirements.
600 dpi
Select when printing at 600 dpi.

300 dpi
Select when printing at 300 dpi.

Specify print job
Select to match the input resolution of the printer with the scanning resolution when scanning the
original in JPEG format.

32 Important

* When scanning the original in JPEG format with imageRUNNER ADVANCE, match the
scanning resolution with the input resolution of the printer. If the resolution is different, it will
not be printed at the specified magnification level.
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I Setting scale percentage
1. Select Paper settings.

Print settings 1

&

Print quality settings

“ Paper settings

Line & pen manager

Processing options

2. Select Enlarge/Reduce.

Paper settings
Save paper
Rotate
Auto rotation

“ Enlarge/Reduce

3. Select Scaling.

Fit paper size

Sav ;
Same size

Rot: - -
Scaling

Aute

Enla

4. Select the scaling input area (A) on the displayed screen.
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Scaling

100 A

{25-400)%

oK

5. Enter the scale percentage, and then select OK.

Scaling

&

For commonly used magnification conversions, refer to Reference for Magnification.

6. Select OK on the displayed screen.

Scaling

A

283

{25-400)%

[ x ]

»» Note

» Change the image quality in Print quality settings if necessary.
* You can specify the orientation of the image from Rotate.

Reference for Magnification
* ISO A format

Original size

245



246

A4 A3
A4 100% 71%
A3 141% 100%
Output size A2 200% 141%
A1 283% 200%
A0 400% 283%
ANSI format
Original size
Letter Legal Ledger
8.5"x 11" 8.5" x 14" 11" x 17"
C 200% 157% 129%
Output size D 258% 242% 200%
E 400% 314% 258%
ARCH format
Original size
A B
A 100% 66%
B 133% 100%
C 200% 133%
Output size
D 266% 200%
E 400% 266%
E1 333% 233%




I Managing Print Jobs

» Handling Print Jobs

Deleting Print Jobs
Priority Printing
Printing Pending Jobs

Printing Security Print Jobs

» Using the Printer Hard Disk to Handle Print Jobs

Using Printer Hard Disk

Saving Print Jobs in Personal Job Boxes

Printing Saved Jobs

Deleting Saved Jobs

Moving Saved Jobs

Saving Print Jobs Sent from Sources Other than Printer Driver
Printing without Saving Jobs in Common Job Box
Setting Passwords for Personal Job Boxes
Naming Personal Job Boxes

Printing List of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space

» Collecting Printer Job Logs Using Accounting Manager
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| Handiing Print Jobs

» Deleting Print Jobs
» Priority Printing

» Printing Pending Jobs

¥

Printing Security Print Jobs
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I Deleting Print Jobs

You can delete a print job as needed.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

I Using Operation Panel

1. Select . Job management on HOME screen.
2. Select Print job.

3. In the list, select the target job.
3> Note

+ Select Del. selected to delete multiple jobs at one time.

4. Select Delete.

Print job details

@ Document name
lobName1
lob status
Receiving...
User name

|| Delete

5. Confirm the message and select Yes.
2> Note
» Select Delete all print jobs on Job management to delete all jobs in the job queue

= Job management

I Using Remote Ul

1. Start up Remote UI.

= Start up Remote Ul
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. Select Job management.
. Select Print job.
. In the list, select the target job.

. Select Delete.

. Confirm the message and select Yes.
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I Priority Printing

Specify a print job that is being received to change its print order (Priority printing).
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

> Note

 For the operation of the print job with the . icon (pending print job), see Printing Pending Jobs.

* For the operation of the print job with the ﬂ icon (security print job), see Printing Security Print
Jobs.

I Using Operation Panel

1. Select . Job management on HOME screen.
2. Select Print job.
3. In the list, select the target job.

4. Select Priority printing.

Print job details

@ Document name Stop
lobMame]
Job status
Receiving...

User name v

_- =
Delete ﬂ Priority printing ||

5. Confirm the message and select Yes.

I Using Remote Ul

1. Start up Remote UI.

= Start up Remote Ul

2. Select Job management.

251



3. Select Print job.
4. In the list, select the target job.

5. Select Prioritize.
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I Printing Pending Jobs

If the type or size of paper loaded does not match the settings in the print job received when you have set
Detect paper setting mismatch to Hold job in the operation panel, the print job is held on the printer as a
pending job in the job queue.

To print held jobs, replace the loaded paper with the paper specified in the print job.

= [ oading Rolls in the Printer
= [ oading Roll Paper in the Roll Unit
= | oading Sheets in the Printer

This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

»>» Note

* As long as you do not manage held jobs from the operation panel, they will remain in the job queue. In
this case, the printer processes the next job in the queue without pausing.

I Using Operation Panel

1. Select . Job management on HOME screen.

2. Select Print job.

3. In the list, select print job with . icon on the left.

4. Select Release hold.

Print job details

@ Document name
JobName1l
Job status
On hold...
User name

Delete | Release hold ”

5. Confirm the message and select Yes.
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I Using Remote Ul

1. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.

3. Select Print job.

!
4. In the list, select print job with D icon on the left.

5. Select Release.

254



I Printing Security Print Jobs

A security print job is a print job that requires you to enter the PIN code set in the printer driver when
printing.

The print job specified for the security print job has a lock icon to the left of the job name in the list such as
List of print jobs.

»» Note

* The security print job remains saved as a normal pending job until you enter the PIN code using the
operation panel or Remote Ul. In this case, the printer processes the next job in the queue without
pausing.

* When deleting a security print job, you do not need to enter a PIN code.

1. Select . Job management on HOME screen.

2. Select Print job.

3. In the list, select print job with ﬂ icon on the left.

4. Select Print.

Print job details

@ Document name Stop

JobName
Job status

Awaiting authentication
User name

Delete

5. Enter PIN code you set and select OK.

Enter the PIN.

@

“s Enter PIN

Show PIN
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6. Select OK.
PIN authentication successful. is displayed and printing starts.

»» Note

» The security print job is deleted after printing.
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| Using the Printer Hard Disk to Handle Print Jobs

>

>

Using Printer Hard Disk

Saving Print Jobs in Personal Job Boxes

Printing Saved Jobs

Deleting Saved Jobs

Moving Saved Jobs

Saving Print Jobs Sent from Sources Other than Printer Driver
Printing without Saving Jobs in Common Job Box
Setting Passwords for Personal Job Boxes
Naming Personal Job Boxes

Printing List of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space
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I Using Printer Hard Disk

The printer can save print jobs on the built-in hard disk.

Saving print jobs offers the following benefits.

» Save the time spent using a computer
When you send a print job to the printer, you can save it on the printer after printing or simply save it on
the printer without printing it yet. Saved print jobs can be printed in the required quantity later without the
need to use a computer again.

+ Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing
the error without resending the print job from a computer.

» Streamline printing work

Without using a computer, you can select print jobs and print in the desired quantity. You can also
select multiple print jobs to print during the same period. This enables unattended operation at night, for
example.

I Output Method

To save print jobs on the printer's hard disk, configure the printer driver.
In Windows, this is set using the Output Method dialog box.
In macOS, this is set by selecting Additional Settings in Printer Options of the printer properties dialog.

Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Set PIN for printing
Set a 7 digit security code. To start printing, enter the PIN set here using the operation panel. If the
entered PIN does not match the set PIN, the printing does not start.

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not start
printing.

I Storage Destination

The storage area on the printer's hard disk is divided into a temporary storage area and a permanent
storage area. The temporary storage area stores print jobs in the job queue or common job box. The
permanent storage area stores jobs in personal job boxes.
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Job queue
The job queue refers to print jobs that are being processed by the printer (saved, received, prepared
for processing, printed, deleted, or held). Up to 100 jobs can be stored in the temporary storage area.
However, the number of jobs available as queued jobs is up to 64.

When the maximum number of job queues are saved, the print job sent from the computer is in a
state of waiting for processing.

However, if all saved job queue states are pending, the oldest job queue of the saved date and time
will be deleted and the print job sent from the computer will be processed.

Common job box
Jobs for which you have specified Print in Output Method are saved in common job box and
classified as saved jobs.

There is one common job box, numbered "00". A password cannot be set for common job box.

Up to 100 print jobs can be saved here. However, they will be deleted one after another starting with
the oldest job in the following situations.

« If there are over 101 jobs queued and saved in common job box combined

+ If no more temporary storage space is available when jobs for which you have selected Print in
Output Method are received

+ If there is not enough space in the temporary or permanent storage area when jobs for which you
have selected Save in Job Box in Output Method are received.

Personal job boxes
In the following cases, the job is classified as saved job and saved in a personal job box on the
permanent storage area.

* When a saved job stored in common job box is moved to a personal job box
* When you have selected Save in Job Box in Output Method

There are 29 personal job boxes, numbered "01" to "29". You can specify a name and password for
each personal job box.

Up to 100 print jobs can be saved in all personal job boxes combined.
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I Saving Print Jobs in Personal Job Boxes

To save print jobs in personal job boxes, configure the printer driver.

I Configuring Printer Driver (Windows)

1. Open printer properties dialog box.

= How to Open the Printer Driver Setup Window

2. Select Page Setup tab.
3. Select Output Method.
4. Select Save in Job Box in Output Method.

5. In Name of data to be saved, specify how to name saved print jobs.
To use the file name, select Use file name.

Otherwise select Enter name and enter a name in Name.

6. Select a personal job box in Job Box.

> Note

» Select Acquire Job Box Name to display personal job box names in the Job Box list, as
acquired from the printer.

7. Select OK.

I Configuring Printer Driver (macOS)

1. Open printer properties dialog.

= How to Open the Printer Driver Setup Dialog
2. Select Additional Settings in Printer Options.

3. Select Save in Job Box in Output Method.
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I Printing Saved Jobs

Print saved print jobs stored on the printer's hard disk as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

I Using Operation Panel

1. Select . Job management on HOME screen.
2. Select Saved job.

3. In the list, select the target job box.

»» Note

« If an administrator password is set, enter the password.

4. Select Job list.
5. In the list, select the target job.
6. Select Print settings.

7. Specify the number of copies.

1. To change the number of copies, select the number of copies display area (A).
A

o [ 1]

Document name is not entered.

int ti 00000
., Print time 0:00:00

2. Specify the number of copies and select OK.
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Print tim

8. Select Start.

I Using Remote Ul

1. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.
3. Select Saved job.

4. In the list, select the target job box.

> Note

« If an administrator password is set, enter the password.

5. In the list, select the target job.
6. Select Print.
7. Enter the number of copies.

8. Select Yes.
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I Deleting Saved Jobs

Delete saved print jobs stored on the printer's hard disk as follows.
This operation is available using the operation panel or Remote Ul.

= Using Operation Panel
= Using Remote Ul

I Using Operation Panel

1. Select . Job management on HOME screen.
2. Select Saved job.

3. In the list, select the target job box.

»» Note

« If an administrator password is set, enter the password.

4. Select Job list.
5. In the list, select the target job.
6. Select Delete.

7. Confirm the message and select Yes.

I Using Remote Ul

1. Start up Remote UI.

= Start up Remote Ul

2. Select Job management.
3. Select Saved job.

4. In the list, select the target job box.

»» Note

« If an administrator password is set, enter the password.

5. In the list, select the target job.
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6. Select Edit.

7. Select Delete.

8. Select Yes.
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I Moving Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current job box to another job
box as follows.

However, jobs saved in personal job boxes cannot be moved to common job box.

22 Important

+ Jobs stored in common job box may be automatically deleted under some conditions. To prevent jobs
from being deleted, move them from common job box to personal job boxes.

= Using Printer Hard Disk

—

. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.
3. Select Saved job.

4. In the list, select the target job box.

»» Note

+ If an administrator password is set, enter the password.

5. In the list, select the target job.
6. Select Edit.

7. Select Move.

8. Select Destination job box.

9. In the list, select the personal job box to move to and select OK.

»» Note

« If an administrator password is set, enter the password.
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I Saving Print Jobs Sent from Sources Other than Printer Driver

To save print jobs sent from software or systems other than the printer driver or applications provided with
the printer, specify the output method and select the setting to perform printing after saving printing data
using the operation panel.

»» Note

+ Contact the software or system developer for information about support for this printer function.

22 Important
» The administrator password is required to change settings if it is enabled for changing settings using the

operation panel.

= Specifying Output Method
= Printing after Saving Printing Data

I Specifying Output Method

Perform settings for printing or saving print job.

1. Select ! Printer settings on HOME screen.

2. Select Hard disk settings.

Enter administrator password if it is enabled.
3. Select Output method.

4. Select the output method you want to set up.

Print
Save print jobs automatically at the same time they are printed.

Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.

Save to job box
Save print jobs on in the personal job box.

I Printing after Saving Printing Data

To save print jobs on the hard disk before printing, select ON for Save first and print.

Printing will start when Save first and print is set to ON, even if you have selected Save to job box for
Output method.

1. Select ! Printer settings on HOME screen.
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2. Select Hard disk settings.

Enter administrator password if it is enabled.
3. Select Save first and print.

4. Select ON.
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I Printing without Saving Jobs in Common Job Box

Jobs sent from a computer for which you have selected Print in Output Method in the printer driver are
saved in common job box.

= Using Printer Hard Disk

When Common job box settings is set to Print (auto delete) in the operation panel menu, print jobs for
which you have selected Print in Output Method in the printer driver are deleted from common job box after
printing.

Use this function when printing highly confidential documents.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

-
o
1. Select ! Printer settings on HOME screen.

2. Select Hard disk settings.

Enter administrator password if it is enabled.
3. Select Common job box settings.

4. Select Print (auto delete).
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I Setting Passwords for Personal Job Boxes

For greater security, you can specify a password for personal job boxes. After setting the password, it is
necessary to enter the password when performing the following operations.

» Change personal job box settings
+ Display / print the list of jobs saved in personal job box, print / delete / move /rename jobs saved in
personal job box

»>» Note

» By default, no passwords are set for personal job boxes.

» A password cannot be set for common job box.

+ Enter a seven-digit number as the password, in the range 0000001 to 9999999.

» Even if you have set passwords, they are not required to access personal job boxes in Administrator
Mode in Remote UI.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.

3. Select Saved job.

4. In the list, select the target job box.
5. Select Edit.

6. Select Set/change password check box and enter password. (This field is limited to seven
digits in the range 0000001 to 9999999.)

7. Select OK.
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I Naming Personal Job Boxes

For easier identification, you can assign names to personal job boxes.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.
3. Select Saved job.

4. In the list, select the target job box.

> Note

» Enter the password if the personal job box has it.

5. Select Edit.

6. Enter name and select OK.
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I Printing List of Saved Jobs

The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by job box as follows.

1. Select . Job management on HOME screen.
2. Select Saved job.

3. In the list, select the target job box.

»» Note

» Enter the password if the personal job box has it.

4. Select Print the job list.

For each job box, a list of saved jobs is printed.
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I Renaming Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Job management.
3. Select Saved job.

4. In the list, select the target job box.

> Note

» Enter the password if the personal job box has it.

5. In the list, select the target job.
6. Select Edit.
7. Select Change.

8. Enter name and select OK.
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I Printer Hard Disk Operations

Printer hard disk operations are available from the following programs and interfaces.

* Printer driver
* Remote Ul

» Operation panel

The hard disk operations available through each interface are as follows.

Operation Printer driv- [ Remote Ul | Operation
er panel
Saving print jobs Save to job box v - -
Print without saving jobs in common job box - -
Save print jobs sent from sources other than - - v
printer driver
Operations with saved jobs | Print saved jobs - v v
Delete saved jobs - v v
Job queue management Display job queue - v v
Delete - 4 4
Priority printing - v v
Operations with pending jobs - v v
Operations with security print jobs - - v
Delete Operations with security jobs - v v
Job box management Move saved jobs - v -
Modify saved jobs - v -
Modify job boxes - v -
Print a list of saved jobs - - v
Display a list of saved jobs - v v
Other operations Display free hard disk space - v
Initialize hard disk - - v
Display the time of printing - v v
Display error messages - v
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I Checking Free Hard Disk Space

Check the space available on the printer's hard disk as follows.

This operation is available using the operation panel or Remote Ul.

I Using Operation Panel

1. Select ﬁ Printer information on HOME screen.

2. Select Hard disk information.

The free hard disk space (job box free space) appears.

I Using Remote Ul

1. Start up Remote UI.

= Start up Remote Ul

2. Select Job management.

3. Select Hard disk information.

The free hard disk space (job box free space) appears.
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I Windows Printer Driver

» Overview of the Printer Driver
» Printer Driver Description

» Updating the Printer Driver
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I Overview of the Printer Driver

>

>

Canon IJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window
Updating Media Information in Printer Driver
Setting Accounting Information

Set a PIN Code for Print Jobs

Deleting the Undesired Print Job

Canon |J Status Monitor

Instructions for Use (Printer Driver)
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I Canon |J Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

I Installing the Printer Driver

To install the printer driver, install the driver from the Setup CD-ROM or our website.

I Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

I Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

I Related Topic

= How to Open the Printer Driver Setup Window
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I Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab
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Special Settings *
Cetings Summany:

Parameler S

Spooing & Porter Dever

FineZoom Setings Ao

Presiewe Swichag o

Aopheaton Color Mtching Pricety o

Dunable the color prfile seting of the soplcation setiware O

Speciy Pattem Resslbion ]
Spockeg ot Frnter Driver:
e v

Carcn Detmts re

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.
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I Canon imagePROGRAF Preview

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

I Related Topic

= Displaying the Print Results before Printing
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I How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

I Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

I Opening the Printer Driver Setup Window from the Printer Icon
Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

The following instructions are shown using screens displayed in Windows 11 as an example.
1. Select the Settings -> Bluetooth & devices -> Printers & scanners

2. Click your model name icon, and then select Printing preferences from the displayed
menu

The printer driver setup window appears.

»» Note

« If you're using Windows 10 or earlier, follow the steps below to display the printer driver settings
screen.
1. Select the Control Panel -> Hardware and Sound -> Devices and Printers

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

Opening the printer driver setup window through Printer properties displays such tabs
regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.

280



I Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.

When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Update media information

Click Update Media Information the Device Settings tab.

When a confirmation message appears, click Start.

If the paper information on the driver cannot be updated, click Initial Check Items and check the
displayed information.

The printer driver media information will update.

32 Important

+ It may take some time to update the media information.

4. Finish updating media information

When a confirmation message appears, click OK.
The media information will be updated.

32 Important

* Restart the printer driver after updating media information.
» Do not change media information on the printer while you are updating media information on
the driver.

2% Important

» Ensure that a user with administrative privileges carries out the media information update.
Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

* When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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I Setting Accounting Information

By setting accounting information, you add IDs to print jobs, and use the printer and cost management tool
to tabulate print history information for any ID. You can also lock accounting information, or require this
information be entered before printing.

The procedure for setting accounting information is described below. To lock accounting information or

require it to be entered, refer to Setting Accounting Information from Printer properties to change the
settings.

I Entering Accounting Information for Print Jobs

1. Open the printer driver setup window

2. Click Accounting... on the Main tab
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The Accounting dialog box opens.

3. If necessary, complete the settings

»» Note

+ If required fields are left blank, a warning will be displayed and printing cannot be started.

I Setting Accounting Information from Printer properties

Administrators can use the following settings to lock accounting information or require it to be entered.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.
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2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's properties window appears.

3. Click Accounting on the Device Settings tab
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The Accounting dialog box opens.

4. If necessary, complete the settings

If you want to require accounting information, check the check box to make each item required.
To prevent changes to accounting information, check the checkbox to set each item as fixed.

After completing the setting, click OK to return to the Device Settings tab.
2> Note

+ If you made accounting information a required field, you need to enter accounting information in
the Accounting dialog box in the Main tab. Printing will not start until you do this.

5. Apply the settings

Click OK or Apply.
The settings are enabled hereafter.
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I Set a PIN Code for Print Jobs

If you set a PIN code to your print jobs, the print jobs remain in standby status until the PIN code is entered
on the printer operation panel.

As the material is printed immediately after entering the PIN code, issues such as retrieving the wrong
documents and allowing others to peek at your documents can be prevented.

The procedure for setting a PIN code to your print jobs is explained here.

1. Open the printer driver setup window

2. Set the output method

Click Output Method... in the Page Setup tab.

3. Set the PIN code

Place a checkmark next to Set PIN for printing, and enter a one to seven-digit number in PIN.
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4. Complete the setup

Click OK.
When you print, the print job is set to standby status on the printer unit.
If you enter the PIN code you set on the printer operation panel, the print job will be printed.

»» Note

+ See "Printing Security Print Jobs" for instructions on how to operate using the printer operation panel.
* Print jobs with a PIN code set are not saved on the printer hard disk.
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I Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor

Click Status Monitor... on the Main tab.
The Canon |J Status Monitor appears.

3. Display the print jobs

Click Display Send Queue.
The print queue window opens.

4. Delete the print jobs

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

32 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.
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I Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

I Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon |J Status Monitor appears as a button on the task bar.
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Click the button of the status monitor displayed on the task bar. The Canon |J Status Monitor appears.
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»>» Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click Status Monitor... on the Main tab.
» The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

I When Errors Occur

If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor

displays an error information dialog box.
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In such cases, take the appropriate action as described.
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I Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Main tab, click Status Monitor....
The Canon IJ Status Monitor opens.

3. Display Estimated ink levels

Ink status is displayed as an illustration.
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»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.
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I Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

I Restrictions on the Printer Driver

Before installing, log on to Windows as user with administrator rights.
Always check the following before installing the software.
1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.
Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.

This may cause incorrect layout.

When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
Depending on the application software, lines drawn at almost horizontal angles may not print
correctly.

If that should happen, re-draw the line horizontally and print one more time.

Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.

In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties.

After the Properties dialog box has opened, immediately close it by clicking OK.

If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.

In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

Printing at high resolution requires a large amount of memory on your computer.

When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.

In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.

When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.

If you are you are using your printer with a USB connection, refrain from using standby mode. You
can set standby mode through the Power Options on the Control Panel.
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* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so
program finishes printing faster and place a check mark next to Start printing after last page is
spooled.
 Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of the application, and after opening from there the
property dialog box of the printer driver, follow the procedure below and then run printing.
1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.

* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.

In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
operation panel.

» Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

* If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.

In such cases, try printing after following the procedure indicated below.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase your computer memory.
o Increase the virtual memory of your operating system.

* Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use some of the features correctly, such as the Page
Layout feature in the Layout tab.
* In the cases described below, you will not be able to use the Edit Using PosterArtist feature of Page
Layout in the Layout tab, as well as the Canon imagePROGRAF Preview feature.
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline
o When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties
o When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties
o When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties
o When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:
o When printing after choosing Output to file in the Print dialog box in the application software
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* If you perform a point-and-print installation, you will not be able to use the Edit Using PosterArtist
features of Page Layout in the Layout tab.

* If you print after setting Edit Using PosterArtist, refrain from printing from other drivers.

« If you combine specific Print Quality with large paper sizes, you may not be able to correctly print
stamps and borders.

« In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may
look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

* If you are using a model supporting Automatically switch paper sources (paper size priority) in
the Device Settings tab, or if you have chosen Automatically switch paper sources (paper size
priority), you may not be able to get the desired printing results.

In such cases, uncheck Automatically switch paper sources (paper size priority).

I Points to Note About Applications with Restrictions

« If, in Microsoft Excel, you place a checkmark next to the Collate and then you print more than one
copy, or if you do Entire workbook after configuring different settings in each tab, you may not be
able to perform layout printing nor to get the intended printing results.

* If you try to print data on a very large-size paper through applications like Adobe lllustrator, you may
not be able to print.

In such cases, try printing after following the procedure indicated below.
o Open the Main tab and uncheck Preview before printing.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase the virtual memory of your operating system.
o If you are using Adobe lllustrator, turn off/on Bitmap printing in the Print dialog box.

* When printing from application software that does not allow EMF spooling, you will not be able to use
the Edit Using PosterArtist feature of Page Layout in the Layout tab.

* When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.

* When printing data created with Microsoft Word using Enlarged/Reduced Printing or Borderless
Printing, you may not be able to print correctly.
In such cases, try printing after following the procedure indicated below.

o Open the printer folder from the start menu, right click on the printer icon and select Printing
preferences. Launch the application after setting, in the Page Setup tab, Page Size, Enlarged/
Reduced Printing and Borderless Printing.

o Open Microsoft Word's Page setup dialog box and close it by clicking OK.

o After configuring the printer driver, close momentarily the Print dialog box without printing. Then,
open the printer driver's set up screen once again, close it by clicking OK, and run printing.
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I Printer Driver Description

» Main Tab Description

» Page Setup Tab Description

» Layout Tab Description

» Favorites Tab Description

» Utility Tab Description

» Device Settings Tab Description

» Canon |J Status Monitor Description
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I Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...
Opens the Paper Information on Printer dialog box.
You can check the settings on the printer and apply the checked settings to the printer driver.

Specify...
Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu
Switches the Easy Settings and Advanced Settings.
Easy Settings
This mode allows you to print by using pre-registered print settings.
Print Target
Print settings that are generally used frequently are pre-registered as print purposes. By using
a print purpose to print, you can print by using settings that match the document.
Default Settings
Select this when printing general documents such as business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Poster
Select this when printing posters.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

3% Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Fast
Gives priority to printing speed over print quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
22 Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Fast
Gives priority to printing speed over print quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.
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Color
Prints with the number of colors in the document.

Monochrome
Select this setting to print a line drawing using black ink.

Color Settings
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness,
and Contrast on the Color Adjustment tab, and select the Color Correction method on
the Matching tab.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be
before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

Accounting...
Opens the Accounting dialog box.
By setting Accounting information, you add IDs to print jobs, and use the printer and cost management
tool to tabulate print history information for any ID.

»» Note

» To set accounting information, see "Setting Accounting Information."

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

I Paper Detailed Settings dialog box

Drying Time
Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.
Between Pages
The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so the page may be dropped into the basket with dried
ink.
Printer Default
Settings in printer unit operation panel are applied.

None
Page will be output immediately after printing

30 sec./1 min./3 min./ 5 min./ 10 min. / 30 min. / 60 min.
Page will be output after set amount of time has passed after printing.
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Between Scans
The wait time until printing next scan can be set after printing one scan in page. Set in the event
smudging occurs in the page, unevenness occurs in borderless printing, etc., and you would like
to avoid this smudging and unevenness.
Printer Default
Settings in printer unit operation panel are applied.

None
Next scan will be print immediately after first scan is print.

0.5sec./1sec./3sec./5sec./7sec./9 sec.
Next scan will be print after the set amount of time has passed after printing one scan.
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin
In order for heavily curling paper to absorb well in platen, length of margin established on edge of
paper can be selected.
Near End Margin
Roll Near End Margin length can be set.
Printer Default
Settings in printer unit operation panel are applied.

3mm
Will be print in standard size.
* Please select when there are no particular problems with printing.

20mm
Please select when rubbing of the print heads occurs, such as when heavily curling paper is
being used.

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.
Printer Default
Settings in printer unit operation panel are applied.

Fast
Select when cut is not smooth with Standard settings.

Standard
Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and it will
slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Calibration Value
The results can be applied when printing in the event color calibration was set in printer unit. Please
select Use Value when applying calibration.
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Mirror
Select whether to print reflected image or not. When you select this check box, text and images will
be printed as if reflected in a mirror.

I Custom dialog box

Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

32 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

»» Note

» The High, Standard, or Fast print quality modes are linked with the slider bar. Therefore when
the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding quality is selected for Print Quality on the Main tab.

I View Settings dialog box

Print Target
Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.

Details
Displays the settings of the print purpose that was selected for Print Target.

I Color Settings dialog box

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
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This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

32 Important

* When Monochrome is selected for Color Mode, the color balance (Cyan, Magenta, and
Yellow) can't be set.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black.
However, the brightness of the colors between white and black can be changed. Colors become
brighter as you drag the slider toward the right and darker as you drag the slider toward the left.
You can also directly enter brightness values that are linked to the slider bar. Enter a value in the
range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Matching Tab

This is displayed when Color is selected for Color Mode.
Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICC Profile Matching, ICM, or Off to match the purpose of
the print operation.
Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or
scanner ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing using a profile creation tool
or color chart.

32 Important

* When setting not to use ICM in the application software, ICC Profile Matching and ICM
of Color Correction do not function. There are also times when it does not print correctly.
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Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile
Specifies the printer profile to be used when ICC Profile Matching is selected for Color
Correction.
Normally Auto Settings is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICC Profile
Matching, or ICM, for Color Correction.
Perceptual (Photo) / Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Saturation (Poster) / Saturation
Reproduces vivid colors on data such as a poster.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the
image data so the color reproduction approximates the shared color regions. Select this
method to print image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric
This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.

3% Important

» Depending on the media type, you may obtain the same print results even when you change
the Rendering Intent setting.

« If Driver Matching is selected for Color Correction, then Relative Colorimetric and
Absolute Colorimetric are not displayed.

I Accounting dialog box

Click Accounting... to display the Accounting dialog box.

The Accounting dialog box allows you to add IDs to print jobs. You can then use the IDs, along with the
printer and cost management tool, to tabulate print history information.

Account ID/Department/Project number

Enter the account ID, department, and project number that you want to set. Enter the ID by using up
to 20 alphanumeric characters (0 to 9, a to z, and A to Z).
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I Page Setup Tab Description

The Page Setup tab allows you to set borderless printing for a document and specify the scaling.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Borderless Printing
Chooses whether you are printing on a full page without any page margins or printing with page
margins.
In borderless printing, originals are enlarged to extend slightly off the paper. Thus, printing can be
performed without any margins (border).

32 Important

* When Cut Sheet is selected for Paper Source, Borderless Printing is grayed out and cannot be
set.

Borderless Setting
Select Borderless Printing to enable it for clicking.
Open the Borderless Setting dialog box, so that you can adjust Amount of Extension.

Borderless Printing Method
This appears when you select Borderless Printing.
Set the borderless printing method.
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Fit Paper Size
Enlarge or reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge or reduce the document to match the roll paper width and then print the
document.
When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Print Image with Actual Size
Prints the document at its actual size.

Printer Paper Size
When you select Fit Paper Size, you can specify the setting.
Select the size of the paper to be printed.
The list displays the paper sizes that support borderless printing.

Enlarged/Reduced Printing
You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Fit Roll Paper Width,
or Scaling.
Fit Paper Size
Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.
When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Scaling
Enlarge or reduce the document to a specified scale before printing.

Printer Paper Size
When you select Fit Paper Size, or Scaling, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.
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Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper (Auto)
Depending on the paper settings on the printer driver and the paper information registered to the
printer, the printer automatically determines which roll paper to use and then feeds that paper.

Roll 1
Feeds paper from Roll 1.

Roll 2
Feeds paper from Roll 2.

Cut Sheet
Feeds paper using the cut sheet.

32 Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Paper Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.
If you select Custom Size (XXXX), the paper size set in the printer will be used.
The paper information set in the printer can be confirmed in Get Information... in the Main sheet.
If you select User-defined1 (XXXX) or User-defined2 (XXXX), the Custom Size Settings dialog box is
displayed, where you can specify the paper length and width.

Roll Paper Options...
Displays the Roll Paper Options dialog box.

You can specify auto cut, banner printing, and other settings for printing on roll paper.

Output Method...
Displays the Output Method dialog box.
You can select Output Method and specify save settings for saving documents to a box.

Size Options...
Displays the Paper Size Options dialog box.

The Paper Size Options dialog box allows you to create and register any user-defined paper.

I Custom Size Settings dialog box (Paper Size)

This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Units
Select the unit for entering a user-defined paper size.
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I Borderless Setting dialog box

Adjust how much of the document extends off the paper during borderless printing, and configure the
three-sided borderless setting.

Amount of Extension
Adjusts how much of the document extends off the paper during borderless printing.
Moving the slider to the right increases the amount of extension and allows you to perform borderless
printing with no problems.
Moving the slider to the left reduces the amount of extension and expands the range of the document
to print.

Three-sided Borderless
If you check this check box, and the width or the length of the output paper size is smaller than the
roll width, a margin will be created on the right of the document, and the remaining three sides (top,
bottom, and left) will be borderless when printing.

I Custom Size Settings dialog box (Roll Paper Width)

Enter the roll width you want to use.

Roll Paper Width
Specify the Width of the roll paper. Measurement is shown according to the units specified in Units.

Units
Select the unit for entering a user-defined paper size.

I Roll Paper Options dialog box

You can specify settings for printing on roll paper.

Automatic Cutting
You can print cut guidelines for cutting the roll paper automatically or manually after printing.
Yes
Cut the roll paper automatically after printing.

No
Do not cut the roll paper automatically after printing.

Print Cut Guideline
Prints cut guidelines for cutting the roll paper manual after printing.

Banner Printing
Select this check box to print documents with several pages as one continuous document. When you
do this, the spaces between the pages will be removed.

I Output Method dialog box

Set the method for exporting the print job to the printer's hard disk drive.
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Output Method
Print

After the printing ends, the print job is not saved to the printer's hard disk drive.

Set PIN for printing
Set a PIN code for print jobs to prevent issues such as retrieving the wrong documents and
allowing others to peek at your documents.
PIN

Enter a one to seven-digit number.

Print after reception is complete
When you select this check box, you can prevent the print quality from dropping if the print
job reception is cut off or if printing is interrupted.

Save in Job Box
The print job is saved to the printer's hard disk drive. If you selected Save in Job Box, select an
individual box number as the save destination from the Job Box list.

Name of data to be saved
Use file name
The file name is used as-is.

Enter name
You can set a new name. Enter the save name in Name.

Job Box
The box list appears. If you selected Save in Job Box, select an individual box number as the save
destination from the list.
Acquire Job Box Name
When you click this, Job Box displays the box name that was obtained from the printer.

I Paper Size Options dialog box

You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

»» Note

» Paper deletion is not possible in the following case:
— When a standard paper size of the printer driver is selected
— When an oversized paper size is selected
— When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.
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Page Size
You can specify the Width and Height settings of the paper.
Borderless Printing Size
When you select this check box, you can select a size from the paper sizes that support
Borderless Printing.

Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width
Specify the paper width.
Height
Specify the paper height.
Register with the OS

Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined

paper.
Add

You can register a user-defined paper that was set and overwrite the existing user-defined paper.
Display Series

You can narrow down the paper sizes to be displayed in Paper Size List.
Oversize

When you select this check box, add appropriate margins so that the document contents will not get
cut off, and then print the document.
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I Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.
Poster (1 x 2)/Poster (2 x 2)
Printing is performed with poster settings.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number
of divisions increases, the number of sheets used for printing increases. If you are pasting pages
together to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...
Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages.

2 Pages/Sheet / 4 Pages/Sheet /| 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number
of pages assigned to one sheet.

Set...
Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Edit Using PosterArtist
Word processing and spreadsheet software documents and web browser screens, etc. can be
edited a print from PosterArtist.
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You must install PosterArtist to use this function. Go to the Canon website, download PosterArtist,
and then install it.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...
Opens the Define Stamp dialog box.
You can specify detailed stamp settings or register any stamp.

Print Centered
Prints document in center of paper.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

No Spaces at Top or Bottom
When printing on roll paper, you can save paper by reducing the upper and lower margins when
printing.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

22 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Page Options...
Opens the Page Options dialog box.

You specify settings for printing information such as date, user name, and page number.
32 Important

» Depending on your usage environment, you may not be able to use the Page Options function. In
this case, set Spooling at Printer Driver in the Special Settings dialog box to Yes.

Special Settings...
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

I Pages to Print dialog box

When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.
Invert

Switches the pages to be displayed or hidden.
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»» Note

» The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected
for Page Layout.

I Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Select something other than None from the list to print the page border line.

»» Note

» The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6
Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

I Define Stamp dialog box

The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Stamps
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name
Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.

308



Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps, and click this button.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center
Moves the stamp to the center of the paper.

Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

I Page Options dialog box

Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

»» Note

« It will be displayed if you select Yes in Spooling at Printer Driver in the Special Settings dialog
box.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box

Set the format to be used when printing the contents set in the Page Options dialog box.
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Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

I Special Settings dialog box

The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summary
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
Spooling at Printer Driver
Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting No (Use RAW Spooling) or Yes may improve the print results or the printing speed.
Also, depending on the setting, you may not be able to use some of the driver functions.
FineZoom Settings
Use this function to print on long paper.
Yes
The print problem may be corrected.
Select this in usual cases.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print results
you want by setting this function to off.
This is only displayed when using a 32-bit driver.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver, the
printing results may include an unexpected tint. You can resolve the problem in this case by
setting Disable the color profile setting of the application software to On.
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3» Important

» Even if this is set to On, it will only disable some of the color profile information, and it is still
possible to print using the color profile.
This should normally be set to Off when using.

Specify Pattern Resolution
This function is for switching the rendering resolution for drawings using the hatch brush or
pattern brush.
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I Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.
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Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Settings Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites
list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file (.cfg).
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Export...
You can save the settings of a favorite to a file (.cfg).

| Edit dialog box

You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

| Add dialog box

You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
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| utility Tab Description

The Utility tab allows you to perform printer maintenance or check the settings of the printer.
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Print Nozzle Check Pattern

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source

Displayed using the Media Type, Page Size and Roll Paper Width for each currently set paper

feed position.

»

Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.
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iew Status
This function copies printer information and setting values to the clipboard.

Custom Settings...
Acquire media information from the printer at startup
When the printer driver setup window is opened, the media type registered in the printer is
automatically applied to Media Type.

Apply the previous print settings according to the media type
If you change Media Type, the print purpose and quality of the previous print are applied.

About

Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Settings Summaries...
The Settings Summaries dialog box is displayed.
You can confirm the list of items set in the printer driver.
If you click the tab of each sheet, you can confirm the setting details of each item.

I Related Topics

= Cleaning the Print Heads
= Printing a Nozzle Check Pattern
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I Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.

The Device Settings tab allows you to specify settings related to the printer unit, as well as administrator
settings.
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Automatically switch paper sources (paper size priority)
Prints after automatically switching between roll paper 1 and roll paper 2 depending on the size of the
paper to be printed.
This will save paper as the roll paper that will give the smallest margin when printing is automatically
selected.

32 Important

» Make sure that the same type of paper is used in the upper level and lower level of the printer.
Printing is not possible when different types of paper are used.

* Be sure to click Get Information... from the Device Settings tab to get information on the roll
paper width. You may not be able to print correctly if the roll paper width is not correctly set.

 Be sure to select Roll Paper (Auto) as Paper Source from Page Setup. This function cannot be
used unless Roll Paper (Auto) is selected.

Roll Paper Width 1
Sets the width of the roll paper loaded in the upper level (Roll 1).

Roll Paper Width 2
Sets the width of the roll paper loaded in the lower level (Roll 2).

Get Information...
Acquire information on the attachment of the roll unit or roll paper 1 or roll paper 2 paper width from
the printer.
Based on this information, the Roll Unit and Automatically switch paper sources (paper size
priority), and roll width settings are automatically switched.
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Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer
driver.

Accounting
Opens the Accounting dialog box.
By setting Accounting information, you add IDs to print jobs, and use the printer and cost management
tool to tabulate print history information for any ID.

»» Note

» Accounting can be set only by users with Administrator rights.
Users without Administrator rights may not be able to set Accounting information.

 To set accounting information, see "Setting Accounting Information."

« If you set accounting information in the Device Settings sheet, the items in the Accounting dialog
in the Main sheet will be greyed out, and you won't be able to configure them.

Preferences...
Configure administrator settings for the printer driver.

Device Information
Opens the Device Information dialog box.

You can obtain the device information of the connected printer, and change the configuration to match
the printer that is connected to the driver function.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

I Accounting dialog box

Click Accounting to display the Accounting dialog box.
The Accounting dialog box allows you to add IDs to print jobs. You can then use the IDs, along with the
printer and cost management tool, to tabulate print history information.

If you want to require accounting information, check the check box to make each item required.
To prevent changes to accounting information, check the checkbox to set each item as fixed.

I Preferences dialog box

Use System Language
Set this to On to change the display language of the printer driver according to the OS language
settings.

I Device Information dialog box

The Device Information dialog box allows you to obtain the device information of the connected printer,
and change the configuration to match the printer that is connected to the driver function.
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Settings Summary
This is a list of items that you can set in the Device Information dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.

Device Type
The maximum supported roll paper width will be set to the initial value.

Roll Unit
If the lower roll unit is equipped, it is set to Yes.

»» Note

« If a roll unit set as a wrapping device is equipped, it is set to No.

Hard disk
If a hard disc is equipped, it will be set to Yes.

Acquire Status
Obtain device type, roll unit, and hard disk information from the printer.
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I Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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I Canon |IJ Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

I Canon |J Status Monitor Overview

Canon |J Status Monitor allows you to check the status of the printer and ink with graphics and messages.

You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.

]
* . A warning is being displayed.
Q : An operation error has occurred.
0 : You are being informed of remaining ink levels, etc.

0 : There has been an error which requires a service.
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Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Remaining Printing Time of Current Page
Displays the remaining print time of the pages being printed.

Display Send Queue
Shows the print window used to manage the print job that is being printed or being in the print queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click \.» (the disclosure triangle) to display a pictorial representation of the estimated ink level in the
ink tank.
Ink Model Number

You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the cartridge is
full.

Click \.» (the disclosure triangle) to display a pictorial representation of the estimated usage amount
in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder.

Click '» (the disclosure triangle) to check the remaining amount of paper.
Purchase information is displayed in Purchase Paper....

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon 1J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the other
windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon |J status
monitor starts automatically and appears in front of all other windows.
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Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically and be
displayed in front of other windows.

Start when Windows is Started
Starts the Canon |J Status Monitor automatically when you start Windows.

Remote Ul menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

»» Note

* When the printer is being used via USB connection Remote Ul will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Job List
Displays the Print job window.

HDD Information
Displays the Saved job window.
This window allows you to check each box of the information saved on the printer's hard disk.

Ink Supplier Display Settings
Displays the Ink supplier information window.

Paper Supplier Display Settings
Displays the Paper supplier information window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and disable
warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and you
can check the version and copyright information.
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I Updating the Printer Driver

» Obtaining the Latest Printer Driver
» Deleting the Unnecessary Printer Driver
» Before Installing the Printer Driver

» Installing the Printer Driver
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I Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Utility tab.

You can access our website and download the latest printer driver for your model.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= Before Installing the Printer Driver
= |nstalling the Printer Driver
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I Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

Select the Control Panel -> Programs -> Uninstall a program (Programs and Features).
From the program list, select "XXX Driver" (where "XXX" is your model name) and then click Uninstall.

The confirmation window for uninstalling the model appears.

2% Important

+ A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Start. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.
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I Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

I Checking the Printer Status

* Turn on the printer.

I Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

I Related Topics

= Obtaining the Latest Printer Driver
= |nstalling the Printer Driver
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I Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:
1. Turn on the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

2» Important

* A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation
Click Exit.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= QObtaining the Latest Printer Driver
= Deleting the Unnecessary Printer Driver
= Before Installing the Printer Driver
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I Handling Paper

» Handling rolls

Loading Rolls on the Roll Holder
@ Loading Rolls in the Printer
@ Loading Roll Paper in the Roll Unit
@« Removing the Roll from the Printer
@« Removing Roll Paper from the Roll Unit
« Removing Rolls From the Roll Holder
@ Feeding Roll Paper Manually
« Cutting Roll Paper
« Cutting Roll Paper after Printing
@« Automatically Switch Rolls
« Remove Jammed Roll Paper
» Handling sheets
@ Loading Sheets in the Printer
« Removing Sheets
@ Printing From a Desired Starting Point
« Remove a Jammed Sheet
» Paper Settings
@« Changing the Type of Paper
@« Specifying the Paper Length
« Keeping Track of the Amount of Roll Paper Left
@« Specifying the Cutting Method for Rolls
« Cutting the Leading Edge of Roll Paper Automatically
@ Reducing Dust from Cutting Rolls
@ Specifying the Ink Drying Time

@« Specifying the Amount of Extension for Borderless Printing
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» Information about Paper

« Paper Sizes

t.

Paper Information List

t.

Updating paper information

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a
Media Type

t.

Managing Paper Information on Printer Using Media Configuration Tool
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I Handling rolis

>

>

Loading Rolls on the Roll Holder
Loading Rolls in the Printer

Loading Roll Paper in the Roll Unit
Removing the Roll from the Printer
Removing Roll Paper from the Roll Unit
Removing Rolls From the Roll Holder
Feeding Roll Paper Manually

Cutting Roll Paper

Cutting Roll Paper after Printing
Automatically Switch Rolls

Remove Jammed Roll Paper
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I Loading Rolls on the Roll Holder

When printing on roll paper, attach the roll paper to the Roll Holder.

Roll paper comes in two types: 2-inch and 3-inch cores. If using 3-inch core roll paper, attach the 3-Inch
Paper Core Attachment to the Roll Holder and holder stopper.

/% Caution

+ Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and
dropping a roll may cause injury.

22 Important

* When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

» Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

Il - — - >40mm

»>» Note

 For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".
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1. Rotate the holder stopper lever (A) towards ‘p to release the lock, and while holding the
end plate (B), remove holder stopper from the roll holder.

2. If using 3-inch core paper, align 3-Inch Paper Core Attachment tabs (A) with Roll Holder
holes (B) and insert firmly.

3. With leading edge of roll paper facing forward as shown, insert Roll Holder from right side of
roll. Insert firmly until roll paper touches flange (A) of Roll Holder.

2% Important

* When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the
Roll Holder.
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« If you stand the roll holder vertically and set the roll paper by dropping, the roll holder may be
damaged.

4. If using 3-inch core paper, align 3-Inch Paper Core Attachment tabs (A) with holder stopper
holes (B) and insert firmly.

5. Insert holder stopper from left into roll holder as shown, and then while holding the end
plate (B), push firmly until holder stopper flange (A) touches roll paper. Lock the holder

stopper lever (C) by rotating it towards ﬁ
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I Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

When selecting Enable in Roll paper auto feed, the roll paper is fed automatically by simply loading it.

32 Important

+ Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be
advanced correctly when you turn the printer on.

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Top Cover

« If Paper retention settings is set to Release, the roll paper is not fed automatically.

* For details on the paper that can feed roll paper automatically, see "Paper Information List."

»>» Note

» When using the roll unit, you can also load roll paper on the roll unit separately from the printer that is
described here.

= | oading Roll Paper in the Roll Unit

* When roll paper cannot be fed automatically, see "Roll Paper Is not Switched Automatically."

1. Select the paper setting display area on Home screen.

Ready to print

There is no paper.
There is no paper.

There is no paper,

|4 Maintenance

2. Select the Roll paper 1 area.

333



Paper information

@ [ @n There is no paper. | Stop

There is no paper.

There is no paper. hd

Buy paper

3. Select Load paper.
2> Note

« If any paper has been advanced that will not be used, a message is shown requesting you to
remove it. After following the instructions on the screen to remove the paper, go to the next step.

4. Open top cover and lift output guide.

5. Hold flanges (A) so that holder stopper is on left, align roll holder shaft with roll holder slot
left and right guide grooves (B), and load.
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A Caution

* Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

» Do not release the flanges until the holder is loaded in the roll holder slot.

» Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

3% Important

« If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,
remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

» Load the roll paper so that it is not loaded in the opposite direction.

Make sure there is no slack in the roll paper, and then load it.

* Depending on the surrounding environment, the leading edge of roll paper is stuck because of
static electricity or humidity so that the roll paper may not be able to be fed correctly. In this case,
set Roll paper auto feed to Disable, and then feed the roll paper.

« If the roll paper is decentered, it may not be able to be fed correctly. In this case, set Roll paper
auto feed to Disable, and then feed the roll paper.

335



* When Roll paper auto feed is Enable and if you attach the roll holder without the roll paper
loaded on the roll holder, Preparing to feed the paper... appears on the operation panel. In this
case, press the Stop button on the operation panel to cancel feeding.

»» Note

* For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll
Holder."

* When selecting Enable in Roll paper auto feed.

Go to step 6.

* When selecting Disable in Roll paper auto feed.

Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly beneath
it, and feed roll paper until you hear a sound.

22 Important
« If the roll paper has become unwound, remove the slack before loading the roll paper.

* When feeding the leading edge of the roll paper, make sure the entire width of the roll paper
is separating and feeding from the roll. If the roll paper is fed with some of the roll paper still
stuck to the roll, the roll paper will be damaged.

* Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may
affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to
protect the printing surface.
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« If the paper is wrinkled or warped, straighten it out before loading it.

* Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

E

» Depending on the paper, the roll paper may be scratched when being fed and not feed well.
In this case, you must feed the paper manually after setting Paper retention settings to
Release on the touch screen. Lift the release lever, advance the roll paper until its leading
edge appears on platen, lower the release lever, and then proceed to the next step. However,
if Paper retention settings is set to Release, automatic switching of the upper and lower
rolls is not possible.

3. Lower output guide.

* When selecting Enable in Roll paper auto feed.

The roll paper is fed.

* When selecting Disable in Roll paper auto feed.

Select Start feeding, and then the roll paper is fed.
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5. After paper feeding has started, do the following operations based on the Manage
remaining roll amount setting and the barcode printed on the roll paper

= Keeping Track of the Amount of Roll Paper Left

* When selecting Disable or Auto estimate in Manage remaining roll amount.

o When selecting Manual or Auto with confirmation in Media type selection method.
A menu for selecting the media type appears on the touch screen. Operate the touch screen
and select the media type to be used.

> When selecting Auto detect in Media type selection method.
You'll see candidate for the media type you've estimated to the touch screen. After 5 seconds,
the paper type of the first item is selected. If you choose a different candidate, you can use the
touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.
A menu for selecting the media type appears on the touch screen. After 5 seconds, the media
type will be selected with the fixed media kind.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.
The type and amount of paper left is automatically detected based on the barcode printed on the

roll. There is no need to specify the type and length of the paper.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

> When selecting Manual in Media type selection method.
A menu for selection of the media type and length is shown on the touch screen.Operate the
touch screen, select the media type to be used, and enter its length.

o When selecting Auto with confirmation in Media type selection method.
A menu for selecting the estimated media type candidates and the paper length. Interact with
the touch screen, select the media type you want to use, and enter the length.

> When selecting Auto detect in Media type selection method.

A menu for selecting the estimated media type candidates and the paper length.After 5
seconds, the paper type of the first item is selected. If you choose a different candidate, you
can use the touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.

A menu for selecting the media type and the paper length appears on the touch screen. After 5
seconds, the media type will be selected with the fixed paper kind.

2% Important
« |If the leading edge of the roll paper is folded or dirty, cut the leading edge of the roll paper.

= Cutting Roll Paper
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»» Note

* If you have selected Auto with confirmation or Auto detect in the Media type selection
method and you are using the barcode to manage the remaining roll paper, the barcode is read
first. If it fails to read the barcode, it will detect the media type from the estimated result and
display the candidate.

 For details on media types that you can select, see "Paper Information List."
» The width of the roll paper is automatically detected by the printer when the paper is loaded.

When using roll paper with a user-defined size width, the detected width length and the set width
length must exactly match, so even if the correct roll paper is loaded, detection may fail.

In this case, you can improve it by setting the roll paper width you want to use in Add priority roll
paper width.

= Add priority roll paper width
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I Loading Roll Paper in the Roll Unit

Follow these steps to load roll paper in the roll unit.

When selecting Enable in Roll paper auto feed, the roll paper is fed automatically by simply loading it.

32 Important

» Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be
advanced correctly when you turn the printer on.

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Top Cover

« If using the roll unit as the feed device, depending on the basket position, the ejected roll paper's cut
end enters the roll unit and may cause a paper jam or affect the print quality when set to "Borderless
Printing" or "Trim Edge First" when loading the paper. In this case, change the basket position, and
then print.

= Example Basket Configurations

« If Paper retention settings is set to Release, the roll paper is not fed automatically.

» For details on the paper that can feed roll paper automatically, see "Paper Information List."

> Note

* When roll paper cannot be fed automatically, see "Roll Paper Is not Switched Automatically."

1. Select the paper setting display area on Home screen.

Ready to print

There is no paper.

There is no paper.
There is no paper,

|4 Maintenance

2. Select the Roll paper 2 area.
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Paper information

@ OF There is no paper.

SH There is no paper.

There is no paper. hd

Buy paper

3. Select Load paper.
2> Note

« If any paper has been advanced that will not be used, a message is shown requesting you to
remove it. After following the instructions on the screen to remove the paper, go to the next step.

4. Change Roll Holder Lock switch on roll unit to release position.

5. Hold flanges (A) so that holder stopper is on left, align roll holder shaft with roll holder slot
left and right guide grooves (B), and load.
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A Caution

» Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

» Do not release the flanges until the holder is loaded in the roll holder slot.

» Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

32 Important

« If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,
remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

« If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

» Load the roll paper so that it is not loaded in the opposite direction.
* Make sure there is no slack in the roll paper, and then load it.

» Depending on the surrounding environment, the leading edge of roll paper is stuck because of
static electricity or humidity so that the roll paper may not be able to be fed correctly. In this case,
set Roll paper auto feed to Disable, and then feed the roll paper.

« If the roll paper is decentered, it may not be able to be fed correctly. In this case, set Roll paper
auto feed to Disable, and then feed the roll paper.

* When Roll paper auto feed is Enable and if you attach the roll holder without the roll paper
loaded on the roll holder, Preparing to feed the paper... appears on the operation panel. In this
case, press the Stop button on the operation panel to cancel feeding.
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»» Note

» For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll
Holder."

6. Change Roll Holder Lock switch on roll unit to locked position.

3% Important

« If you do not change Roll Holder Lock switch to locked position, the roll paper cannot be fed
automatically.

7. Change feed flap switch on top of roll unit to feed icon position on the left.

* When selecting Enable in Roll paper auto feed.

The roll paper is fed.

* When selecting Disable in Roll paper auto feed.

Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly beneath it,
and feed roll paper until you hear a sound.
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Select Start feeding, and then the roll paper is fed.

3% Important

« If the roll paper has become unwound, remove the slack before loading the roll paper.

* When feeding the leading edge of the roll paper, make sure the entire width of the roll paper is
separating and feeding from the roll. If the roll paper is fed with some of the roll paper still stuck to
the roll, the roll paper will be damaged.

» Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

« |If the paper is wrinkled or warped, straighten it out before loading it.

* Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

E]

* Depending on the paper, the roll paper may be scratched when being fed and not feed well. In
this case, you must feed the paper manually after setting Paper retention settings to Release on
the touch screen. Lift the release lever, advance the roll paper until its leading edge appears on
platen, lower the release lever, and then proceed to the next step. However, if Paper retention
settings is set to Release, automatic switching of the upper and lower rolls is not possible.
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8. After paper feeding has started, do the following operations based on the Manage
remaining roll amount setting and the barcode printed on the roll paper

= Keeping Track of the Amount of Roll Paper Left

* When selecting Disable or Auto estimate in Manage remaining roll amount.

o When selecting Manual or Auto with confirmation in Media type selection method.
A menu for selecting the media type appears on the touch screen. Operate the touch screen
and select the media type to be used.

> When selecting Auto detect in Media type selection method.
You'll see candidate for the media type you've estimated to the touch screen. After 5 seconds,
the paper type of the first item is selected. If you choose a different candidate, you can use the
touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.
A menu for selecting the media type appears on the touch screen. After 5 seconds, the media
type will be selected with the fixed media kind.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.
The type and amount of paper left is automatically detected based on the barcode printed on the

roll. There is no need to specify the type and length of the paper.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

> When selecting Manual in Media type selection method.
A menu for selection of the media type and length is shown on the touch screen.Operate the
touch screen, select the media type to be used, and enter its length.

o When selecting Auto with confirmation in Media type selection method.
A menu for selecting the estimated media type candidates and the paper length. Interact with
the touch screen, select the media type you want to use, and enter the length.

> When selecting Auto detect in Media type selection method.

A menu for selecting the estimated media type candidates and the paper length.After 5
seconds, the paper type of the first item is selected. If you choose a different candidate, you
can use the touch screen to select the type of paper you want.

o When selecting Use current media type in Media type selection method.

A menu for selecting the media type and the paper length appears on the touch screen. After 5
seconds, the media type will be selected with the fixed paper kind.

2% Important

« |If the leading edge of the roll paper is folded or stained, cut the leading edge of the roll paper.

= Cutting Roll Paper
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»» Note

* If you have selected Auto with confirmation or Auto detect in the Media type selection
method and you are using the barcode to manage the remaining roll paper, the barcode is read
first. If it fails to read the barcode, it will detect the media type from the estimated result and
display the candidate.

 For details on media types that you can select, see "Paper Information List."
» The width of the roll paper is automatically detected by the printer when the paper is loaded.

When using roll paper with a user-defined size width, the detected width length and the set width
length must exactly match, so even if the correct roll paper is loaded, detection may fail.

In this case, you can improve it by setting the roll paper width you want to use in Add priority roll
paper width.

= Add priority roll paper width
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I Removing the Roll from the Printer

Remove rolls from the printer as follows.

»>» Note

* If you need to cut a printed roll, cut the roll paper at the desired position.

= Cutting Roll Paper

1. Select the paper setting display area on Home screen.
Ready to print

GY PEKE O MEX

(©)1=—50.0m Plain Paper
50.0m Plain Paper

o

Maintenance

Paper information

OF Plain Paper
50.0m A1 Roll
OF Plain Paper
50.0m 567.8mm

[ There is no paper.

Buy paper

3. Select Remove paper.

4. Select Yes.
The roll is rewound.

2% Important

« |f Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is
printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left.

= Keeping Track of the Amount of Roll Paper Left
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23 Note

 For instructions on removing the Roll Holder from rolls, see "Removing Rolls From the Roll
Holder."

. Lower output guide and close top cover.
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I Removing Roll Paper from the Roll Unit

Follow these steps to remove roll paper from the roll unit.

»>» Note

* If you need to cut a printed roll, cut the roll paper at the desired position.

= Cutting Roll Paper

1. Select the paper setting display area on Home screen.

Ready to print

GY PEKE O MEX

(©)1=—50.0m Plain Paper

50.0m Plain Paper
Maintenance

2 Job management

2. Select the Roll paper 2 area.

Paper information

@ OF Plain Paper
50.0m A1 Roll

OF Plain Paper
30.0m  567.8mm

) [ There is no paper. W

Buy paper

3. Select Remove paper.

4. Select Yes.
The roll is rewound.

2% Important

« |f Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is
printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the

amount of roll paper left.

= Keeping Track of the Amount of Roll Paper Left
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7. Hold roll holder by its flanges (A) and remove from roll holder slot.
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23» Note

* For instruction on removing the roll paper from the roll holder, see "Removing Rolls From the Roll

Holder."
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I Removing Rolls From the Roll Holder

1. Rotate the holder stopper lever (A) towards :P to release the lock, and while holding the
end plate (B), remove holder stopper from the roll holder.

3. To remove 3-Inch Paper Core Attachment, press tabs (A) inward and remove attachment.

« roll holder Side

* holder stopper Side
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22 Important

 Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If
paper is not stored properly, the printing surface may become scratched, which may affect the printing
quality when you use it again.
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I Feeding Roll Paper Manually

After feeding the roll paper, you can move it forward and back.

1. Select the paper setting display area on Home screen.

Ready to print

GY PEKE O MEX

(21— 50.0m Plain Paper
50.0m Plain Paper

ETEERS

Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. il

Buy paper

3. Select Feed/cut.

4. Tap or touch Advance and Rewind to move roll paper forward or back.

»» Note
» Tapping Advance or Rewind moves the roll paper approximately 0.04 inch (1 mm).

Touching Advance or Rewind moves the roll paper until you release the key. If "Cannot advance
the paper any further." appears on the touch screen, release the key.

5. Select OK when you have determined position of roll paper.
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I Cutting Roll Paper

After feeding the roll paper, you can cut the roll paper.

1. Select the paper setting display area on Home screen.

Ready to print

GY PEKE O MEX

(21— 50.0m Plain Paper
50.0m Plain Paper

ETEERS

Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. il

Buy paper

3. Select Feed/cut.

4. Tap or touch Advance and Rewind to move roll paper forward or back.

»» Note
» Tapping Advance or Rewind moves the roll paper approximately 0.04 inch (1 mm).

Touching Advance or Rewind moves the roll paper until you release the key. If "Cannot advance
the paper any further." appears on the operation panel, release the key.

5. Select Cut paper when you have determined position of roll paper.

6. Check the contents of the message and select Yes.

After the roll paper is cut, it is rewound automatically.
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I Cutting Roll Paper after Printing

How rolls are cut after ejection varies depending on printer settings.

= Specifying the Cutting Method for Rolls

I Eject (when the paper surface is being scratched / to wait for ink to dry)

32 Important

» When cutting wide printed documents after ejection, have two people support the documents. If the
paper drops, printed documents may be damaged.

» Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

1. Print the job.

When printing is finished, the printer will stop without cutting.

2. While holding the printed document from the bottom edge to prevent it from dropping,
select Cut paper to cut the roll paper.

Printing is complete,
Tap [Cut paper] to cut the
paper.

ut paper |

I Manual (when using media that cannot be cut with the cutter blade)

1. Print the job.

The printer stops advancing the paper after printing.

2. Select Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.
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Printing is complete,
Tap [Advance paper] to move
the paper to the cut position.

Advance paper H

3. Cut the roll paper manually with scissors or the like.

4. Select OK.

After the roll is rewound, it stops automatically.

I Manual (for paper of which the leading edge rubs the print head)

1. Select the paper setting display area on Home screen.

Ready to print

| GY PEK O MBEK
@)1 50.0m Plain Paper
50.0m Plain Paper

Maintenance

2 Job management

2. Select paper source.
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Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. i

Buy paper

3. Select Feed/cut.

4. Tap or touch Advance or Rewind and align paper's leading edge with position (A).

5. Print the job.

The printer stops advancing the paper after printing.

6. Select Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.
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Printing is complete,
Tap [Advance paper] to move
the paper to the cut position.

Advance paper |

7. Cut the roll paper manually with scissors or the like.

(] =L
a

by et

~L4___~ 7

8. Select OK.

After the roll is rewound, it stops automatically.
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I Automatically Switch Rolls

By using the roll unit as a roll paper feed device, you can load an upper roll (Roll 1 on printer) and a lower

roll (Roll 2 on the roll unit), and print on while automatically changing between Roll 1 and Roll 2 depending
on the print job.

For details on how to switch between Roll 1 and Roll 2, see "How to Switch Paper Rolls" (Windows) or "How
to Switch Paper Rolls" (macOS).

22 Important

« If Paper retention settings is set to Release, automatic switching of roll paper cannot be used.
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I Handling sheets

» Loading Sheets in the Printer
» Removing Sheets
» Printing From a Desired Starting Point

* Remove a Jammed Sheet
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I Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

22 Important

» Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.
* Load the paper straight. Loading paper askew will cause an error.

=» 1317

+ If you are not using the stand, make sure there is no object under the printer. If there is any object
under the printer, it may cause damage of the paper or jamming.

»>» Note

» Before loading cut sheets, check whether or not the inside of the top cover or the output guide is soiled.
If these areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Top Cover

» Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Select the paper setting display area on Home screen.

Ready to print

GY PEKE O MEX

(21— 50.0m Plain Paper

50.0m Plain Paper

ETEERS

2 Job management

> Note

« If a print job has been received in advance, follow the instructions on the screen and select Load
paper.

2. Select the Manual area.
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Paper information

@ OF Plain Paper
50.0m A1 Roll
OF Plain Paper
20.0m  567.8mm

- " [ There is no paper. j

Buy paper

3. Select Load paper.

4. Open top cover and lift release lever.

2% Important
* Do not touch Linear Scale (A), carriage shaft (B), or Ink Tube Stabilizer (C). Touching these parts

may damage them.
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5. Insert the cut paper in portrait orientation, with the print side up, between the platen (D) and
the paper retainer (E).

When the cut paper is inserted, it is automatically adsorbed onto platen surface.

6. Align the paper with the paper alignment line (F) on the right side.
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7. Align the back edge of the inserted paper with the front edge of the back paper alignment
line (G).

G

Y

32 Important

» Load the sheet so that it is parallel to the right paper alignment line (F). Loading paper askew will
cause an error.

» Warped paper may rub against the print head. Straighten paper if it is warped before loading.
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»» Note

* You can also align the cut sheet based on its near edge. In this case, load the cut sheet aligning
its near edge with marks (H) on the platen and the right edge with the right-side paper alignment
line (F).

* You can adjust the vacuum strength holding the paper against the platen when the release lever
is up. If it is difficult to load the paper, tap Suction on the touch screen and adjust the vacuum
strength. You can adjust the vacuum strength to 5 levels.

However, even if you increase the suction, it may not be sufficient to hold some types of paper
against the platen well. In this case, use your hand to load the paper.

» Sheets are held in place by suction through holes on the platen. Although the suction may
produce a noise when paper is loaded in some positions, it does not indicate a problem. If the
noise is distracting, try moving the paper over slightly to the left or right (up to 0.04 inch (1 mm))
while keeping it parallel to the paper alignment line.

» The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet
during this time, pull the sheet away and reinsert it to start the suction again.

8. Lower release lever and close top cover.
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»» Note

« If a print job has been received in advance, follow the touch screen to start printing after loading
the paper.

9. Select the type of loaded paper and select OK.
Paper feeding will start.

> Note

 For details on media types that you can select, see "Paper Information List."
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I Removing Sheets

Remove sheets from the printer as follows.

1. Select the paper setting display area on Home screen.

Ready to print

50.0m Plain Paper
50.0m Plain Paper
Plain Paper

|/ Maintenance

2. Select the Manual area.

Paper information

@ OF Plain Paper
50.0m A1 Roll

OF Plain Paper
50.0m  567.8mm

5 (B _orwe 3

Buy paper

3. Select Remove paper.
4. Check the contents of the message and select Yes.

5. When instructions for removing sheet appear on touch screen, lift release lever while
holding sheet, and remove sheet.

369



6. Lower release lever.
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I Printing From a Desired Starting Point

Print on sheets from a desired starting point as follows.

I Setting Detect paper width to Disable

1. Select E Printer settings on HOME screen.
2. Select Paper-related settings.

3. Select Advanced paper settings.

4. Select the paper type.

5. Select Detect paper width.

6. Select Disable.

I Load paper in the desired position to start printing from

1. Load paper.

= | oading Sheets in the Printer

2. Check the contents of the message and select Keep it disabled and continue.

[Detect paper width] is
disabled. Do vou want to
keep it disabled and continue?

Stop

# Function note

[ Keep it disabled and continue ‘

Enable it

3. Open top cover.
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4. Lift release lever.
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5. Load paper keeping right edge of paper aligned with extended line of paper alignment line
(A) on right side of printer and position from which to start printing aligned with groove (B)
at far end of platen.

6. Lower release lever and close top cover.
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7. When screen for selecting paper size appears, select size of paper loaded.
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I Paper Settings

>

>

Changing the Type of Paper

Specifying the Paper Length

Keeping Track of the Amount of Roll Paper Left
Specifying the Cutting Method for Rolls

Cutting the Leading Edge of Roll Paper Automatically
Reducing Dust from Cutting Rolls

Specifying the Ink Drying Time

Specifying the Amount of Extension for Borderless Printing
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I Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

»>» Note

* This printer has the ability to estimate the media type by the data read by the sensor when the paper
is set. If you continue to use this feature, you will learn the data that you read and the accuracy of the
media type estimation. If you continue to use multiple media types, this feature will reduce the need to
select the media type each time you set the paper.

= Media type selection method

* If you continue using the same type of paper and set Media type selection method to Use current
media type, when you load paper, the media type selected before Use current media type was set is
selected automatically, eliminating the need to set the media type.

= Media type selection method

22 Important

» For best printing results, the printer fine-tunes the print head height and the feed amount for each type
of paper. Be sure to select the type of paper to use correctly before printing.

1. Select paper settings display area on Home screen.

Ready to print

50.0m Plain Paper

50.0m Plain Paper
Plain Paper

Maintenance

2. Select paper source.

Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

Plain Paper

Buy paper

3. Select Paper settings.
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4. Select Type.

5. Select media type of roll paper loaded in printer.

32 Important

» Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.

2> Note
* For details on media types, see "Paper Information List."

* When the release lever is operated, the settings automatically return to the last selected media
type.

6. Select Register.
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I Specifying the Paper Length

When changing the length of paper after the paper has been advanced, specify the length as follows.

»>» Note

 Specify the roll paper length when you have set Manage remaining roll amount to Barcodes.

= Keeping Track of the Amount of Roll Paper Left

1. Select paper settings display area on Home screen.

Ready to print

GY PEKE O MEX

o

(©)1=—50.0m Plain Paper

50.0m Plain Paper

Maintenance

2 Job management

2. Select paper source.

Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. hd

Buy paper

3. Select Paper settings.
4. Select Length.
5. Enter roll paper length and select OK.

6. Select Register.
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I Keeping Track of the Amount of Roll Paper Left

There are two methods of managing the amount of roll paper left: by using the barcode and by estimating
the amount of roll paper left.

I Managing by the Barcode for the Amount of Roll Paper Left

When you set Manage remaining roll amount to Barcodes, the amount of remaining roll paper and the
media type information are printed as a barcode and text when the paper is removed. When Manage
remaining roll amount is set to Barcodes and you load roll paper with a printed barcode, the media type
and remaining amount are automatically detected after the roll paper is loaded. The barcode will be cut off
after it has been read.

B .
W4 L

Fuw Fass -

2% Important

« If the barcode on the roll is not detected, enter the type and length of paper on the operation panel.
The length of the paper at this time can be set in Roll length (change default).

= Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode

Follow the steps below when setting Manage remaining roll amount to Barcodes.

1. Select E Printer settings on Home screen.
2. Select Paper-related settings.

3. Select Manage remaining roll amount.

4. Select Barcodes.

5. Enter roll paper length and select OK.
32 Important

* When selecting Enable in Roll paper auto feed, the screen for checking the length of the roll
paper is displayed for only 5 seconds.

2> Note
» The length of the roll paper to be displayed can be set in Roll length (change default).

= Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode

6. Select the timing when the warning message appears.
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Setting the Default Value of the Amount of Roll Paper Left when Managing by the
Barcode

When you select Barcodes in Manage remaining roll amount and if you feed roll paper on which no
barcode is printed, such as new roll paper, the screen to enter the roll paper length (remaining amount)
appears.

In this screen, the length (remaining amount) of default value appears. If the length is not correct, enter a
correct length.

When you want to change the length (remaining amount) of default value, follow the steps below.

1. Select paper settings display area on Home screen.

Ready to print

QY PEE O MEX

(©)— 50.0m Plain Paper
50.0m Plain Paper

Maintenance

Paper information

Plain Paper
A1 Roll

Plain Paper
267.8mm

There is no paper. b

Buy paper

3. Select Paper settings.

4. Select Advanced.

5. Select Roll length (change default).
6. Enter roll paper length and select OK.

I Managing by Estimating the Amount of Roll Paper Left

When you set the Manage remaining roll amount to Auto estimate, the remaining amount of roll paper
is estimated and displayed in the Operation panel. The barcode is not printed.
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When paper runs out, the printer records the estimated remaining roll amount. Any discrepancy will be
used to make the estimated remaining roll amount more accurate the next time you load the same paper.
32 Important

« If the type of paper is not selected correctly, the amount of roll paper left may not be estimated
correctly.

» There is an error in the estimated amount of paper remaining, and it may be out of paper during
printing.

* When using the paper which is not listed in "Paper Information List" set Paper thickness and Paper
core outer diameter under Advanced paper settings or Media Configuration Tool. To estimate the
remaining amount of paper, Paper thickness and Paper core outer diameter must be set correctly.

= Paper Information List

= Media Configuration Tool Guide
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I Specifying the Cutting Method for Rolls

3> Note
» Automatic cut and Eject cut are valid only when you have selected Automatic Cutting>Yes in the

printer driver.

= Cutting Roll Paper after Printing (Windows)
= Cutting Roll Paper after Printing (macOS)

» Eject cut, printing does not resume after a series of jobs have been printed continuously until the roll is
cut.

» For continuous printing with User cut, select Yes or Print Cut Guideline in Automatic Cutting in the

printer driver.

 Eject cut or User cut is the preset selection in Cutting mode for some types of paper. For this paper,
we recommend keeping the preset cutting mode.

If documents printed using Automatic cut, Eject cut, or User cut are short, rolls are advanced a
specific amount before cutting to prevent problems with cutting and paper ejection. This may create a
wider bottom margin, in some cases.

1. Select paper settings display area on Home screen.

Ready to print

B GY PEKE O WEE
(©)1— 50.0m Plain Paper

50.0m Plain Paper

1A Maintenance

{2 Job management

2. Select paper source.

Paper information

OF Plain Paper
50.0m A1 Roll

O Plain Paper
20.0m  567.8mm

There is no paper. e

Buy paper

3. Select Paper settings.
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. Select Advanced.
. Select Cutting mode.

. Select a setting from the menu.

Automatic cut
Select this to cut the roll paper automatically with the cutter blade.

Eject cut
Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the
paper drops and may rub against the basket, resulting in damage to the print surface, but you can
cut using this method and supporting the paper so that it does not drop to avoid damage to the
paper. Also, you can prevent paper that has not dried from dropping by visually checking the ink has
dried, and then cutting the paper.

After printing, select Cut paper and cut the roll paper on the cutter blade.

= Cutting Roll Paper after Printing

User cut
Select this if the paper cannot be cut on the cutter blade. When Do you want to set to detect the
leading edge of the paper? is displayed, select Detect (recommended).

Cut each page from the roll using scissors.
= Cutting Roll Paper after Printing

22 Important

» For paper of which the leading edge rubs the print head, set the detection of paper leading
edge to Do not detect and align paper's leading edge with position (A).

= Feeding Roll Paper Manually

« If you set the detection of paper leading edge to Do not detect, a margin of about 4.0 inches
(10 cm) is created at the paper leading edge when printing starts.
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* When the detection of paper leading edge is set to Do not detect, printing will start at the
position at which the roll was set for the first printing after replacing a roll. Thus, the margin of
the paper leading edge will enlarge.
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I Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the operation panel menu.

Follow these steps to change the Trim edge first setting.

1. Select paper settings display area on Home screen.

Ready to print

L GY PEE O WEE
()1~ 50.0m Plain Paper

50.0m Plain Paper

Maintenance

2 Job management

2. Select paper source.

Paper information

OF Plain Paper
50.0m A1 Roll

OF Plain Paper
20.0m  567.8mm

There is no paper. o

Buy paper

3. Select Paper settings.
4. Select Advanced.
5. Select Trim edge first.

6. Select a setting from the menu.

This setting takes effect the next time you load a roll.
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Auto
If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling
the printer.

Off
The edge is not cut and scraps are not removed.

On(Preset Length)
The paper is cut at the pre-defined length when the roll paper is loaded. The pre-defined length
depends on the type of paper. For more information, see "Paper Information List."

= Paper Information List

On(Input Length)
The paper is cut at the specified length when the roll paper is loaded. The range of lengths that can
be specified depends on the type of paper.

Manual
The amount to cut from the leading edge of paper can be adjusted by using the operation panel.

To cut the paper after adjusting, select Cut paper and select Yes.
After cutting the paper, select Complete paper loading.
3> Note

+ If you do not select Complete paper loading after cutting the paper, you cannot print the next
job.
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I Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the operation panel menu, which will coat the leading and trailing edges

of the printed document with ink. As a result, you can reduce problems with the print head. You can set
Cut-dust reduction according to the media type.

( [

471 <

A: The ink is coated.
B: Cut Position

3% Important

* Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight
paper. If not cut properly, the paper may jam.

» Borderless printing is not available when Cut-dust reduction is set to ON. When performing borderless
printing, set Cut-dust reduction to OFF.

Follow these steps to set Cut-dust reduction to ON.

1. Select paper settings display area on Home screen.

Ready to print

GY PEKE O MEX

(©)1=—50.0m Plain Paper

50.0m Plain Paper

A Maintenance

2 Job management

2. Select paper source.
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Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. hd

Buy paper

3. Select Paper settings.

4. Select Advanced.

5. Select Cut-dust reduction.

6. Select ON.
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I Specifying the Ink Drying Time

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

22 Important

* Printer settings are applied when the ink drying time is not set in the printer driver. If the ink drying time
is set in the printer driver, that setting has priority.

= Main Tab Description (Windows)
= Advanced Paper Settings (macOS)

»» Note

« If the cutter touches the print surface on which the ink is not dry, the paper surface may become
scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without allowing printed materials to fall after printing, set Cutting mode on the
printer menu to Eject cut.

= Specifying the Cutting Method for Rolls

I Pausing Between Scans

Specify the waiting time between printing one scan and printing the next one. You can set the drying
waiting time and the target area where the waiting time occurs.

1. Select paper settings display area on Home screen.
Ready to print

0 MEX

(@7 50.0m Plain Paper
50.0m Plain Paper

‘ . Stop

A Maintenance

2 Job management

2. Select paper source.
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Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. i

Buy paper

3. Select Paper settings.

4. Select Advanced.

5. Select Pause between scans.
6. Select Ink drying wait time.

7. Select a setting from the menu.

I Pausing Between Pages

Specify the waiting time between printing one page and ejecting the paper. If there is a next page, it will
be printed after the ink drying time has elapsed.

1. Select paper settings display area on Home screen.

Ready to print

GY PEK O MBEX

@)1 50.0m Plain Paper

50.0m Plain Paper

Maintenance

2 Job management

2. Select paper source.
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Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. i

Buy paper

3. Select Paper settings.
4. Select Advanced.
5. Select Pause between pages.

6. Select a setting from the menu.

I Pausing on the last page during take-up

When you use a roll unit mode as a take-up, you set the wait time after you print the last page.

If you have the next page to print, cancel the drying time waiting and print.

1. Select paper settings display area on Home screen.

Ready to print

L GY PEKE ©Q MEX
(©)— 50.0m Plain Paper
50.0m Plain Paper

Maintenance

2 Job management

2. Select paper source.
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Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. i

Buy paper

3. Select Paper settings.
4. Select Advanced.
5. Select Pause on last page take-up.

6. Select a setting from the menu.

»» Note

» Under Pause timing priority you can specify the prioritized pause time when the roll unit is used as
a take-up device.

To prioritize the waiting time between printing each page and paper ejection, select Between pages.
To prioritize the waiting time after printing the last page, select On last page.
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I Specifying the Amount of Extension for Borderless Printing

Borderless printing may leave margins on the left and right sides of the paper or soil the back of the paper.
Adjusting the amount of extension may improve these problems.

Each paper width is shown as being a recommended width for borderless printing (Paper with
recommended width), or as having sufficient width for borderless printing (Paper of sufficient width).
The procedure for specifying the amount of extension differs depending on Paper with recommended
width and Paper of sufficient width.

= Specifying Amount of Extension for Paper with recommended width.
= Specifying Amount of Extension for Paper of sufficient width.

For more information on a paper width recommended for borderless printing, see Paper Sizes.

I Specifying Amount of Extension for Paper with recommended width.

1. Select paper settings display area on Home screen.

Ready to print

| GY PBEK © MEK
(=) — 50.0m Plain Paper

50.0m Plain Paper

I\ Maintenance

& Job management

2. Select paper source.

Paper information

Plain Paper
A1 Roll

Plain Paper
267.8mm

There is no paper. b

Buy paper

3. Select Paper settings.
4. Select Advanced.

5. Select Extension for borderless printing.
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6. Select Paper with recommended width.

7. Select amount of extension.
Select Large, Standard, or Small.
2> Note
» When selecting Large, the printed area will be wider. Select this if there are margins.

* When selecting Small, the printed area will be narrower. Select this if there are stains.

I Specifying Amount of Extension for Paper of sufficient width.

In case of Paper of sufficient width, the width of the original is set to be slightly smaller than the paper,
and there are margins on the left and right. You can reduce the margins by increasing the amount of
extension.

On the other hand, if the amount of extension is too large, the back side of the paper will be easily soiled
with the overflowed ink. When performing borderless printing with specifying the amount of extension for
Paper of sufficient width, clean the platen regularly.

= Cleaning Inside the Top Cover

1. Select paper settings display area on Home screen.

Ready to print

L GY PEKE ©Q MEX
(©)— 50.0m Plain Paper

50.0m Plain Paper

A Maintenance

2 Job management

2. Select paper source.

Paper information

Plain Paper
A1 Roll

Plain Paper
567.8mm

There is no paper. b

Buy paper

3. Select Paper settings.
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. Select Advanced.

. Select Extension for borderless printing.
. Select Paper of sufficient width.

. Select Sample of extension amounts.

. Confirm displayed message and select Yes.

The alignment pattern for each adjustment value is printed.

. Select the adjustment value.

Check the paper edge (A) of the 1st to 8th on the output pattern and select the number that has the
appropriate amount of extension.

3> Note
» The larger the set adjustment value, the wider the printed range.
* After setting, we recommend to perform borderless printing to check the margin status.

If the margin remains, set a larger adjustment value. If the back of the paper is soiled, set a
smaller adjustment value.

* After printing alignment pattern and borderless printing for confirmation, we recommend to
clean the platen.

= Cleaning Inside the Top Cover
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I Information about Paper

» Paper Sizes

» Paper Information List

» Updating paper information

» Using Paper Other Than Genuine Paper and feed confirmed Paper

@ Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

& Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding
a Media Type

» Managing Paper Information on Printer Using Media Configuration Tool
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I Paper Sizes

| Rolis

Rolls that meet the following conditions are supported.
 Outer diameter is 6.7 inches (170 mm) or less
* Inner diameter of paper core: 2 or 3 inches

* Printing side out

Roll Paper Width GP-6600S / GP-566S : 60.00 in. (1524.0 mm) to 6.00 in. (152.4 mm)
GP-4600S / GP-546S : 44.02 in. (1118.0 mm) to 6.00 in. (152.4 mm)
GP-2600S / GP-526S : 24.02 in. (610.0 mm) to 6.00 in. (152.4 mm)

Roll Paper Width recommended | 60 in Roll (1524.0mm)
for borderless printing(*1,*2) 54 in Roll (1371.6mm)
50 in Roll (1270.0mm)
44 in Roll (1117.6mm)
42 in Roll (1066.8mm)
B0/B1 Roll (1030.0mm)
36 in Roll (914.4mm)
AO0/A1 Roll (841.0mm)
B1/B2 Roll (728.0mm)
24 in Roll (609.6mm)
A1/A2 Roll (594.0mm)
B2/B3 Roll (515.0mm)
17 in Roll (431.8mm)
14 in Roll (355.6mm)
10 in Roll (254.0mm)

Minimum Paper Length 4.00in. (101.6 mm)

Excludes cloth/canvas paper.

Maximum Printable Length 59 feet (18 m)
depends on the OS and application.

Thickness 3 mil (0.07 mm) to 31 mil (0.8 mm)

*1:Borderless printing may not be available depending on the media type. For details on media types that
can be used for borderless printing, see "Paper Information List."

*2:You can perform borderless printing without specifying Roll Paper Width recommended for it. As
opposed to standard borderless printing, there will be a small margin on the left and right because the
paper width is set a little bit smaller than the width of the document.
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I Sheets

Sheets of the following sizes are supported.

Sheet Width GP-6600S / GP-566S : 60.00 in. (1524.0 mm) to 6.00 in. (152.4 mm)
GP-4600S / GP-546S : 44.02 in. (1118.0 mm) to 6.00 in. (152.4 mm)
GP-2600S / GP-526S : 24.02 in. (610.0 mm) to 6.00 in. (152.4 mm)

Minimum Paper Length 8.00 in. (203.2 mm)

Maximum Printable Length 5.2 feet (1.6 m)

Thickness 3 mil (0.07 mm) to 31 mil (0.8 mm)
»>» Note

+ For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or
"Setting Paper Dimensions (Custom Size)" (macOS).

» Borderless printing is not supported on sheets.
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I Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

= Media Configuration Tool Guide

22 Important

* If you are using the Media Configuration Tool, the new Media Information File is downloaded
automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.

» Even if you are not using the printer driver, you should install the Media Configuration Tool in order to
register the media types for your region in the printer.
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Using Paper Other Than Genuine Paper and feed confirmed
Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

» Paper where the size is described in "Paper Sizes"

» Paper where bleeding and ink overflow does not occur when printing

» Paper that does not warp severely when loading the paper or printing

»» Note

* For Canon genuine paper/feed confirmed paper, see "Paper Information List."

22 Important

* If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely
no guarantees regarding print quality or paper feed properties.

After loading the paper in the printer, select the media type in the operation panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

I Printing Using Existing Settings

You can print easily by selecting from existing settings provided in the operation panel and printer driver.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

I Printing Using Additional Settings

You can use the function to add custom paper in the Media Configuration Tool to create settings suitable
for paper other than genuine paper/output confirmation paper you are using. You can add the created
settings to the printer operation panel and printer driver as a new paper type for printing.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the operation panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

3% Important

+ The Canon genuine paper settings provided in the operation panel and printer driver are optimized for
Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

2> Note
» For the available paper types, see "Paper Information List."

» For instructions on selecting the media type with the operation panel, see "Changing the Type of
Paper". For instructions on selecting the media type with the printer driver, see "Main Tab Description"
(Windows) or "Quality & Media" (macOS).

I Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

»>» Note

* If you cannot obtain the desired results by selecting the general-purpose paper settings, use the
custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

= Media Configuration Tool Guide

22 Important
* For details on how to select the added media type in the operation panel, see "Changing the Type of
Paper."

* You can select the media type to be used in printing in the Main sheet (Windows) or Quality & Media
(macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or "Quality & Media"
(macOS).

* We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool. See "Adding Custom Paper" in Media Configuration Tool Guide.

402



I Settings

» Changing Settings from Operation Panel
« Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Erasing Data on Printer's Hard Disk

Status Print

» Changing Printer's Setting Using Web Browser
« Start up Remote Ul
« Changeable Setting Items Using Remote Ul
@ Setting Passwords Using Remote Ul
« Registering Printer's Root Certificate to Web Browser for SSL Communication
« Registering Printer's Root Certificate to Local Computer for SSL Communication
@« Generating Server Certificate

@ Setting Mail Server

Receiving Printer Status by E-mail
» Migrating Printer's Setting

» Initializing Printer's Setting

» Network Setting

Printer Connection Methods

Another Printer Found with Same Name

Printing Network Settings

Network Status and Troubleshooting

t.

Checking Printer Connection Status Using Wi-Fi Connection Assistant

t.

Sharing the Printer on a Network (Windows)
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« Sharing the Printer on a Network (macOS)
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I Changing Settings from Operation Panel

» Home Screen Menu Composition
» Menu Structure

» Setting Items on Operation Panel

¥

Setting Administrator Password on Operation Panel
» Erasing Data on Printer's Hard Disk

» Status Print
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I Home Screen Menu Composition

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations,
settings, and other menus.

= Basic Touch Screen Operations
= |cons on Touch Screen

500n Fisn Fagii
S10m Man Pagei

# Mantenance

I Maieranze

E Jaob management

B b management

B Print from USE flash drive
(g LAN settings

5 Printer settings

@ v & Printer information

\ J

A: Printer Information Display Area
Displays the printer status, messages, and other information. Select this item when a message appears
to view the message on the list screen and to jump to the screen with detailed information and
operations.

= Notification Messages

B: Network

Displays the current network status. Select to display the basic network information or to change the
network settings.

The icon differs depending on the network of use or the network status.

—
Wi-Fi is enabled and the printer is connected to the wireless router.
»>» Note

» Depending on the signal state, the icon will change.

_
(Signal strength: 81 % or more): You can use the printer over a Wi-Fi without any problems.

. (Signal strength: 51 % or more): The problem such as the printer cannot print may occur
according to the network status. We recommends placing the printer near the wireless router.

*)
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' (Signal strength: 50 % or less): The problem such as the printer cannot print may occur.
Place the printer near the wireless router.

- Wi-Fi is enabled but the printer is not connected to the wireless router.

. Wired LAN is enabled.
E Wireless Direct is enabled.

Wi-Fi and Wired LAN are disabled.

C: Internal Light button
Tap this button to change the internal light setting.

The displayed icon changes depending on the current setting.

In all cases, the internal light is turned off during printing of patterns for image quality adjustment, and
some other operations.

-

‘A (Auto): Automatically turns on when the top cover is opened or during printing.

E (ON): Always on.

-

M (OFF): Always off.

D: Stop button
Cancels print jobs in progress and ends the ink drying period.

E: Ink Display Area
Displays the ink status. Select this item to view the remaining amount of ink and how to replace the ink
tanks.

F: Paper Setting Display Area
Displays the media information for each feeding location. Select this item to configure the size and type
of the paper loaded.

G: Other Menu Items
Displays the items used to perform maintenance and configure the various settings.

= Setting Iltems on Operation Panel

»» Note

» By default, menu settings apply to all print jobs. However, for settings that are also available in the
printer driver, the values specified in the printer driver take priority.
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I Basic Touch Screen Operations

You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

32 Important

 Take the following precautions when operating the touch screen. Otherwise, the touch screen may
malfunction or become damaged.

— Do not forcibly press the touch screen with your finger.

— Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).

— Do not operate the touch screen with wet or dirty hands.

— Do not place objects on top of the touch screen.

» Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap
Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.

Touch
Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick

Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.
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Drag
Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.

I Notification Messages

When the ink is low or there is another notification, New notice appears in the printer information display
area. Select this to display the Notice list screen to view messages. Select a message to display the
message details screen to view the details and take action.

I Icons on Touch Screen

While operating on the touch screen, some icons are displayed on the touch screen.

Printer settings
Test print
Print settings

LAN settings

Web service setup

(HOME)

The HOME screen appears.
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(Back)

Displays the screen before the current screen.

Stop
Cancels print jobs in progress and ends the ink drying period.
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I Menu Structure

The * on the right side of an item indicates the default value.

Values may vary depending on your model, firmware version, and printer settings.

* Ink information

This menu is displayed by selecting Ink icon.

Current estimated ink levels

Replace

Order ink now

* Paper settings

This menu is displayed by selecting paper information area.

Roll paper 1
Replace paper
Feed/cut
Remove paper
Paper settings
Width
Length
Type
Advanced
Buy paper
Roll paper 2
Replace paper
Feed/cut
Remove paper
Roll unit use settings
Paper settings
Width
Length
Type
Advanced
Buy paper
Take-up mode
Roll unit use settings
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Auto feed to take-up position

Skip errors during take-up

ON / OFF

Wind up after cutting

Enable / Disable

Paper retention settings

Release / Retain

Use in take-up mode

Use / Do not use

Manual

Replace paper

Remove paper

Paper settings

Page size

Width

Length

Type

Advanced

Buy paper

. mMaintenance

Troubleshooting

Nozzle Check

Print Head Cleaning

Cleaning

All colors / Pattern 1 / Pattern 2 / Pattern 3

Deep Cleaning

All colors / Pattern 1 / Pattern 2 / Pattern 3

System Cleaning

All colors / Pattern 1 / Pattern 2 / Pattern 3

Print Head Alignment

Auto (standard)

Auto (advanced)

Manual
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Paper feed adjustment

Set priority

Auto / Prioritize print quality / Prioritize length accuracy

Adjust print quality

Auto

Manual

Adjust feed length

Print alignment pattern

Change adjustment values

-0.70% / -0.68% / ... / 0.68% / 0.70%

Color calibration

Auto adjust

Enable/disable adjustment values

Enable* / Disable

Adjustment information

Calibration guide settings

Enable / Disable*

Reset adjustment values

Maintenance cartridge info

Maintenance cartridge usage

Replace

Head Replacement

Start head replacement.

Replace cutter blade unit

Platen cleaning

Prepare to move

Move indoors on the same floor

Move indoors to a different floor

Transport outdoors

. .Job management

Print job

List of print jobs
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Saved job

Job box list

Job list

Print the job list

Job history

Display job history

Print job history

Pause printing

Enable / Disable*

Delete all print jobs

. nPrint from USB flash drive

Folderf/file list

Number of copies

Preview

Print settings

The lower items of this menu are the same as the lower items of Print from USB flash settings.

(t4)

LAN settings

Wi-Fi

Connection

Network name (SSID)

Frequency

Wi-Fi security

Signal strength (%)

IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv4 DNS dynamic settings

IPv4 DNS host name

IPv4 DNS domain name

IPv6 link-local address

IPv6 manual address

IPv6 manual prefix length

414



IPv6 stateless address 1

IPv6 stateless prefix length 1

IPv6 stateless address 2

IPv6 stateless prefix length 2

IPv6 stateless address 3

IPv6 stateless prefix length 3

IPv6 stateless address 4

IPv6 stateless prefix length 4

DHCPv6

DHCPv6 stateful address

DHCPv6 stateful prefix length

IPv6 default gateway 1

IPv6 default gateway 2

IPv6 default gateway 3

IPv6 default gateway 4

IPv6 primary DNS server address

IPv6 secondary DNS server add.

IPv6 DNS dyn. update: manual

IPv6 DNS dyn. update: stateless

IPv6 DNS dyn. update: stateful

IPv6 Use IPv4 host/domain name

IPv6 DNS host name

IPv6 DNS domain name

MAC address

Printer name

Bonjour service name

Settings
Enable/disable Wi-Fi
Enable / Disable
Wi-Fi setup
Easy wireless connect
Manual connect
WPS (Push button method)
Other connection types
WPS (PIN code method)
Advanced
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Wireless Direct

Connection

Network name (SSID)

Password

Frequency

Wi-Fi security

No. of printers connected now

IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv6 link-local address

MAC address

Printer name

Bonjour service name

Settings

Enable/disable Wireless Direct

Yes / No

Change network name (SSID)

Auto update / OK

Change password

Change manually / Auto update

Connection request confirmation

ON*/ OFF

Advanced

Wired LAN

Connection

IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv4 DNS dynamic settings

IPv4 DNS host name

IPv4 DNS domain name

IPv6 link-local address

IPv6 manual address

IPv6 manual prefix length

IPv6 stateless address 1
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IPv6 stateless prefix length 1

IPv6 stateless address 2

IPv6 stateless prefix length 2

IPv6 stateless address 3

IPv6 stateless prefix length 3

IPv6 stateless address 4

IPv6 stateless prefix length 4

DHCPv6

DHCPv6 stateful address

DHCPvV6 stateful prefix length

IPv6 default gateway 1

IPv6 default gateway 2

IPv6 default gateway 3

IPv6 default gateway 4

IPv6 primary DNS server address

IPv6 secondary DNS server add.

IPv6 DNS dyn. update: manual

IPv6 DNS dyn. update: stateless

IPv6 DNS dyn. update: stateful

IPv6 Use IPv4 host/domain name

IPv6 DNS host name

IPv6 DNS domain name

MAC address

Printer name

Bonjour service name

Settings

Enable/disable Wired LAN

Enable / Disable

Advanced

Print details

-
. Printer settings

Test print

Nozzle Check

Status print
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Status print (administrator)

Print LAN details

Print the print settings

Print advanced paper settings

Print job history

Print menu map

Print settings

Print head movable width setting

Data width* / Maximum movable width / Paper width

Prioritize paper size

Enable / Disable*

Magnification level for borderless

Large / Medium* / Small / Minimum

PDF print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome

Print quality

5 (Standard) / 4/ 3* / 2/ 1 (Highest)

Input resolution

600 dpi / 300 dpi*

Paper settings

Paper src
Auto select* / Roll paper (auto) / Roll paper 1/ Roll paper 2 /
Manual
Margin
3mm*/ 5mm
Border
Borderless / Bordered*
Oversize
Enable / Disable*
Save paper
ON / OFF*
Rotate
0 degrees* / 90 degrees
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Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

ON / OFF*

Line & pen manager

Width correction

Black/gray

Color

Processing options

Warning display

Enable / Disable*

JPEG print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome

Print quality

5 (Standard) / 4/ 3* / 2/ 1 (Highest)

Input resolution

600 dpi / 300 dpi* / Specify print job

Paper settings

Paper src
Auto select* / Roll paper (auto) / Roll paper 1/ Roll paper 2 /
Manual
Margin
3mm*/ 5mm
Border
Borderless / Bordered*
Rotate
0 degrees* / 90 degrees
Auto rotation
ON / OFF*
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Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard

size

ON / OFF*

Print fro

m USB flash settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome

Print quality

5 (Standard) / 4/ 3* / 2/ 1 (Highest)

Paper settings

Paper src
Auto select” / Roll paper (auto) / Roll paper 1 / Roll paper 2/
Manual
Margin
3mm*/ 5mm
Border
Borderless / Bordered*
Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard

size

ON / OFF*

AirPrint

print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
ICC profile (perceptual) / ICC profile (saturation) / ICC profile
(relative) / ICC profile (absolute) / Monochrome

420




Print resolution

Standard* / Speed priority / Print priority

Paper settings

No Top/Btm Space (Save Paper)

ON / OFF*

Unidirectional printing

Enable / Disable*

Direct print settings from FTP

Print settings 1

Print quality settings

Color mode
Color (perceptual) / Color
(saturation)* / Color (correct
off) / Monochrome

Print quality

5 (Standard) /4/3*/2/1
(Highest)

Input resolution

600 dpi / 300 dpi* / Specify
print job

Paper settings

Paper src
Auto select” / Roll paper (au-
to) / Roll paper 1/ Roll paper
2/ Manual
Margin
3mm*/ 5mm
Border
Borderless / Bordered*
Oversize
Enable* / Disable
Save paper
ON / OFF*
Rotate
0 degrees* / 90 degrees
Auto rotation
ON / OFF*

Enlarge/Reduce
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Fit paper size* / Same size /
Scaling

Print centered

ON / OFF*
Cut to standard size
ON / OFF*
Line & pen manager
Width correction
Black/gray
Color
Processing options
Warning display
Enable / Disable*

Print settings 2

Print quality settings

Color mode

Color (perceptual) / Color
(saturation)* / Color (correct
off) / Monochrome

Print quality

5 (Standard) /4/3*/2/1
(Highest)

Input resolution

600 dpi / 300 dpi* / Specify
print job

Paper settings

Paper src

Auto select* / Roll paper (au-
to) / Roll paper 1 / Roll paper
2 / Manual

Margin

3mm*/5mm

Border

Borderless / Bordered*

Oversize

Enable* / Disable

Save paper

ON / OFF*
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Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size /
Scaling

Print centered

ON / OFF*
Cut to standard size
ON / OFF*
Line & pen manager
Width correction
Black/gray
Color
Processing options
Warning display
Enable / Disable*

Print settings 3

Print quality settings

Color mode

Color (perceptual) / Color
(saturation)* / Color (correct
off) / Monochrome

Print quality

5 (Standard) /4/3*/2/1
(Highest)

Input resolution

600 dpi / 300 dpi* / Specify
print job

Paper settings

Paper src

Auto select* / Roll paper (au-
to) / Roll paper 1 / Roll paper
2/ Manual

Margin

3mm*/5mm

Border
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Borderless / Bordered*

Oversize

Enable* / Disable

Save paper

ON / OFF*

Rotate

0 degrees™ / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size /
Scaling

Print centered

ON / OFF*
Cut to standard size
ON / OFF*
Line & pen manager
Width correction
Black/gray
Color
Processing options
Warning display
Enable / Disable*

Print settings 4

Print quality settings

Color mode

Color (perceptual) / Color
(saturation)* / Color (correct
off) / Monochrome

Print quality

5 (Standard) /4/3*/2/1
(Highest)

Input resolution

600 dpi / 300 dpi / Specify
print job*

Paper settings

Paper src
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Auto select” / Roll paper (au-
to) / Roll paper 1/ Roll paper
2 / Manual

Margin
3mm*/ 5mm
Border
Borderless / Bordered*
Oversize
Enable* / Disable
Save paper
ON / OFF*
Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size /
Scaling

Print centered

ON / OFF*
Cut to standard size
ON / OFF*
Line & pen manager
Width correction
Black/gray
Color
Processing options
Warning display
Enable / Disable*

Default print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /

Monochrome

Print quality

5 (Standard) / 4/ 3* /2 / 1 (Highest)

Print the print settings
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LAN settings

The lower items of this menu are the same as the lower items of LAN settings.

Web service setup

Web service usage registration / Web service usage cancellation

Issue registration code

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Web service inquiry

Print from Canon server

Paper-related settings

Roll paper auto feed

Enable* / Disable

Media type selection method

Manual / Auto detect / Auto with confirmation® / Use current media type

Manage remaining roll amount

Barcodes / Auto estimate* / Disable

Roll amount warning settings

11m/36ft. / 9m/30ft. / 7Tm/23ft. / 5m/16ft.* / 3m/10ft. / 1m/3ft.

Switch roll paper when low

Enable / Disable*

Roll paper auto switching

Identify size* / Do not identify size

Detect paper setting mismatch

Pause / Display warning* / Do not detect / Hold job

Paper retention settings

Release / While feeding*

Paper size recognition settings

Cut sheet setting 1

A3+*/ 13"x19" (Super B)

Cut sheet setting 2

1ISO B1* / 28"x40" (ANSI F)

Roll paper setting 1

10 in Roll* / B4 Roll
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Roll paper setting 2

A3 Roll* / 300mm Roll

Roll paper setting 3

300mm Roll / 12 in Roll*

Roll paper setting 4

500mm Roll* / 20 in Roll

Roll paper setting 5

20 in Roll / B2 Roll*

Roll paper setting 6

A1 Roll* / 600mm Roll

Roll paper setting 7

600mm Roll / 24 in Roll*

Adjust roll unit

Keep margin at cut sheet end

Enable / Disable*

Advanced paper settings

Print advanced paper settings

Add priority roll paper width

Setting 1

Setting 2

Setting 3

Reset all detection priority data

Reset paper settings for all paper

Auto maintenance settings

Auto nozzle check

Standard* / 1 page / 10 pages / Disable

Nozzle check error display

Enable / Disable*

System Cleaning frequency

Standard* / Short

Print pattern after new head

ON*/ OFF

Ink ejection status check

Auto fix* / Display warning / OFF

Hard disk settings

427




Output method

Print* / Print (auto delete) / Save to job box

Save first and print

ON / OFF*

Common job box settings

Print* / Print (auto delete)

File deletion settings

Fast* / Fast secure / Secure / Secure (VSITR)

Data deletion

Fast

Fast secure

Secure

Secure (VSITR)

Monitoring service settings

Enable/disable monitoring service

Enable / Disable*

Communication test

Communication log

Timing for ink level notification

All colors

0% /10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
GY

0%/ 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
PBK

0%*/10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
o

0%*/10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
MBK

0%* /10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
Y

0%/ 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
M

0%*/10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
Cc

0%*/10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%
Check settings
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Warning notification settings

Enable* / Disable

Other printer settings

Energy saving settings

Auto power off

5 minutes / 10 min./ 30 min. /1 hour/ 4 hours / 8 hours / 12 hours / OFF

Sleep timer

5 minutes* / 10 min. / 15 min. / 20 min. / 30 min. / 40 min. / 50 min. / 60 min.

Use USB connection

Use* / Do not use

Date/time settings

Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/IMM/YYYY

Time zone (GMT)

0/+1/.../¥12/12/.../41

Length

unit settings

Meters / Feet/inches

Buzzer settings

Enable* / Disable

EOP timer settings

1 minute / 2 minutes / 5 minutes / 10 minutes* / 30 minutes / 60 minutes

Job history sending settings

Send / Do not send*

Menu row height

Wide* / Standard

Language selection

Firmware update

Install update

Check current version

Update notification settings

Yes*/ No

Show notifications (tool update)

ON*/ OFF

DNS server setup

Auto setup* / Manual setup
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Proxy server setup

Use / Do not use*

Security settings

Administrator password settings

Remote Ul and other tools / LCD, Remote Ul, and other tools

Operation restrictions

Job history

Restrict / Do not restrict*

Remote Ul

Restrict / Do not restrict®

Print from USB flash drive

Restrict / Do not restrict*

IEEE802.1X/EAP settings

Enable/disable

Enable / Disable*

Search for EAP router

Last authentication result

Authentication

TLS*/ TTLS / PEAP

Advanced setup

User-ID

Username

Password

Authentication server name

Verify auth. server name

Enable* / Disable

Verify auth. server certificates

Enable* / Disable

Import/export settings

Import

Export

Initialize printer settings
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. ﬁPrinter information

System information

Hard disk information

Error history

Hardware error

Recoverable error

Paper feed/transfer error

Usage

Total print area

Duty counter

Head information

Head alignment performance log

Values applied with auto settings

Paper thickness (head height)

Transport unit vacuum strength

431



I Advanced (Paper settings)

Select the paper setting display area and select Paper settings to display this menu.

Advanced

Roll length (change default)

Head height

Auto / High / Medium-high / Standard / Medium-low / Low / Super low

Skew detection accuracy

Standard / Loose / OFF

Cutting mode

Automatic cut / Eject cut / User cut

Cut speed

Fast / Standard / Slow

Trim edge first

Auto / Off / On(Preset Length) / On(Input Length) / Manual

Cut-dust reduction

ON / OFF

Transport unit vacuum strength

Auto / Strong / Medium-strong / Standard / Medium-weak / Weak

Guide arm retention pressure

High / Low

Roll paper tension (printing)

High / Standard / Low

Roll paper tension (feeding)

High / Standard / Low

Roll paper tension (winding up)

High / Standard / Low

Pause between scans

Ink drying wait time

OFF / 0.5 seconds / 1 second / 3 seconds / 5 seconds / 7 seconds / 9
seconds

Ink drying target area

Overall / Leading edge

Pause between pages

OFF / 30 seconds / 1 minute / 3 minutes / 5 minutes / 10 minutes / 30 minutes / 60 minutes

Pause on last page take-up
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OFF / 5 minutes / 10 minutes / 30 minutes / 60 minutes / 120 minutes / 240 minutes / 480
minutes / 960 minutes

Pause timing priority

Between pages / On last page

Leading edge margin (roll)

3mm/20mm

Leading edge margin (sheet)

3mm/20mm

Extension for borderless printing

Paper with recommended width

Large / Standard / Small

Paper of sufficient width

Select extension amount

1(min)/2/3/4/5/6/7/8 (max)

Sample of extension amounts

Detect paper width

Enable / Disable

Paper core outer diameter

Paper thickness

Auto-rewind roll paper at sleep

Enable / Disable

Reset detection priority data

Reset paper settings by paper
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I Advanced (LAN settings)

(t4)

To display this item, select LAN settings on the HOME screen, and then select Wi-Fi / Wireless
Direct / Wired LAN > Settings > Advanced.

The * on the right side of an item indicates the default value.

Advanced
Set printer name
TCP/IP settings
IPv4
IP address
Auto setup” / Manual setup
DNS server
DNS server setup
Auto setup* / Manual setup
Dynamic update settings
Enable / Disable*
Host name
Domain name
Proxy server
Use / Do not use*
DHCP option settings
Acquire host name
Enable / Disable*
DNS dynamic update
Enable / Disable*
Acquire domain name
Enable / Disable*
IPv6
Enable/disable IPv6
Enable* / Disable
IPsec settings
Enable / Disable*
Use DHCPv6
Use* / Do not use
Manual address
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Use / Do not use*

DNS server

DNS server setup

Auto setup” / Manual setup

Dynamic update settings

IPv6 DNS dyn. update: manual

Enable / Disable*

IPv6 DNS dyn. update: stateless

Enable / Disable*

IPv6 DNS dyn. update: stateful

Enable / Disable*

IPv6 Use IPv4 host/domain name

Enable / Disable*

IPv6 DNS host name

IPv6 DNS domain name

DHCP option settings

DNS dynamic update

Enable / Disable*

Acquire domain name

Enable / Disable*

WSD settings

Enable/disable WSD

Enable / Disable*

Optimize inbound WSD

Enable* / Disable

Timeout settings

20 minutes / 15 minutes” / 10 minutes / 5 minutes / 1 minute

Bonjour settings

Enable/disable Bonjour

Enable* / Disable

Service name

SNTP settings

Client operation status

Enable / Disable*

NTP server address

Polling interval

435




Spanning tree settings

Enable / Disable*

LPR protocol settings

Enable* / Disable

RAW protocol

ON*/ OFF

LLMNR

ON*/ OFF

Gigabit Ethernet settings

Autonegotiation* / 10 Mbps half duplex / 10 Mbps full duplex / 100 Mbps half duplex / 100 Mbps
full duplex / 1 Gbps full duplex

Use Dedicated Port

ON*/ OFF

IPP settings

Enable/disable IPP

Enable* / Disable

Security Print

Enable* / Disable

Wi-Fi DRX settings

Enable* / Disable

Wired LAN DRX settings

Enable* / Disable

Reset SSL certificates

Reset LAN settings
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I Setting Items on Operation Panel

»» Note

* The administrator password is required to change some setting items if it is enabled for changing
settings using the operation panel.

For more on setting items which the administrator password is required:

= Setting Administrator Password on Operation Panel

Ready to print

H |
[

GY PBX O  MEBK Y M

@1 50.0m Plain Paper
50.0m Plain Paper

| A Maintenance

B Job management
888 Print from USE flash drive
(47 LAN settings

[ Printer settings

i‘; Printer information

18
I i Maintenance
I Job management

nPrint from USB flash drive

= Printing Data Saved on USB Flash Drive
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.
LAN settings

Printer settings

Test print
Print settings
LAN settings

Web service setup

Paper-related settings

Auto maintenance settings

Hard disk settings

Monitoring service settings

Other printer settings

Language selection

Firmware update

Security settings

Import/export settings

= Migrating Printer's Setting

Initialize printer settings

= |nitializing Printer's Setting

ﬁPrinter information
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I Maintenance

This item is displayed on the HOME screen.

* Nozzle Check
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

* Print Head Cleaning
Select this to clean the print head.

= Cleaning the Print Head

* Print Head Alignment
Adjusts the alignment of print head.

= Automatic Adjustment to Straighten Lines and Align Colors
= Manual Adjustment to Straighten Lines and Align Colors

» Paper feed adjustment

Sets the paper feed amount.

o Set priority

Sets the method of adjusting the paper feed amount.

= Auto

Prioritize print quality will be selected when Print Target is set from the printer driver.

» Prioritize print quality
Adjusts the print quality to make the horizontal streaks of the print less noticeable. The setting
for Adjust print quality is applied. When Paper feed fine adjustment is executed, the setting
for Paper feed fine adjustment is applied in addition to the setting for Adjust print quality.

= Prioritize length accuracy
Adjusts the length of the ruled lines on the printed piece to match. The values for Change
adjustment values under Adjust feed length are applied.

o Adjust print quality
Select this when the printed material has different colored horizontal streaks.

= Automatically Adjusting Different Colored Horizontal Streaks
= Manually Adjusting Different Colored Horizontal Streaks

o Adjust feed length
Select this to print the exact length of the ruled lines in a CAD drawing.

= Adjusting Line Length
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Color calibration
Select this to perform the color calibration or check the adjustment information.

= Performing Color Calibration

Maintenance cartridge info

Displays the estimated usage of maintenance cartridge. Select Replace to replace the maintenance
cartridge.

= Replacing the Maintenance Cartridge

Head Replacement
Select this to replace the print head.

= Replacing the Print Head

Replace cutter blade unit
Select this to replace the cutter blade.

= Replacing the Cutter Blade

Platen cleaning
Select this to clean inside the top cover.

= (Cleaning Inside the Top Cover

Prepare to move
Select this to prepare for transporting the printer.

= Preparing to Transfer the Printer
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I Job management

This item is displayed on the HOME screen.

Print job

Displays the print job list. Selecting a job displays the details. You can also delete or prioritize jobs on
this menu.

Saved job
Displays the saved print job list. You can print / delete saved jobs and print job list on each job box.

»» Note

» Enter the password if it is enabled for a personal job box using Remote Ul.

Job history
22 Important

» The administrator password is required to display the job history if it is enabled for changing
settings using the operation panel.

o Display job history
Displays the print job history. Selecting a job displays the details.

o Print job history
Prints out the print job history.

Pause printing

Selecting Enable while a print job is in progress pauses the print job after the current job is completed.

Delete all print jobs

Deletes all jobs in the job queue.
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I LAN settings

This item is displayed on the HOME screen.
22 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

3> Note
* You can also display LAN settings by selecting * (Network) on the HOME screen.
* Wi-Fi

The following setting information on the Wi-Fi connection is displayed. (Some items are not displayed
depending on printer settings.)

Items

Setting

Connection

Enabled (connected) / Enabled (disconnected) / Disa-
ble

Network name (SSID) XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX
Frequency 2.4 GHz
Wi-Fi security Disable / WPA-PSK (TKIP) / WPA-PSK (AES) / WPA2-

PSK (TKIP) / WPA2-PSK (AES) / WPA3-SAE (AES) /
WPA-EAP (AES)* / WPA2-EAP (AES)* / WPA3-EAP
(AES)*

*Supports IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)

Signal strength (%)

XXX

IPv4 address

XXX XXX, XXX, XXX

IPv4 subnet mask

XXX XXX, XXX, XXX

IPv4 default gateway

XXX XXX, XXX, XXX

IPv4 DNS dynamic settings Enable / Disable
IPv4 DNS host name XXXXXXXXXXXX
IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual prefix length

XXX

IPv6 stateless address 1

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 1

XXX
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IPv6 stateless address 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 2 XXX

IPv6 stateless address 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 3 XXX

IPv6 stateless address 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 4 XXX

DHCPv6 Enable / Disable

DHCPv6 stateful address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

DHCPVvV6 stateful prefix length

XXX

IPv6 default gateway 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

IPv6 default gateway 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

IPv6 default gateway 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

IPv6 default gateway 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

IPv6 primary DNS server address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX

IPv6 secondary DNS server add.

XXXX: XXXX: XXXX:

XXXX:

XXXX: XXXX: XXXX: XXXX
IPv6 DNS dyn. update: manual Enable / Disable
IPv6 DNS dyn. update: stateless Enable / Disable
IPv6 DNS dyn. update: stateful Enable / Disable
IPv6 Use IPv4 host/domain name Enable / Disable
IPv6 DNS host name XXXXXXXXXXXX
IPv6 DNS domain name XXXXXXXXXXXX
MAC address XXXX XX XX XX XX
Printer name XXXXXXXXXXXXXXX
Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

("XX" represents alphanumeric characters.)
To change the setting, select Settings.

o Enable/disable Wi-Fi
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Select Enable to wirelessly connect via wireless router.
o Wi-Fi setup
Select how to setup Wi-Fi.
= Easy wireless connect

Select if you specify the settings of the access point information to the printer directly from a
device (e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen
instructions of the connecting device for the setup procedure.

* Manual connect
Select when you perform settings for Wi-Fi manually using the operation panel of the printer.
= WPS (Push button method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi Protected
Setup (WPS) push button method. Follow the on-screen instructions during setup.

= Other connection types
= WPS (PIN code method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

2> Note
+ Select Advanced to make detailed LAN settings.
For the items that can be set, see the following.

= Advanced

* Wireless Direct

The following setting information on the Wireless Direct connection is displayed. (Some items are not
displayed depending on printer settings.)

Items Setting

Connection Enable / Disable

Network name (SSID) DIRECT-XXXX-GP-NNNN*1

Password XXXXXXXXXX

Frequency 2.4 GHz

Wi-Fi security WPA2-PSK (AES)

No. of printers connected now XXIXX

IPv4 address XXX, XXX, XXX, XXX

IPv4 subnet mask XXX, XXX, XXX XXX

IPv4 default gateway XXX, XXX, XXX, XXX

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

MAC address XXXXXXXX XX XX
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Printer name

XXXXXXX XXX XXXXX

Bonjour service name

XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

*1 "GP-NNNN" represents the name of your model.
("XX" represents alphanumeric characters.)
To change the setting, select Settings.

- Enable/disable Wireless Direct

Select Enable to wirelessly connect without wireless router.

o Change network name (SSID)

Changes the identifier (SSID/the printer's name displayed on a Wi-Fi Direct compatible device) for

Wireless Direct.
o Change password
Changes the password for Wireless Direct.

o Connection request confirmation

Changes the display / non-display of the confirmation screen when Wi-Fi Direct compatible devices

are connected to the printer.

»» Note

» By selecting Advanced, you can set LAN in detail.

For the items that can be set, see the following.

= Advanced

* Wired LAN

The following setting information on the Wired LAN
displayed depending on printer settings.)

connection is displayed. (Some items are not

Items Setting

Connection Enabled (connected) / Enabled (disconnected) / Disa-
ble

IPv4 address XXX, XXX, XXX, XXX

IPv4 subnet mask

XXX XXX, XXX, XXX

IPv4 default gateway

XXX XXX, XXX, XXX

IPv4 DNS dynamic settings Enable / Disable
IPv4 DNS host name XXXXXXXXXXXX
IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
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IPv6 manual address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual prefix length XXX

IPv6 stateless address 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 1 XXX

IPv6 stateless address 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 2 XXX

IPv6 stateless address 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 3 XXX

IPv6 stateless address 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 4 XXX

DHCPv6 Enable / Disable

DHCPv6 stateful address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

DHCPvV6 stateful prefix length XXX

IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 primary DNS server address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 secondary DNS server add. XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 DNS dyn. update: manual Enable / Disable

IPv6 DNS dyn. update: stateless Enable / Disable

IPv6 DNS dyn. update: stateful Enable / Disable

IPv6 Use IPv4 host/domain name Enable / Disable

IPv6 DNS host name XXXXXXXXXXXX

IPv6 DNS domain name XXXXXXXXXXXX

MAC address XXXXXXK XX XX XX

Printer name ),9,9,9,9,9.9.9.9.9.9.9,9.9.0.4
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Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

("XX" represents alphanumeric characters.)
To change the setting, select Settings.
o Enable/disable Wired LAN
Select Enable when connecting to wired LAN.
¥>» Note
» By selecting Advanced, you can set LAN in detail.
For the items that can be set, see the following.

= Advanced

* Print details

Prints out the LAN setting information of the printer with Wi-Fi connection, wired LAN connection,
wireless direct connection.

22 Important

 Important information on your computer is stated on the paper on which the LAN setting information
is printed. Please handle with care enough.

»» Note

* You can also print LAN settings information by selecting Test print > Print LAN details after

selecting ! Printer settings on the Home Screen.

« Advanced

By selecting Advanced on each setting screen of Wi-Fi connection, wired LAN connection, wireless
direct connection, LAN information can be set in detail.

32 Important

+ If the LAN is disabled, the following items can not be selected.

o Set printer name
Specifies the printer name. You can use up to 15 characters for the name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.

[

TCP/IP settings
Performs IPv4 or IPv6 setting.
o WSD settings
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Setting items when you use WSD (one of the network protocols supported in Windows).
» Enable/disable WSD
Selects whether WSD is enabled or disabled.
2> Note

* When this setting is enabled, the printer icon is displayed on the Network Explorer in
Windows.
= Optimize inbound WSD
Selecting Enable allows you to receive the WSD printing data faster.
= Timeout settings
Specifies the timeout length.
o Bonjour settings
Setting items for LAN using Bonjour.
= Enable/disable Bonjour
Selecting Enable allows you to use Bonjour to perform the network settings.
= Service name
Specifies the Bonjour service name. You can use up to 48 characters for the name.

The factory default setting is "Canon XX-NNN" where XX-NNN is the model name of your
printer.

»» Note

* You cannot use the same service name as that already used for other LAN connected
devices.
o SNTP settings
Performs various settings for SNTP (Simple Network Time Protocol).
o Spanning tree settings
Enables/Disables spanning tree. Selecting Enable avoids circulating data on a network.
o LPR protocol settings
Enables/Disables the LPR setting.
o RAW protocol
Enables/Disables RAW printing.

[

LLMNR

Specifies ON/OFF of LLMNR (Link-Local Multicast Name Resolution). Selecting ON allows the
printer to detect printer's IP address from the printer name without a DNS server.

o Gigabit Ethernet settings
Specifies the communication speed and communication method when using Gigabit Ethernet.
o Use Dedicated Port

Selects whether to use a dedicated port for a command sent from a Canon application to the printer.
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Selecting ON allows you to use the dedicated port.

o |PP settings

o

[

[

o

= Enable/disable IPP
Selecting Enable allows you to print over a network using the IPP protocol.
= Security Print

Set to Enable to print using the security print function with the IPP protocol, for example with
AirPrint.

Wi-Fi DRX settings
Selecting Enable allows you to activate discontinuous reception when using Wi-Fi.
Wired LAN DRX settings

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

Reset SSL certificates

Initializes SSL certificate information.

Reset LAN settings

Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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I Test print

-
—
This item is displayed when you select ! Printer settings on the Home screen.

* Nozzle Check
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

« Status print
Prints out the printer status and setting value information.

»» Note

+ Status print (administrator) is also displayed if the administrator password is enabled for
changing settings using the operation panel.

= Status Print

* Print LAN details
Prints out the network setting information.

= Printing Network Settings

* Print the print settings

Prints out the print settings list.

* Print advanced paper settings

Prints out the setting values specified by Advanced paper settings.

* Print job history

Prints out a record of print jobs, including the paper type and size, amount of ink consumed, and so on.
Ink consumption indicates a rough estimate of the amount of ink consumed per print job.

= Job management

* Print menu map

Prints out the menu list.
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I Print settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.

Print head movable width setting

Adjusts the print head movable width.

Prioritize paper size
This is a setting item for roll paper.

Select Enable to use the paper size setting as the basis for printing instead of other settings. The text or
images in the margin are not printed.

Select Disable to give priority to printing text or images.

»» Note

* The printed paper length is longer than the actual paper length. This is because the printed paper
includes the upper/lower margins specified by Roll Paper Safety Margin and Near End Margin in
the printer driver and excludes the paper margins.

Magnification level for borderless
Sets magnification level when performing borderless printing in the following print method.

Normally, the image is enlarged slightly and printed so that there is no border. If the border remains,
change this setting.

o Printing JPEG file

o Printing using AirPrint

o Printing PDF file

> Printing data saved on the USB flash drive directly
o Printing directly from FTP

PDF print settings
Performs PDF print settings.

JPEG print settings
Performs JPEG print settings.

Print from USB flash settings

Performs settings for printing data saved on the USB flash drive.

AirPrint print settings

Performs AirPrint print settings when printing with AirPrint.

Direct print settings from FTP

Performs print settings when printing directly from FTP. You can perform four settings individually.
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+ Default print settings

Prints out the default values of print settings.

* Print the print settings

Prints out the print settings list.
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I Web service setup

-
—
This item is displayed when you select ! Printer settings on the Home screen.
22 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Web service usage registration / Web service usage cancellation

Registers/Deletes Web service usage to use the printer device information to/from PIXMA/MAXIFY
Cloud Link.

Issue registration code

In order to link the web service and printer, obtain the registration code from the service origin.

DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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I Paper-related settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.

* Roll paper auto feed
Enables/disables feeding roll paper automatically when you load it on the roll unit.

Selecting Enable detects the paper edge automatically and paper is loaded automatically only by
putting roll paper on the roll unit.

Select Disable if you load roll paper manually, or if you have any problem in feeding roll paper
automatically.

2> Note
* Roll paper with a width of less than 250 mm cannot be fed automatically.

Select Disable and feed paper manually.

* Media type selection method
Specifies a method to select the media type when paper is loaded.

o Manual
You need to select a media type from the registered media types manually.

o Auto detect
The media type estimated by the printer's sensor is set automatically.
As the estimation accuracy increases, it will be not necessary to select the media type each time.

o Auto with confirmation
Among the media types estimated by the printer's sensor, the most likely ones are listed at the top.
You need to select a media type from the listed media types manually.

o Use current media type
Select this to continue using the same type of paper.

> Note

» When using the paper estimation function, the paper width detection function is enabled even if you
set Detect paper width to Disable.

« If the loaded paper is used by your printer for the first time, or if there is no applicable media type,
No selection log entry will be displayed.

If No selection log entry is displayed, select a media type manually.
At this time, the printer learns the data of the selected media type.
The next time the same paper is loaded, the media type is estimated from this data.

» When using a paper that is not listed in the paper information list, perform Create Custom Paper
in Media Configuration Tool. After create the paper information, we recommend to perform Paper
feed adjustment.
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« If the created custom paper does not appear as a candidate in the paper information list even if it is
fed many times, perform Paper feed adjustment again.

* Errors may occur in the estimation results.

* Manage remaining roll amount

Selects the method to manage remaining roll amount and that to display warning when the roll is
running short.

- Barcodes
Manages remaining roll amount by using a barcode.

By using the barcode every time you replace a roll, you can manage remaining roll amount properly.
Specify the roll length properly when you load a new roll.

o Auto estimate
Estimates and manages the remaining amount of roll paper.
The estimated remaining roll amount is displayed on the HOME screen.
The barcode is not printed when Auto estimate is selected.

To estimate the remaining roll amount, Paper thickness and Paper core outer diameter have to
be set correctly.

When using a paper that is not listed in the paper information list, set Thickness and Paper Tube
Size in Advanced paper settings or in Media Configuration Tool.

For paper thickness and paper tube outer diameter size, contact the paper manufacturer.

3% Important

« If you do not select the media type correctly, the remaining roll amount may not be estimated
correctly.

» There is an error in the estimated remaining roll amount, and paper may run out during printing.

o Disable

Select to disable managing remaining roll amount.

* Roll amount warning settings
Specifies when to warn the remaining roll paper amount.

»» Note

 This setting is enabled when Barcodes or Auto estimate is selected for Manage remaining roll
amount.

» Switch roll paper when low
Switches the roll paper for printing automatically when the roll is running out while printing is in progress.
o Enable
This setting is valid only when Barcodes is selected for Manage remaining roll amount.

The roll paper for printing is switched with several rolls remaining.
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o

Disable

Switches the roll paper for printing by estimating the remaining amount based on the roll amount
value you entered.

In addition, if the roll length is not specified properly, paper may remain when switching, or it may
have run out while printing is in progress.

* Roll paper auto switching

Enables/Disables switching roll paper feed position by detecting the paper size.

» Detect paper setting mismatch

Selects printer action when you start printing with the paper size, the media type, and print settings
different from those registered.

* Paper retention settings

Selects whether to contact the roll nip with the rolls in feeding paper.

o

o

If you select While feeding, the roll nip contacts with the rolls and automatic feeding is enabled.
If you select Release, the roll nip does not contact with the rolls.

If you select Release, automatic feed and automatic switching of top and bottom roll paper can not
be performed.

Feed paper manually.

* Paper size recognition settings

Selects which size is preferred when paper size detection is enabled.

o

Cut sheet setting 1

Select whether ISO A3+ or 13"x19"(Super B) is applied when a sheet of an intermediate size is
detected.

Cut sheet setting 2*1

Select whether ISO B1 or 28"x40" (ANSI F) is applied when a sheet of an intermediate size is
detected.

*1: Not displayed on GP-2600S/GP-526S.

Roll paper setting 1

Select whether 10 in. or B4 is applied when a roll of an intermediate size is detected.

Roll paper setting 2

Select whether A3 or 300 mm is applied when a roll of an intermediate size is detected.
Roll paper setting 3

Select whether 300 mm or 12 in. is applied when a roll of an intermediate size is detected.
Roll paper setting 4

Select whether 500 mm or 20 in. is applied when a roll of an intermediate size is detected.
Roll paper setting 5

Select whether 20 in. or B2 is applied when a roll of an intermediate size is detected.
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o Roll paper setting 6
Select whether A1 or 600 mm is applied when a roll of an intermediate size is detected.
o Roll paper setting 7

Select whether 600 mm or 24 in. is applied when a roll of an intermediate size is detected.

Adjust roll unit

Select this setting item when you replace the roll unit.

Keep margin at cut sheet end

When printing on the sheet using AirPrint, selecting Enable sets the trailing edge of the paper to 20 mm.
Select Enable if printing on the trailing edge of the paper is disturbed.

Advanced paper settings

Performs advanced paper settings for each media types.

Print advanced paper settings

Prints out each setting specified in Advanced paper settings.

Add priority roll paper width
When paper size is detected, set the width of the roll paper to be recognized first. Judge in order from 1
in the list.
Reset all detection priority data
Resets estimated data for all learned paper when Auto detect or Auto with confirmation is selected in
Media type selection method.
Reset paper settings for all paper
Initializes each setting specified in Advanced paper settings.
Entering the administrator password is required if it is enabled.
22 Important
» The following information is deleted when paper information is reset to the factory defaults.

— Estimated data for all learned paper when Auto detect or Auto with confirmation is selected
in Media type selection method.

— Media type selection log.
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I Auto maintenance settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.
22 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Auto nozzle check

Enables/Disables automatic nozzle checking. You can also select the page interval to perform automatic
nozzle checking.

Nozzle check error display

Enables/Disables displaying the nozzle check error.

System Cleaning frequency
Specifies the frequency of automatic system cleaning.

»» Note

» To maintain print quality, we recommend you select Short if you use the printer at a higher
elevation.
Print pattern after new head

Selects whether you print an adjustment pattern after replacing the Print head.

Ink ejection status check
Sets the function to automatically detect the print head ejection status.
o Auto fix
Performs an automatic fix when a change in the print head ejection status is detected.
o Display warning

Displays a notification message on the touch screen when a change in the print head ejection status
is detected.

o OFF
Disables automatic detection.

32 Important

» Depending on the paper feeding method, Cutting mode settings, etc., automatic detection may not
be performed.
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| Hard disk settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.
22 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Output method

Selects the printing method for jobs received from software other than the printer driver. When using the
printer driver, configure settings on the printer driver.

° Print

Performs printing as usual.
o Print (auto delete)

Deletes the data from the printer's hard disk after printing is completed.
o Save to job box

Only saves the print job in job box without printing it.

Save first and print

A setting for jobs received from software other than the printer driver. When using the printer driver,
configure settings on the printer driver. Select ON to print the job after it has been saved.

Common job box settings

Select Print (auto delete) to print without saving jobs in common job box.

File deletion settings

Selects the data erasing method when deleting a Print job or Saved job, or when Print (auto delete) is
selected in Output method or Common job box settings.

o Fast

Erases file management data for print job data stored on the printer's hard disk. Choose this method
for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased.

o Fast secure

Erases the data encryption key specified for the hard disk drive. Specifying the encryption key again
does not allow you to read and use data saved in the past safely and fast. Select to erase highly
confidential data.

- Secure

Overwrites the entire hard disk with 00, FF, and random data (one time each) after the data
encryption key specified for the hard disk drive is erased. Verification is performed to check if the
data was correctly written. Choose this method to erase especially confidential data. It is virtually

459



impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

o Secure (VSITR)

Overwrites the entire hard disk with 00 next overwrites with FF after the data encryption key
specified for the hard disk drive is erased. After repeating this process three times, the entire hard
disk is overwritten with AA. It is virtually impossible to recover the overwritten data. Conforms to the
guidelines of German Federal Government (VS-ITR).

+ Data deletion
Selects the method to delete data on printer's hard disk.

= Erasing Data on Printer's Hard Disk
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I Monitoring service settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using the

operation panel.

» Enable/disable monitoring service

Selecting Enable allows the printer to send error details to the service center.

When selecting Enable, perform a communication test.

« Communication test

Performs a communication test with the service center.

+ Communication log

Displays a list of error numbers (up to 30), the error code, and time the error occurs. Selecting an error
number displays the error details.

Main errors and countermeasures

Error code Error detail Countermeasure

0xxx0003 Communication test is not performed. Perform the communication test.

8xxx0003 E-RDS switch is setting OFF. Enable monitoring service.

8xxx2003 Network is not ready, try later. Check the network settings.

8xxx200A Server connection error Check the network settings.

8xxx2014 Proxy connection error Check the proxy server address etc.

8xxx201E Proxy authentication error Check the user name and password to log in to the proxy
server.

8xxx2046 Server certificate expired The server certificate has expired.Set the correct date
and time on the printer.

8xxx2047 Server response time out Check the network settings. Check the proxy server ad-
dress. Make sure that the correct date and time is set on
the printer.

8xxx2058 Unknown error Wait a while, and then try the communication test again.

» Timing for ink level notification

Sets the timing for ink level notification to the local service center.

Selecting Check settings allows you to check the notification timing set for each color.
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* Warning notification settings

Displays a message on the touch screen selecting Enable when communication with the service center
fails.
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I Other printer settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.
22 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Energy saving settings

To save electricity, enable this setting to turn off the printer automatically or to enter sleep mode when
specified length of time has elapsed.

o Auto power off

Sets the time until the printer turns off automatically. If no operations are performed on the printer for
the specified duration of the time after entering Sleep mode, the printer automatically turns off.

o Sleep timer
Specifies the length of time to enter sleep mode automatically when no operation is made.

»» Note

« If the print job contains a pending job or a security print job, the printer does not enter sleep
mode.

Use USB connection

Use / Do not use USB connection.

Date/time settings

Sets the current date and time.

Date display format

Sets the format of dates displayed on the touch screen and printed on photos.

Time zone (GMT)
Specifies the time zone according to a country or region you live in.

Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail
software.

Select the time difference from GMT (Greenwich mean time) according to a country or region you live in.

Length unit settings

Selects the length unit (meter or feet/inch).

Buzzer settings

The printer beeps once for warnings and 3 times for errors when Enable is selected.
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+ EOP timer settings

Specify the timeout period before cancellation of print jobs that cannot be received by the printer.

* Job history sending settings

Select Send to send the information to the printer management and job management systems.

* Menu row height

Adjusts the line spacing of some setting items displayed on the touch screen.
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I Language selection

-
—
This item is displayed when you select ! Printer settings on the Home screen.

Changes the language for the messages and menus on the touch screen.

32 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.
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I Firmware update

-
—
This item is displayed when you select ! Printer settings on the Home screen.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

»» Note

 If LAN is disabled, you cannot use Install update, DNS server setup, Proxy server setup.

* Install update
Updates the printer's firmware.

= Firmware update

* Check current version

You can check the current firmware version.

+ Update notification settings

Select Yes to display a notification on the touch screen when a firmware update is available.

» Show notifications (tool update)
When you select ON, a confirmation screen is displayed on the touch panel before running the Firmware
Update Tool.

* DNS server setup
Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

* Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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I Security settings

-
—
This item is displayed when you select ! Printer settings on the Home screen.
22 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

* Administrator password settings
You can specify or disable the administrator password.
If you specify the administrator password, select the range and specify the administrator password.

Remote Ul and other tools

Entering the administrator password is required to change the setting items using Remote Ul or
some software.

LCD, Remote Ul, and other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote Ul, or some software.

For details:

= Setting Administrator Password on Operation Panel

» Operation restrictions
Restricts the following operations.

o Job history
Restricts to display or print the print job history.

° Remote Ul
Restricts to use Remote UI.

> Print from USB flash drive
Restricts to print data on USB flash drive.

* IEEE802.1X/EAP settings
Performs various settings for IEEE802.1X/EAP.
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I Printer information

This item is displayed on the HOME screen.

+ System information

Displays printer's system information.

» Hard disk information

Displays the total or free space of the printer hard disk.

* Error history
Displays the error history.

o Hardware error
Displays the hardware error codes (up to 5).

> Recoverable error
Displays the recoverable error (e.g. paper or ink related error) codes (up to 5).

o Paper feed/transfer error
Displays the error codes for errors which occur during paper feed/transfer (up to 5).
Selecting an error code displays the error details.

For more on the error code, refer to List of Support Code for Error.

* Usage
Displays the actual printer usage, such as the total print area.

+ Head information

Displays the Print head serial number, elapsed days since the current Print head was installed, and dot
count.

* Head alignment performance log

Displays the Print head alignment performance log (up to 5).

* Values applied with auto settings

Displays the print settings applied the last print job.
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I Setting Administrator Password on Operation Panel

The administrator password can be set or canceled.

Specifying the administrator password requires you to enter the password to use the items or change the
settings below.

* LAN settings

+ Web service setup

+ Auto maintenance settings
* Hard disk settings

* Monitoring service settings
» Other printer settings

+ Language selection

* Firmware update

» Security settings

* Import/export settings

* Initialize printer settings

+ Status print (administrator)

Follow the procedure below to specify the administrator password.

22 Important

» The administrator password is set at time of purchase. The default password is the printer serial
number (9 characters) which can be found on the sticker on the printer.

L
1. Select ! Printer settings on the HOME screen.
2. Select Security settings.

3. Select Administrator password settings.

If you have set an administrator password, enter the password.
4. Select Change administrator password.

5. Select the effective range of the administrator password.

Remote Ul and other tools
To change the setting using the remote Ul or a certain software, the administrator password needs
to be entered.

LCD, Remote Ul, and other tools
To change the setting using the operation panel of this printer, remote Ul or a certain software, the
administrator password needs to be entered.

6. Enter new administrator password.
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2% Important
* When changing the password, the character is limited as follows.
— Set the password using 4 to 32 characters.

— Single-byte alphanumeric characters, spaces, umlaut characters, and the following symbols
are available.

Sl@#S % N&T s, = () {1 <>

— From a security point of view, it is recommended to set the password of 8 characters or more
in combination of alphanumeric characters.

7. Select Apply.
8. Enter the administrator password again.

9. Select Apply.

The administrator password is available.

I When You Want to Disable the Administrator Password:

-

]
After selecting ! Printer settings on the HOME screen, select Security settings > Administrator
password settings > Remove administrator password. Select either item and follow the on-screen
instructions to perform settings.
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I Erasing Data on Printer's Hard Disk

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

» For a more secure method of preventing data recovery, we recommend physically or magnetically
destroying the hard disk. In this case, the hard disk can no longer be used.

+ Additionally, print jobs are not processed while data erasing is in progress.

vy
1. Select ! Printer settings on HOME screen.

2. Select Hard disk settings.

If an administrator password is set, enter the password.
3. Select Data deletion.

4. Select erasing method.

Fast
Erases file management data for print job data stored on the printer's hard disk. Choose this method
for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased.

Fast secure
Erases the data encryption key specified for the hard disk drive. Specifying the encryption key again
does not allow you to read and use data saved in the past safely and fast. Select to erase highly
confidential data.

Secure
Overwrites the entire hard disk with 00, FF, and random data (one time each) after the data
encryption key specified for the hard disk drive is erased. Verification is performed to check if the
data was correctly written. Choose this method to erase especially confidential data. It is virtually
impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

Secure (VSITR)
Overwrites the entire hard disk with 00 next overwrites with FF after the data encryption key
specified for the hard disk drive is erased. After repeating this process three times, the entire hard
disk is overwritten with AA. It is virtually impossible to recover the overwritten data. Conforms to the
guidelines of German Federal Government (VS-ITR).

5. Confirm the message and select Yes.

Data on the hard disk are erased.
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I Status Print

You can print a "Status Print" report indicating the current status of the printer.

With "Status Print", information is printed regarding the printer firmware version, various settings, and the
status of consumables.

e
1. On the HOME screen, select ! Printer settings.
2. Select Test print.

3. Select Status print.
3> Note

* If you specify the administrator password, select Status print (administrator).

4. Select Yes.
The printer starts printing.
The following information is included.

Items and values may vary depending on your model, firmware version, and printer settings.

Canon XXXXXXXXXXXXXXXXXXxX Status Print Printer model
S/N Printer serial number
Firm Firmware version
Boot Boot ROM version
Date Date and time when the status print was output
Paper Info
Roll1 Media Type of roll paper 1
Roll2 Media Type of roll paper 2
Cut Sheet Type of cut sheet
Job Menu
Job History
Log Details of up to 5 jobs
Settings
Printer settings
Print settings Setting values of Print head movable width setting, Pri-
oritize paper size, and Magnification level for border-
less
Paper-related settings Setting values of Paper-related settings
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Device settings

Auto maintenance settings

Setting values of Auto maintenance settings

Hard disk settings

Setting values of Hard disk settings

Device user settings

Setting values of Other printer settings

Web service setup

Setting values of Web service usage regis-
tration

Language selection

Setting value of Language selection

Firmware update notification

Setting values of Update notification set-
tings

Show notifications (tool update)

Setting values of Show notifications (tool
update)

Monitoring service settings

Setting values of Monitoring service set-
tings

Roll unit use setting

Setting values of Take-up mode

Maintenance

Color calibration

Setting values of Calibration guide settings

Usage Condition

Hard disk information

Values of Hard disk capacity and Job box free space

Hardware error

History information of Hardware error

Error History information of Recoverable error
Warning Warning history information
Jam History information of Paper feed/transfer error

Maintenance cartridge usage / Tank size / Re-
maining ink level

Information on maintenance cartridge usage / Ink tank size /
Remaining ink amount

Duty counter

Values of Duty counter

PARTS STATUS

COUNTER

Part status

Head information

HEAD LOT NUMBER/ DATE OF INSTALLATION

Information of Head information

Head alignment performance log

History information of Head alignment performance log

COUNTER

MEDIA

Usage status by media

THE NUMBER OF CUTS

Total number of cuts

AFTER INSTALLATION

Number of days from the use start date
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I Changing Printer's Setting Using Web Browser

» Start up Remote Ul

» Changeable Setting Items Using Remote Ul

» Setting Passwords Using Remote Ul

» Registering Printer's Root Certificate to Web Browser for SSL Communication

» Registering Printer's Root Certificate to Local Computer for SSL Communication
» Generating Server Certificate

» Setting Mail Server

» Receiving Printer Status by E-mail
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I Start up Remote Ul

You can check the printer status and change the printer settings using the web browser on your
smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

»>» Note

* Remote Ul is a software that enables you to perform operations, which are usually performed on the
printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UlI.
* You can use Remote Ul on the following OS and the web browser.

— iOS device

Web browser: iOS standard Web browser (Mobile Safari)
— iPadOS device

Web browser: iPadOS standard Web browser (Mobile Safari)
— Android device

Web browser: Android standard Web browser (Browser or Chrome)
— macOS device

OS: macOS Catalina 10.15.7 or later

Web browser: macOS standard Web browser (Safari)
— Windows device

OS: Windows 7 SP1 or later

Web browser: Microsoft Edge, Mozilla Firefox, Google Chrome

» Enable JavaScript and cookies in the web browser.

1. Check printer's IP address.

(t92)

1. Select LAN settings on the HOME screen.

2. Select the enabled LAN.

Diagonal lines are displayed for disabled LAN icons.

3. Check IPv4 address.

2. Open web browser on your smartphone, tablet, or computer and enter IP address.

Enter as following in the URL field of the web browser.
http://XXX. XXX XXX
Enter the IP address of the printer in "XXX.XX.X.XXX".
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»» Note

* If you have set a DNS host name, you can also enter this.

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or
computer.

Detally Ready ta prirt
When & password is sl you will

be requested Lo enler your

password. Estimated Ink levels

m Len

Manual {Orlime)
For secure communication

1
]
I
Download Software
]
| —

Ik ricdel mirmbar Order My Ik Naw

Raoll paper 1 o7 Plain Paper
= A1 Rall
Roll paper 2 oy Flain Paper
= Custom
M |
A »  Thesre i no paper.

Purchasing paper

k Mainterance cartridge usage

> Note

« If you display Remote Ul for the first time on your smartphone, tablet, or computer, download the
root certificate, and then register it.

= Regqistering Printer's Root Certificate to Web Browser for SSL Communication

« If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

3. Select Log in.

The password authentication screen appears.

»» Note

* When the standard user mode is enabled, choose either administrator mode or standard user
mode to log on.

After choosing a mode and selecting Log in, the password authentication screen of each mode
appears.

4. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.
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2% Important

* The password is set at the time of purchase. The password is the printer serial number. The

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters.

For details on setting password, see Setting Passwords Using Remote UI.

5. Confirm that the main screen of Remote Ul is displayed.
For changeable setting items, see below.

= Changeable Setting Iltems Using Remote Ul

When you finish checking printer status and changing printer settings, select Log out.
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I Changeable Setting Items Using Remote Ul

»» Note

* The item which can be used is different in administrator mode or in standard user mode.

Printer status

Ready to print
Utilities.
Printer settings Estimated ink lewsls
AirPrint settings T
‘Wab sarvice connaction sabup
Job management

Security

Records of use gt

System info and LAM settings
Firmware update
Language sebection Ink model number | | Order My ink Now
Manual {Online)
Rall pager 1 ray;  Plain Paper
Download Socftware = A1 Roll

Roll paper 2 Plain Paper

Custom

Manual
. There ia no paper

Purchasing popesr
k¥ Maintenance cartridge usage

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.
Utilities
This function allows you to set and perform maintenance such as cleaning.

Printer settings
You can change various settings, such as print settings.

Additionally, this function allows you to receive the printer status information.

= Setting Mail Server
= Receiving Printer Status by E-mail

You can disable any operations using the operation panel from Operation panel lock on Custom
settings.

»» Note

+ Some of the menu is available only when you logged on in administrator mode.

AirPrint settings
This function allows you to specify the AirPrint settings when printing with AirPrint.
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Web service connection setup
This function configures web services that use printer device information, such as PIXMA/MAXIFY
Cloud Link.

Job management
This function allows you to display the job history and print it.

»» Note

* When you are logging on in administrator mode, you can restrict this function in standard user
mode.

Security (Iltem for administrator)
Set passwords, make settings related to certificates for encrypted communication, and other security
settings.

Records of use
Get information on printer usage.

System info and LAN settings
» Confirm system information
* LAN settings (Item for administrator)
* Error history

Firmware update
You can update the firmware of the printer, check the firmware version, or perform settings of a DNS
server and a proxy server.

= Firmware update

Language selection (Iltem for administrator)
This function allows you to change the language on the display.

Manual (Online)
This function displays the Online Manual.
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I Security

+ Administrator password setting

= Setting Passwords Using Remote Ul

» Standard user mode settings

Select Enable/Disable for the standard user mode.

* Operation restrictions
Restricts the following operations.
o Job history
Restricts to display or print the print job history.
o Print from USB flash drive

Restricts to print data on USB flash drive.

» TLS server settings
Make settings related to certificates for encrypted communication.
Advanced TLS settings enables you to specify the range of TLS versions to be used, the algorithm to
be used, and so on.
+ |IEEE802.1X/EAP settings
o Authentication
Select an authentication method for IEEE802.1X/EAP authentication.

»>» Note

* In the case of using IEEE802.1X certificate, Security > IEEE802.1X/EAP settings > CA
certificate, and register the CA certificate.

» Supported authentication method
— EAP-TLS(Extensible Authentication Protocol-Transport Level Security)
— EAP-TTLS(EAP-Tunneled TLS)
— PEAP(Protected EAP)

- Key and certificate settings

Perform settings for key and client certificate.
o CA certificate

Perform settings for the CA certificate that verifies a server certificate.
> Enable/disable IEEE802.1X/EAP

Enable or disable IEEE802.1X/EAP authentication.
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| LAN settings

Wi-Fi

Enables/Disables Wi-Fi.

Wireless Direct

Enables/Disables Wireless Direct.

Wired LAN

Enables/Disables Wired LAN.

Confirm LAN settings

The LAN setting information is displayed.

Advanced setup

o

Set printer name

Specifies the printer name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.

TCPI/IP settings

Performs IPv4 or IPv6 setting.

WSD settings

Perform settings to use WSD.

Bonjour settings

Perform settings to use Bonjour.

LPD print

Perform settings for printing with LPD.

SNMP settings

Perform settings for using SNMP to manage and control the printer.
SNTP settings

Perform settings for using SNTP to adjust the time on the printer.
FTP settings

Perform settings for printing with FTP.

IPP Settings

Perform settings for printing with IPP.

CHMP settings

Perform settings for communication at the time when printer drivers or applications acquire the

information on status, paper, and job log, from the printer.
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Selecting Enable HTTPS redirection redirects the communication using CHMP to encrypted
communication.

»» Note

» To use CHMP for encrypted communication, you need to register the printer's root certificate to
your computer.
= Registering Printer's Root Certificate to Local Computer for SSL Communication

* CHMP is a Canon proprietary protocol.

o Network interface settings
To connect to a hub that supports spanning tree, select Spanning tree settings > Enable.
Selecting Enable avoids circulating data on a network.
o DRX settings
When enabled, data is received intermittently during network connection.
o |P filtering
Allows or denies access for specific IP addresses.

Settings for both IPv4 and IPv6 addresses can be specified.

22 Important

(1)

+ If the device address for the administrator has been set to rejection by mistake, select
LAN settings on the HOME screen of the operation panel, and then select Wi-Fi / Wireless
Direct / Wired LAN > Settings > Advanced > Reset LAN settings in this order, and initialize
network information of the printer.

After resetting, perform setup again as necessary.

o MAC address filtering settings

Allows or denies access for specific MAC addresses.

32 Important

(7}

* If the device address for the administrator has been set to rejection by mistake, select { T }
LAN settings on the HOME screen of the operation panel, and then select Wi-Fi / Wireless
Direct / Wired LAN > Settings > Advanced > Reset LAN settings in this order, and initialize
network information of the printer.

After resetting, perform setup again as necessary.

o Reset LAN settings
Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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I Setting Passwords Using Remote Ul

Each of passwords for administrator and standard user can be set.
When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

= Setting Administrator Password
= Setting Standard User Password

»» Note

» Password can be set only when you are logged in administrator mode.
» The standard user password is disabled by default.

I Setting Administrator Password

Change the administrator password by following the steps below.
32 Important

» The password is set at the time of purchase. The password is the printer serial number. The

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters.

1. Start up Remote Ul.

= Start up Remote Ul

2. Select Security.
3. Select Administrator password setting.

4. Select Change administrator password.

If an administrator password is not specified, the confirmation message appears. Confirm the
message and select Yes. When message appears again, confirm it and select OK.

5. Select range where administrator password is valid and select OK.

Remote Ul and other tools

Entering the administrator password is required to change the setting items using the Remote Ul
or some software.

Operation panel/Remote Ul/other tools

Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote Ul, or some software.

6. Enter password and select OK.

32 Important

» The following character restrictions apply to the password:
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— Set the password by using 4 to 32 characters.

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
-l@#S WM& =+ () {1 <>

— For security reasons, we recommend you use 8 and more alphanumeric characters.
7. When completion message appears, select OK.

I Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Start up Remote Ul.

= Start up Remote Ul

2. Select Security.
3. Select Standard user mode settings.
4. Confirm the message and select Yes.

5. Enter password and select OK.

3% Important
» The following character restrictions apply to the password:

— Set the password by using 4 to 32 characters.

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
-l@#S%N& s, =+ () {1 <>

— For security reasons, we recommend you use 8 and more alphanumeric characters.

6. When completion message appears, select OK.
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Registering Printer's Root Certificate to Web Browser for SSL
Communication

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear. However, the message may appear depending on a web browser even after you have
registered the root certificate.

How to register the root certificate varies depending on the web browser.

Operating procedure may differ depending on the version of your web browser. For other web browser, refer
to each help.

32 Important

» Make sure that you have accessed to the printer IP address correctly by checking the URL field of the
web browser before registering the root certificate.

« If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote Ul.

For details, see Generating Server Certificate.

For Microsoft Edge
1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started.

3. If confirmation screen appears, select Open.
Certificate screen is displayed.

> Note

» To save the certificate file and register it, select Save. To register, select Control Panel >
Network and Internet > Internet Options, and register the root certificate from Certificates on
Content sheet.

4. Select Install Certificate.

Certificate Import Wizard screen is displayed.
5. Select Next.
6. Select Place all certificates in the following store.

7. Select Browse.
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10.

1.

12

Select Certificate Store screen is displayed.
Select Trusted Root Certification Authorities and OK.
Select Next on Certificate Import Wizard screen.

If Completing the Certificate Import Wizard appears, select Finish.

Security Warning screen is displayed.

Make sure that thumbprint on Security Warning screen matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select ﬁ Printer information on the HOME screen of the operation panel,
and then select System information.

If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

13. Select OK on Certificate Import Wizard screen.

The root certificate registration is completed.

For Safari

1.

Select For secure communication on Remote Ul.

Select Download.

Downloading the root certificate is started.

Open the downloaded file.

Keychain access starts up and Add Certificates screen is displayed.

Select Add.
Information on the certificate is displayed.

> Note

* You can also add the